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ACE IT Department Daily Procedures
Procedures to be Done ONCE, First Thing in the Morning:
1. Testing the ACE Fax Numbers
14 TEST FAX files numbered 1 to 14 have been compiled as FaxServer message requests. To send them, do the following…
1) Browse to the ACE FAX TESTS directory (stored on the C:\ drive of the IT workstation, with a shortcut on the desktop).
2) Open a second copy of Windows Explorer and browse to F:\Data\First Entry\MsgBin.
3) From the ACE FAX TESTS folder, click and drag to highlight all 14 test fax .msg files. Right-click and select “Copy.”
4) Return to the F:\Data\First Entry\MsgBin directory. Next, right-click and select “Paste” to paste the test fax .msg files.
Within a few seconds, the messages will be pulled from the MsgBin and into the fax servers, from where they will be sent.
5) Go downstairs and retrieve all 14 sheets from the fax machines to which they were sent. Take note of any
fax numbers that did not properly send a sheet!
6) Return upstairs and retrieve the confirmation sheets from the fax machine. Take a look at the sheet(s) for any
jobs that did not send. Whenever applicable, determine what is causing the problem with the fax line and fix the problem.

2. Verifying that the Call Accounting System is Actively Running
1) Physically go to the Phone Call Accounting System. Turn on the monitor and type in the screensaver password.
2) Verify that the logged phone call information is up-to-date (indicating that the system is currently running/logging calls).

3. Rebooting the ACE Fax Servers
1) Go to the ACE fax servers and push the power strip button to turn on all 4 fax server monitors. Next, for each fax server:
- Click the upper right-hand [X] to close the Eclaim Fax Server program and then shutdown the fax server.
2) Once all 4 fax servers are off, turn off their external modems (by pushing the button on the power strip).
After several seconds, turn the power strip back on to restart the 4 fax servers. Next, for each fax server:
- Logon to the fax server workstation and then double-click to open “ACE Fax Server.”
- Click “Unlock.” From the pop-up window, click “OK.”
- Click “Start Msg. Scan” and verify that the fax server login script begins to run.

4. Retrieving New Voice Mail Messages for Delaware Valley
1) Physically go to the Delaware Valley phone in the IT room. If the message light is blinking, press the [Msg] button
on the phone, enter the extension and password code [2][8][0] and then press [1] to listen to the first new message.
2) Take notes on all messages and then return phone calls or call Robert as necessary.

5. Backing up the Network (FS3) to Tape
1)
2)
3)
4)
5)

Unalarm, unlock, and then enter the server closet. Turn on the ACE Server monitor.
From the desktop, double-click to open VERITAS Backup Exec. The server will take a few seconds to load the program.
From the Activity Monitor tab, verify that yesterday’s backup was successful and that today’s backup is on schedule.
Push the tape eject button on the tape drive (the tape will rewind completely before ejecting).
After ejection, pull out the tape and place in the corresponding case. Place the *new* appropriate tape into the tape drive.
If the tape ejects, place the cleaning tape into the drive (The tape will run for a few minutes then eject). Repeat step 5.
6) Leave the *new* tape case along with the cleaning tape in the server closet, but take the previous day’s tape.
7) Close Backup Exec, turn off the Server monitor, and lock/alarm the server closet. Store the tape in a vehicle, or at home.

6. Verifying That Outlook is Receiving all New Internet Claims Submissions and Member Signups
1) From the desktop of the Consultant PC, double-click to open “ACE_Admin.” From the form, click “Portal Activity Rpt.”
From the pop-up question “Run Report for how many days?”, type 2 in the field and click “OK.”
2) Print and then retrieve the report. From the desktop of an IT workstation, double-click to open Microsoft Outlook.
3) For each file signup listed under yesterday’s --- Welcome Email Sent --- banner of the report:
- Locate the file’s corresponding email within Outlook (by checking all Member Signup Forms sent to us yesterday).
- For each signup not received by Outlook, but on the printout list, complete Step 12 (Approving New Applicants).
4) For each file submission listed under yesterday’s --- Submit Form --- banner of the report:
- Locate the file’s corresponding email within Outlook (by checking all Claim Submission Forms sent in yesterday).
5) If there are any submissions not received by Outlook that appear on the printout list, go to the Consultant PC.
6) From “ACE_Admin”, click “View Portal Auto Claim Submissions.”
7) For each submission not received by Outlook, but on the printout list:
- Locate the submission and click on it. The form will populate into the lower window. Print it.
- Click “Save Attachments.” From the My Documents folder location, click “Open” to save the attachment.
- Close Microsoft Access. From Explorer, browse to “My Documents” and then open/print the attachment.
- Delete the attachment, retrieve the form and attachment print outs, and deliver them to a customer service rep.
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7. Verifying that the ACE Website is Functioning
1) Go to the ACE website, http://www.ace-it.com.
2) Type an IT user id in the User ID field and the corresponding password in the Password field, then click “Login.”
3) If the ACE website Portal functions properly, close Internet Explorer (everything is OK). If it does not, investigate!

Procedures to be Done Periodically THROUGHOUT the Day:
1. Checking the Delaware Valley Computer Calendar for New Appointments
1)
2)
3)
4)

From Internet Explorer, browse to https://webmail.mailtrust.com/.
Login to the account DVC@DVComputers.com and click “Sign In.”
Once logged in, from the upper menu, click “Calendar.” The Delaware Valley calendar will appear in the main window.
Browse through the current day’s schedule (the current day should appear by default) and update as necessary.

2. Checking the Fax Machines for Information Jams
1) Go to each of the 4 Minolta printer/fax machines.
2) On the machine display, look at the Memory Occupied percentage. If it is 0, the machine is resting. Go to step 6.
3) If the Memory Occupied percentage is 1 or greater, press “Activity List” on the LCD display to view machine job details.
Typically, a job will be sending, receiving or printing.
4) For a job that is sending, press “Sending” to view further details. If a job has been attempting to send for more than
2 hours, press “Cancel” to cancel the job.
5) Similarly, for a job that is incoming, press “Receiving” to view details. If a job has been incoming for over an hour,
or if the same page of a job has been receiving for more than 5 minutes, press “Cancel” to cancel the job.
6) If the job did not need to be canceled (in either case), push the “Panel Reset” button to return to the main menu screen.
7) In the event that a job is jammed while sending or receiving, the Cancel command will not respond; At that time, return to
the activity list to ensure that nothing is receiving. If/when nothing is receiving, turn off the machine and then restart it.

3. Ensuring that the Email Client Send/Receive Feature is Functioning Properly
1) Go to the Email Client workstation. From Outlook (which should be open be default), click “Send/Receive.”
2) Verify that the client receives email from the server successfully (Status text in the lower-right portion of the
Outlook window should display “Connecting to the Server … Mail Delivery Complete).
3) Maximize (or open, if it is not already) Outlook Express. From Outlook Express, click “Send/Recv.”
4) Verify that the client receives email from the server successfully (Status text in the lower-right portion of the
Outlook window should display “Connecting to the Server … Mail Delivery Complete).

4. Printing Failed Message Information from Email Client
1) Go to the Email Client workstation.
2) From the left-hand folder list of Outlook, click “_UNKNOWN.” Verify the folder is EMPTY. Repeat for
“_TROUBLE BIN” and “_FAILED EMAIL.”
3) If there are any failed messages found in the “_FAILED EMAIL” folder, for EACH message:
- Double-click to open the message. From the upper menu of the message, click “File” and then select “Print …”
- Click “Print” again to print the message to the customer service printer.
- Double-click on the message attachment icon found in the message.
- From the upper menu of the attached message, click “File” and then select “Print …”
- Click “Print” again to print the message to the customer service printer.
- Click the upper right-hand [X] to close the attached message and then the message.
4) Click on the “Inbox” folder.
5) Retrieve all print outs and distribute them to Linda Mirolli in the Accounts Receivable Department.

5. Checking for Unprinted and Unsent Estimates
1) From Explorer, go to F:\Data\First Entry\Images.
2) Verify that there are no files that appear like the following: _______0.EST (such files will not be processed by the
Conversion program). If no such file exists, go to step 6. If such a file appears, double-click and open it with Notepad.
3) From within notepad, review the estimate, noting its file number. Close Notepad.
4) Right-click on the ________0.EST file and select “Rename.” Type in the estimate # seen via Notepad
(using the same format as other “normal” estimates found in the Images folder) and press [ENTER].
5) From Explorer, verify that the file now processes by ensuring that it vanishes from the Images folder
(Press [F5] to refresh the Explorer window). Note: It may take the file a few minutes to be evacuated.
6) From Explorer, go to F:\Data\First Entry\MsgBin\FailedMessages and verify that there are no files in the folder.
7) If there are files in the folder, determine why each failed and ensure they get sent successfully. Close Explorer.
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6. Checking the Fax Servers
1) Physically go to the ACE fax servers. Periodically check that each of the fax servers is working by doing the following:
- Verify that the latest time found in the ACE Eclaim Fax Server message window is near to the current time
(This certifies that the fax server is has been doing work recently).
- Move the fax server system’s mouse to help verify that the system is not frozen.
- From the startup menu, click to open Winfax PRO (It’s found on the righthand portion of the Windows menu bar).
- From Winfax PRO, go to the Outbox and verify that jobs are sending. Close Winfax PRO.
2) At the end of the day, turn off each fax server monitor.

7. Correcting ACE Audit Information that was Erroneously Written by ACE Auditors
1) See Correcting an ACE File-Related Error, step 3 (Correcting an Original or Supplement File…) procedure.

8. Purging Unnecessary Client Claim Rep Information
1) From the desktop of the Consultant PC, double-click to open “ACE_Admin.” From the form, click “Rep Cleanup.”
2) From the RepCleanup form, click button 1, “Remove Spaces from Rep Names.” Click “OK” in response to the pop-up.
3) Next, click button 3, “Remove Reps not associated with a file.” Click “OK” in response to the pop-up.
4) Click the “Show Reps with invalid Office codes“ bullet. If any records display, click “File -> Print…” for a print copy.
5) Click the “Show Duplicate Reps“ bullet. If any records display, click “File -> Print…” for a print copy.
6) Close Access. Retrieve the printouts and then physically go to an IT workstation.
7) From the AccessShortcuts folder found on the desktop, double-click to open “Ins Comp Admin MDB.”
8) From the Access file, press [F11]. Go to the pop-up window and click the Tables tab.
9) Double-click to open “tblClaimReps.” Return to the pop-up window and click the Queries tab.
10) For each claim rep record found on the Duplicate Reps printout:
- From the table, click “ClaimRepName.” Press [CTRL] + [F]. Type in the claim rep name and click “Find First.”
- Verify that the office code in the table record matches the code on the print out and then write down the IDPK #.
- Repeat the first step, clicking “Find Next.” Again, verify that the office code matches and write the IDPK #.
- Determine the best/most accurate/most recent of the IDPK claim rep records.
- Double-click to open “qryLookupAssignmentsbyClaimRep.” Enter the to be replaced IDPK # and press [ENTER].
Replace the existing ID by typing (or Find/Replacing) the chosen IDPK # in the ClaimRepID field.
- Close the query, then, from the table, locate and delete the entire record containing the just replaced IDPK.
11) For each claim rep record found on the invalid Office codes printout:
- From the table, click on “InsuranceCoID.” Press [CTRL] + [F]. Type the invalid company and click “Find First.”
- Write down the corresponding IDPK # and double-click to open “qryLookupAssignmentsbyClaimRep.”
- Enter the IDPK # and press [ENTER]. Copy the “Table.ClaimReps…” data to the “Table.Assignments…” field.
12) Close Microsoft Access.

9. Checking for and Approving New ACE-IT.com Applicants
1) From the desktop of an IT workstation, double-click to open Microsoft Outlook.
2) Browse to the “SupportACE” folder and locate any new messages containing the subject “ACE Member Signup.”
3) When a new member signup message is present:
- Print the signup message. Go to the Consultant PC. From the desktop, double-click to open “Web Admin.”
- If it is not already open, from the Access ACEWebPortalAdmin2K, double-click to open “frmAdminMembers.”
- From the Goto Member field within the form, type in the last name of the signee. From the pop-up list, click to
select the signee’s individual record. (If the signee has already signed up, delete his record from “tblMembers”
and send an email with his existing username, password info and indicating “You already have an account.”)
- Verify that the applicant is a legitimate ACE client. If the applicant is NOT legitimate, delete his record.
4) For each legitimate new record:
- Verify that information is filled out in all necessary fields. Complete/correct necessary info (like email address).
- From the ACE Office ID field, click the pull-down arrow and select the signee’s company from the menu list.
- From the Member Type field, click the pull-down arrow and select the applicant’s title.
- Click “Send Welcome Email ...” Click “OK” and then “Yes” in response to the two pop-up messages.
- Close Access, and, from the desktop, double-click to open “Outlook.”
- Click “Send/Receive” and then verify that the message sends successfully.
5) Close Microsoft Outlook and shut off the Consultant workstation monitor.
6) From an IT workstation, double-click to open Internet Explorer. From Internet Explorer, go to http://www.ace-it.com.
7) From the Member Login, type in the User ID and Password for the recently approved applicant, and click “Login.”
8) Verify that the user can view claims, etc. After verifying that the user account works properly, close Internet Explorer.
9) Double-click to open “Microsoft Excel.” Click “File -> Open…” Browse to “aceitDOTcomSignups” and click “Open.”
10) Type all necessary information in the “ACE-IT.com Members”, “Members-MGRs Only”, and “MGRs to Email !” pages,
referencing the signup message printout. Close Microsoft Excel.
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10. Retrieving New Internet Claims Submissions
1) From the desktop of an IT workstation, double-click to open Microsoft Outlook.
2) Browse to the “SupportACE” and locate any new messages containing the subject “Portal Claim Submission.”
3) For each of the new claims submission form messages:
- Double-click to open the message. Verify that an attachment is present. (If the file is an .oft, print it for the CSR.)
- If no attachment is present, but an attachment is listed in the email text, complete the following steps:
- Print the message to the Customer Service printer, then, from Internet Explorer, go to the ACE website.
- Logon to the website using an IT login.
- Once in the Portal, click on the “Employees Only” button and then click
the “View Claim Submission Attachments” link.
- Locate the listed image file and click on it. From the pop-up window, click “Open.”
- From the upper menu, select “File -> Print …” Select the Customer Service printer and click “Print.”
- Close the image window and Internet Explorer.
- NOTE: If the image cannot be opened/printed, inform the customer service department that the file
contains a corrupt image and that the claim rep must resubmit it.
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ACE IT Department Weekly Procedures
(The following steps are listed in the order in which they are to be performed during the week.)

1. MONDAY: Verifying that Auto Claims Transferred from Clerical to the ACE Office Program
Checking which Auto Claims Transferred and which Did Not
1)
2)
3)
4)

From the Desktop, go to Access Shortcuts and double-click to open “Shortcut to IT.mdb.”
From the Queries tab, double-click to run “qryEstimatesExportValidationOfficeLiveTable” (This step will take a while).
Once the results are retrieved, click on the printer icon to print the query list of estimates
For each file that is checked Proposal Only (indicated by a -1 in the ProposalOnly field of the query print out) …
- Open the file in Clerical.
- Click on the Notes/Remarks button and look in the Remarks box to determine whether or not the file is closed.
- If the file is closed, uncheck the “Proposal Only” checkbox.
- From the upper menu in Clerical, click the “Save” button. Answer “Yes” in response to the pop-up question.
- Write closed on the printed list.
5) For each file that is NOT checked Proposal Only (indicated by a 0 in the ProposalOnly field of the print out) …
- Return to the Queries tab in Access and double-click on the “qryOfficeTableByEstimateIDNumber” query.
- At the prompt, type the 6-digit file number and click “OK” to check for files (of that #) not checked Proposal Only.
- Access will conduct the search (which will take a while).
- If nothing appears in the query results, the file was never transferred to Office; Jot an X on the list next to the file.
- If a file appears in the query, verify the ACE field number. Write down the number on the list, noting
discrepancies between the two.

Transferring Files into Office
(Complete this section for all files that closed, but are not currently in the Office program under another number.)
1) From the desktop, double-click to open “Shortcut to clerical.”
2) After login, click the yellow folder to open a file, type the 6-digit file number, and then click “OK.”
3) Once the file opens, click on the “Notes/Remarks” button and double check to ensure that the file has not been cancelled.
4) From Explorer, browse to F:\Data\First Entry\Images\Copies\* (where * is the folder that contains the file).
5) Right-click and copy the file from within its specific folder. Browse up to F:\Data\First Entry\Images and right-click
to paste the file.
6) Repeat steps 2 – 5 for all the listed files to be transferred. Close Clerical.
7) Quickly return to Explorer and verify that all files copied to the Images directory get processed
(the files should disappear from the directory). Close Explorer.
8) Double-click to open the Approval program and then, for each file, type in its 6-digit number. View and Approve each.
9) Close Approval.
10) Return to the Access file “Shortcut to IT”.mdb, and from the Tables tab, double-click to open “TblAssignments.”
11) Locate the specific file(s) that were just reclosed and verify that the correct information (from the printed sheet)
appears in the Closed Date field.
12) Close the Access IT.mdb and DO NOT save changes.
13) Repeat steps 13-15, this time opening the Access file “Office.mdb” and locating the files in the table “Import.”

Verifying that Files Transferred Properly
(Perform this step on the day following file transfer)
1) From the desktop, double-click to open Office. From the upper menu in Office, go to “Maint\Edit Claims – Auto.”
2) From the Search Criteria tab, type the file number (beginning with the insurance co. code) in the ACE # field
and hit [ENTER].
3) Verify that the file close date matches the printed list close date and click “Update.”
4) Repeat steps 2 – 3 for all transferred files.
5) Close Office and hand the printed list to Linda Morelli.

2. WEDNESDAY: Archiving Sent Items from the Active Email Server .Pst File
1)
2)
3)
4)
5)
6)
7)
8)

Physically go to the ACE Email Server.
From Microsoft Outlook, click on “Sent Items.” Next, from the upper menu of Outlook, click “File -> Archive …”
Verify that the “Archive this folder and all subfolders” bullet is selected.
From the archive items drop-down menu, select yesterday’s date.
From the Archive file: field, arrow over to the end of the file name and change it to SentItems* (where * is today’s date).
Click “OK” to archive the Sent Items folder. Wait a few minutes and then verify that the archiving was successful.
Repeat steps 2 – 6, this time selecting the “Ariba Notifications” folder (and naming the file AribaNotifications*).
Repeat steps 2 – 6 one last time, selecting the “Ariba Processed” folder (and naming the file AribaProcessed*).
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3. WEDNESDAY: Repairing and Compacting the Conversion.mdb
(Verify that the Conversion PC is NOT running, then complete the following steps.)
1) From F:\Data\First Entry\Databases, locate and open “Conversion.mdb.”
2) Right click on the file “Conversion.mdb” and select “Copy.”
3) Right-click somewhere within the folder and select “Paste.” (It will take a few minutes for the database to copy.)
4) Once the file has copied, double-click to open “Copy of Conversion.mdb.”
5) From the upper menu of the database, select Tools\Database Utilities - > Repair Database. (This will take a while.)
6) Click “OK” in response to the successful repair pop-up message.
7) From the upper menu, select Tools\Database Utilities - > Compact Database. (This also will take a while.)
8) Once the compacting process is finished, close the Access database.
9) From Explorer, select and delete “Copy of Conversion.mdb.” Click the upper right-hand [X] to close Explorer.

4. WEDNESDAY: Rebooting the ACE Email Server
1) Go to the ACE Email Server. Click [X] to close the “ACE EClaim Mail Svr” and then “Microsoft Outlook.”
2) From the righthand side of the Windows toolbar, double-click on the 2 PCs icon to maximize “PE Internet Msg. Server.”
3) From the upper menu of the Internet Msg. Server, click “Unload Server.” Answer “Yes” in order to stop service.
4) From the righthand side of the Windows toolbar, double-click on the folded paper icon to maximize “Ariba Invoicing.”
5) From the Ariba Invoicing Module, click “Stop” and [X] to close the module. Answer “Yes” in response to the pop-up.
6) From the Start menu, shut down to Email Server. Wait about 10 seconds and then reboot.
7) Logon to the Email Server as EMS (Wait a minute for several programs to automatically load and run upon start up.).
8) Click “Hide” to minimize the PE Internet Msg. Server pop-up window.
9) Click “Start” and then click [-] to minimize the Ariba Invoicing Module pop-up window.
10) Double-click to open Microsoft Outlook and then double-click to open “Shortcut to EClaim Server.”

5. THURSDAY: Verifying that the Toshiba Phone System Data Backed up Properly
1)
2)
3)
4)

From the desktop of any ACE computer, double-click to open “Internet Explorer.”
Type 192.168.200.18 (the IP address of the phone system backup solution) into the address field of Internet Explorer.
At the iQ Smart Backup screen, type admin in the Username field, password in the Password field, and click “Login.”
Peruse the resulting iQ Smart Backup data screen to assure that the backup took place successfully on the current date,
and to assure that there’s free space left on the backup storage drive.
5) Click the upper right-hand [X] to close the Internet Explorer window.

6. FRIDAY (Bi-weekly): Running a Bi-Weekly Report for Zurich DRP
1) From the desktop of an IT workstation, double-click to open the “Access Shortcuts” folder and then “Shortcut to IT.mdb.”
2) From the Queries tab of the IT Access database, select “qryZURICHDRPclaims” and then click “Design.”
3) From the qryZURICHDRPclaims window, scroll to the ClosedDate row of data. Change the info in the cooresponding
Criteria: field to reflect the start date of the report range (Ex: >#01/01/2008# would pull all data as of/after Jan. 1, 2008).
4) Click the upper right-hand [X] to close the query and click “Yes” to save changes. Next, double-click to run the query.
5) Highlight the resulting data, paste it into an Excel spreadsheet, and email the spreadsheet to robbryson@ace-it.com.
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Zurich Billing Procedures
1. Examining and Resolving Zurich Ariba Unbilled/Unpaid AUTO Files
(Perform this procedure on the third and fourth Fridays of EACH month.)

Gathering and Printing the List of Unpaid Files
1) From the desktop of an IT workstation, double-click to open the folder named “Zurich.”
2) Double-click to open “ZurichASNAdmin.mdb.”
3) From the Forms tab of the ZurichASNAdmin database, double-click to open “Form1.” From the Form1 window, click
“Go.” Click “Yes” to the following three pop-up windows, and then click “OK.” Click [X] to close the Form1 window.
(NOTE: This form checks the Office program for any and every Zurich file that has NOT YET BEEN PAID.)
4) From the Queries tab of the ZurichASNAdmin database, double-click to run “qryAnalizeUnpaidFilesTable.”
(NOTE: This query will pull the list of unpaid files that need to be reconciled.)
5) From the upper menu of the Microsoft Access, select “File -> Print ...” From the Print window, click “OK.”
6) Retrieve the print out, then click the upper righthand [X] in order to close the qryAnalizeUnpaidFilesTable window.

Things to Note When Viewing this Print out, or the Property Print Out
*NOTE: Standard ACE fees for Zurich files are as follows:
- Auto = $30 Subro = $60 Heavy = $60 Property = $60 per hr Auto supp = $15 Over 5K job = $45
- Subro supp = Half the fee ($30) normally, but check with the auditor Property supp = check with the auditor
*NOTE: From the print out, look at the row of data labeled “ACE” and cross out all files that start with A30 or Z34/L.
These files (plus D95A,B, and C are NOT BILLED through Ariba, but rather are Empire files which are bulk billed.
*NOTE: Zurich reps must log into EZBuy and approve ALL BILLED ACE FILES that exceed the total amount
of $60.00 (whether the fee is for a single file OR a combination of billed files, such as original + supplements).
*NOTE: Files below the $60.00 total amount can be billed without a Zurich rep’s EZBuy approval.

1A - Requesting Payment on Files that are Determined to be Over $60.00
1) From the “Zurich” folder on the desktop, double-click to open “Ariba Supplier Network Supplier” to launch EZBuy.
Type robertgizzio@ace-it.com in the Username: field and osi***** in the Password: field, then click “Log In.”
2) From the lefthand window of the Ariba website home, under the Transactions section, click “Inbox.”
3) Referencing the print out, for each file over $60.00:
- From the Inbox of the Ariba website, type the file’s PO# (starting with DO) in the Search field and click “Search.”
- From the Search Results webpage, click on the “DO# link” listed beneath the Order #.
- From the Purchase Order webpage, view the file’s details to determine if it should be billed and for what amount.
- Click on the “Invoice: link” located beneath RELATED DOCUMENTS to view the file’s ACE invoice.
NOTE: From the Invoice webpage, an Invoice Status: of “Processing” (not “Approved”) indicates that
The file has definitely NOT BEEN PAID.
An Invoice Status: of “SENT”, but which has still not been paid, indicates the file is “stuck” in
the Ariba EZBuy system. Contact Janeen Craig at Zurich in order to get the file pushed through
the system for processing.
- If more than one invoice link appears on the Purchase Order webpage, click each link and then click
“Print” in order to print both invoices. Determine which of the two invoices was not paid, then take the
invoice print outs to Accounts Receivable for assistance in figuring out why two invoices were attached.
- Once the specifics of the unpaid file have been determined, from the “Zurich” folder on the desktop, double-click
to open “Zurich.oft.” This will open a Zurich-Ariba draft email into Microsoft Outlook.
- From the Purchase Order webpage, copy the following data, and paste the data over the ~s in the draft email:
- Claim rep email address (under SHIP ALL ITEMS TO) (NOTE: Paste this in the email’s To… field.),
claim # (under OTHER INFORMATION), Claim rep name (under DELIVER TO),
billing amount (under Ext. Price, and verified as the correct billing amount),
all necessary vehicle information (under OTHER INFORMATION), IR # (the Invoice link number).
NOTE: Type any additional notes, as needed, into the body of the email.
- Click “Send” in order to send the email message.
- On the Notes column of the print out, write down what I did with the file (ex: emailed Tracey 1/26).
- From the top of the Purchase Order webpage of the EZBuy website, click “Done” to return to the Inbox webpage.
4) Once payment has been requested on all files, click the upper righthand [X] in order to close the EZBuy website.
5) From the “Zurich” folder on the desktop, double-click to open “Unpaid_Zurichs.xls.” Enter all necessary info for files in
which email request for payment was sent.
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1B - Billing Listed Files (with No PO Number) that are Determined to be Supplements
1) Referencing the print out, for each supplement file (such as any file that is listed with a BalDue of 15):
- From the desktop, double-click to open “Approval.” Click “OK” at the Login window.
- Type the 6-digit ACE number (found on the print out) in the ACE Audit # field and press [ENTER].
- Click “View” in order to view the file, then peruse the file to determine if it is truly a supplement (Most easily
determined by looking at the Claimant field on page 1. If the name is followed by an “-A”, the file is a supp.).
- Click the upper righthand [X] in order to close the ACE Viewer window.
- From the upper menu of Approval, click “View -> Activity.” Browse through the activity subwindow to verify
the file was never sent through Ariba (files sent to Ariba have a line “Created/SubmittedInvoiceForARIBA_PO “).
A) To determine each file’s PO number:
- From the desktop, double-click to open “ACEViewer.” Referencing the print out, find the file’s CLAIM.
- From ACEViewer, type the claim number into the Claim No. field and click “Show Results.”
- From the results subwindow, note the ACE Number for the original Zurich file, not the listed supplement.
(If only one file is retrieved, the file is either NOT a supplement, or it’s claim # doesn’t match the original.
Try to do a search using the Policy No.)
- Click the upper righthand [X] to close ACE Viewer.
- From the desktop, double-click to open “Shortcut to clerical.” Click “OK” at the Login window.
- From the upper menu of Clerical, click the yellow folder icon.
- Type the 6-digit original ACE Number in the Enter a claim number field and click “OK.”
- Once the file pulls into Clerical, from the lefthand menu, click “Options.”
- Jot down the contents of the Cust. Billing Code field in the PONum field of the print out.
- Verify the “Received via ARIBA” checkbox is checked, then click the righthand [X] to close Clerical.
- Repeat subprocedure A until all PO numbers have been determined.
- Once the PO number has been determined, the file is ready to be billed (since it is under the $60.00 amount).
NOTE: If the PO number still cannot be determined, go downstairs and pull file paperwork to find the number.
- From the Queries tab of the ZurichASNAdmin data, double-click to run “qryFindEstIDFromDO.”
From the Enter Estimate ID window, type the 6-digit ACE number and click “OK.”
- From the pop-up results window, type the DO# in the CustBillingFld1 field and type –1 into the AribaClaim field
(This will automatically bill Zurich for the file.). Click the upper righthand [X] to close qryFindEstIDFromDO.
- On the print out, write a checkmark next to the file to indicate that I have billed for it.
- From the Queries tab of the ZurichASNAdmin data, double-click to run “qryActivityTableByAuditID.”
Type 6-digit ACE number in the ENTER AUDIT ID field and click “OK.”
- From the results table, check the ActivityDesc data and verify “Created/SubmittedInvoiceForARIBA_PO” exists
(This confirms that the file has been sent for billing.). Click the upper righthand [X] to close Microsoft Access.
- Close Approval.

2. Checking the Ariba Log File for Unprocessed Ariba Files
(Perform this procedure on a weekly basis.)
1) From the desktop of an IT Workstation, double-click to open “Shortcut to Logs.” Right-click on “ARIBAInvoicing.log”
and select “Copy.” Right-click on the desktop and select “Paste” to paste the ARIBAInvoicing.log file on the desktop.
2) Close the Logs folder, then, from the desktop, double-click to open “ARIBAInvoicing.log.”
3) Press [CTRL] + [END] to go to the bottom of the log file. Press [CTRL] + F. From the pop-up Find window, type
ERROR, click the “Up” bullet, and click “Find Next.” The next instance of ERROR will be found. Check its
corresponding date.
4) If the date of the most recent ERROR log entry is over one week old, close ARIBAInvoicing.log. The procedure is done.
If the date of the most recent ERROR log entry is less than one week old (and therefore unresolved):
- For each unresolved ERROR log entry, jot down the entry’s corresponding ACE number.
5) For each unresolved ACE Ariba file:
- From the desktop, double-click to open the folder “Zurich.” Double-click to open “ZurichASNAdmin.mdb.”
- From the Queries tab of the ZurichASNAdmin data, double-click to run “qryFindEstIDFromDO.”
- From the Enter Estimate ID window, type the 6-digit ACE number and click “OK.”
If CustBillingFld1 is empty and there is a –1 in the AribaClaim field, open Clerical and determine whether or not
the file is truly a Zurich file.
- If the file IS NOT a Zurich file, close Clerical, and type 0 in the query’s AribaClaim field.
(This will stop the non-Zurich file from attempting to bill through Ariba).
If the file IS a Zurich file, use Clerical to determine it’s DO# (Cust. Billing Code), then enter the DO# into the
CustBillingFld1 (This will cause the file to be billed to Zurich, as long as the AribaClaim field is set to –1).
6) Close ZurichASNAdmin.mdb and then close ARIBAInvoicing.log. Delete ARIBAInvoicing.log from the desktop.
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3. Examining and Resolving Zurich Ariba Unbilled/Unpaid PROPERTY Files
(Perform this procedure on the third and fourth Fridays of EACH month.)

Gathering and Printing the List of Unpaid Files
1) From the desktop of an IT workstation, double-click to open the folder named “Zurich.”
2) Double-click to open “ZurichASNAdmin.mdb.”
3) From the Forms tab of the ZurichASNAdmin database, double-click to open “Form1.” From the Form1 window, click
“Go.” Click “Yes” to the following three pop-up windows, and then click “OK.” Click [X] to close the Form1 window.
(NOTE: This form checks the Office program for any and every Zurich file that has NOT YET BEEN PAID.)
4) From the Queries tab of the ZurichASNAdmin database, double-click to run “qryAnalizeUnpaidPropertyFiles.”
(NOTE: This query will pull the list of unpaid files that need to be reconciled.)
5) From the upper menu of Access, select “File -> Print ...” From the Print window, click “OK.” Retrieve the print out.

Manually Forcing Unpaid Files to be Sent Through the Ariba ezBuy System
1) For ALL FILES listed on the print out:
- From the qryAnalizeUnpaidPropertyFiles window, highlight data in the CLAIM field, then right-click and “Copy.”
- Next, from the Queries tab of the ZurichASNAdmin database, double-click to open “qrytblPropByClaimNumber.”
- In the blank field of the Enter Claim Number pop-up window, right-click and “Paste” and then press [ENTER].
NOTE: If the results window returns NO DATA, the file CANNOT be submitted via ezBuy (certain offices
are NOT set up to bill ACEproperty files in this manner). Note this on the paperwork for a later check
in our system (see 3B) and/or discussion with Accounts Payable, then skip to the next file on the print out.
- If the results window returns data, referring to the list:
- Type the 5-digit ACE number into the PropACENum field.
- Type the BalanceDue number into the PropFee field.
- If the ACE office code is incorrect (very likely), type the ACE office code into the PropACEOffice field.
- Click the upper right-hand [X] to close the results window.
NOTE: Entering the ACE number and balance due prompts the file to be pushed to ezBuy for payment.
2) Wait a few hours, then from the Queries tab of the ZurichASNAdmin database, double-click to open
“qryActivityTableByAuditID.” For ALL FILES that were pushed through for payment in the previous step:
- Type the 5-digit ACE number in the ENTER AUDIT ID field and press [ENTER].
- Verify that the query returns data (the ActivityDesc field should contain text stating
“Created/SubmittedInvoiceForARIBA_PO”).
NOTE: If the data includes a line indicating it has been “Approved”, then no further course of action is required.
However, if there is no indication of approval, then the file is most likely over the automated ezBuy
Payment amount. In such cases, complete the following step (3A).

3A - Requesting Payment on Files that are Determined to be Over $75.00
(Perform this procedure a day or two after pushing the unpaid property files through to ezBuy ~ see previous procedure.)
1) From the “Zurich” folder on the desktop, double-click to open “Ariba Supplier Network Supplier” to launch EZBuy.
Type robertgizzio@ace-it.com in the Username: field and osi***** in the Password: field, then click “Log In.”
2) From the lefthand window of the Ariba website home, under the Transactions section, click “Inbox.”
3) Referencing the print out, for each file over $75.00:
- From the Inbox of the Ariba website, type the file’s PO# (starting with DO) in the Search field and click “Search.”
NOTE: To determine the file’s PO#, from the Queries tab of the ZurichASNAdmin database, double-click to open
“qrytblPropByClaimNumber.” Type the file’s claim number at the Enter Claim Number pop-up window
and then press [ENTER]. The PO# will appear in the PropPONum field of the query results.
- From the Search Results webpage, click on the “DO# link” listed beneath the Order #.
- From the Purchase Order webpage, view the file’s details to determine if it should be billed and for what amount.
- Click on the “Invoice: link” located beneath RELATED DOCUMENTS to view the file’s ACE invoice.
NOTE: From the Invoice webpage, an Invoice Status: of “Processing” (not “Approved”) indicates that
The file has definitely NOT BEEN PAID.
An Invoice Status: of “SENT”, but which has still not been paid, indicates the file is “stuck” in
the Ariba EZBuy system. Contact Janeen Craig at Zurich in order to get the file pushed through
the system for processing.
- If more than one invoice link appears on the Purchase Order webpage, click each link and then click
“Print” in order to print both invoices. Determine which of the two invoices was not paid, then take the
invoice print outs to Accounts Receivable for assistance in figuring out why two invoices were attached.
- Once the specifics of the unpaid file have been determined, from the “Zurich” folder on the desktop, double-click
to open “Zurich.oft.” This will open a Zurich-Ariba draft email into Microsoft Outlook.
- From the Purchase Order webpage, copy the following data, and paste the data over the ~s in the draft email:
- Claim rep email address (under SHIP ALL ITEMS TO) (NOTE: Paste this in the email’s To… field.),
claim # (under OTHER INFORMATION), Claim rep name (under DELIVER TO),
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billing amount (under Ext. Price, and verified as the correct billing amount),
all necessary vehicle information (under OTHER INFORMATION), IR # (the Invoice link number).
NOTE: Type any additional notes, as needed, into the body of the email.
- Click “Send” in order to send the email message.
- On the Notes column of the print out, write down what I did with the file (ex: emailed Tracey 1/26).
- From the top of the Purchase Order webpage of the EZBuy website, click “Done” to return to the Inbox webpage.
4) Once payment has been requested on all files, click the upper righthand [X] in order to close the EZBuy website.
5) From the “Zurich” folder on the desktop, double-click to open “Unpaid_Zurichs.xls.” Enter all necessary info for files in
which email request for payment was sent.

3B - Scanning Zurich Files to Determine Whether or Not They Have Been Submitted via ezBuy.
(Perform this procedure for all files on the printed list that were initially determined to have NOT been submitted via ezBuy.)
1) From Explorer, browse to F:\Data\First Entry\EClaimEmailReturn\Server\ARIBA_POs and then, from the upper menu,
click “Search” (or press [CTRL] + [F]).
2) From the left-hand search menu that appears, click the “All files and folders” link.
3) From the “Look in” drop-down menu, verify “ARIBA_POs” is the location. Next, for EACH possible non-submitted file:
- Type the file’s claim number into the “A word or phrase in the file” field and click “Search.”
- Wait about 10 minutes or so for the search to complete.
If NO results are returned, the file WAS TRULY NEVER submitted through Ariba’s ezBuy system.
(If this is the case, give the file’s information to the Accounts Receivable Department to determine if a request
for payment was sent out via fax or other means.)
If a result is returned, the file WAS submitted through ezBuy, but mistakenly as an Auto instead of a Property file.
(If this is the case, repeat procedure 3 “Manually Forcing Unpaid Files to be Sent Through the Ariba System”,
entering necessary info into all (blank) fields of data. NOTE: Type 1 in the PropLineNum field,
-1 in the PropIsARIBA field and 0 in the PropInvSent field.)

4. Reprinting a Previously Processed Zurich Ariba File Cover Sheet
(Perform this procedure upon request from the customer service department.)
1) From Windows Explorer, browse to F:\Data\First Entry\EclaimEmailReturn\Server\ARIBA_POs.
2) Locate the PO/DO # for the file that the customer service rep requested to have reprinted.
3) Double-click to open the appropriate PO folder. From within the PO folder, double-click to open “coversheet.pdf.”
4) From the upper lefthand menu of Acrobat, click “File -> Print …” From the Printer name: dropdown of the Print
window, select “\\SERVER1\CustSvc” and then click “OK” in order to print to the customer service printer.
5) Click the upper righthand [X] to close Acrobat and then close Explorer.

5. Manually Creating an Additional Billing Invoice in ezBuy for a Previously Closed File
(Perform this procedure upon receiving word from Accounts Receivable that a file has been reopened & needs add’l billing.)
1) From the desktop of an IT workstation, double-click to open the folder named “Zurich.”
2) Double-click to open “ZurichASNAdmin.mdb.”
3) From the Queries tab of the ZurichASNAdmin database, double-click to run “qryActivityTableByAuditID.”
Type the 5 or 6-digit ACE# into the “ENTER AUDIT ID” field and press [ENTER]. Scroll to the bottom of the query
results window and then highlight and right-click & “Copy” the DO# contained in the “ActivityInfo1” column.
4) Click the upper righthand [X] in order to close the Zurich Access database.
5) From the “Zurich” folder on the desktop, double-click to open “Ariba Supplier Network Supplier” to launch EZBuy.
Type robertgizzio@ace-it.com in the Username: field and osi***** in the Password: field, then click “Log In.”
6) From the lefthand window of the Ariba website home, under the Transactions section, click “Inbox.”
7) From the Inbox of the Ariba website, right-click and “Paste” the file’s PO# (starting with DO) in the Search field and then
click “Search.” From the Search Results webpage, click on the “DO# link” listed beneath the Order #.
8) From the Purchase Order webpage, click “Create Invoice.” From the drop-down menu, click “Standard Invoice.”
9) From the Invoice # field of the Invoice Header webpage, type the 5 or 6-digit ACE# followed by – 2 digit mth, day, yr.
10) Click “Next.” At the following webpage, check the Line Ref # checkbox, change the Quantity to 1, and change the Unit
Price amount field to the billing charge amount. Click “Update.” Verify the unit price has updated and click “Next.”
11) Scroll down at the next webpage and type relevant comments (about the additional charge) in the COMMENTS field.
NOTE: These comments can be pulled from Clerical (for auto files) or the Property Reports program (for property files).
12) Click “Next” and then click “Submit” to submit the invoice for payment by the Zurich rep who handled the original file.
13) Click the “Exit” link. At the following webpage, jot down the name and number of the claim rep and then click the
upper right-hand [X] to close the ezBuy Internet Explorer window.
14) Finally, add the relevant information into the Unpaid Zurich Excel spreadsheet in order to follow up on the file until paid.
15) Once the file is paid… Forward the ezBuy payment confirmation email to a billing department representative.
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6. Checking the Unpaid Files Query Against Accounts Receivable Dept’s EFT Outstanding Invoice Report
(Perform this procedure once a month, when The Accounts Receivable Rep delivers an Outstanding Invoice Report.)
1) From the desktop of an IT workstation, double-click to open the folder named “Zurich.”
2) Double-click to open “ZurichASNAdmin.mdb.”
3) From the Forms tab of the ZurichASNAdmin database, double-click to open “Form1.” From the Form1 window, click
“Go.” Click “Yes” to the following three pop-up windows, and then click “OK.” Click [X] to close the Form1 window.
(NOTE: This form checks the Office program for any and every Zurich file that has NOT YET BEEN PAID.)
4) From the Queries tab of the ZurichASNAdmin database, double-click to run “qryAnalizeUnpaidFilesTable.”
(NOTE: This query will pull the list of unpaid files that need to be reconciled.)
5) From the upper menu of the Microsoft Access, select “File -> Print ...” From the Print window, click “OK.”
6) Retrieve the print out, then click the upper righthand [X] in order to close the qryAnalizeUnpaidFilesTable window.
7) For each file contained on the EFT Outstanding Invoice Report:
- Check the number against the list of files contained on the unpaid files printed sheet.
~ If the file appears on the printed sheet of unpaid files, mark on the invoice report that the file is still unpaid.
~ If the file does not appear on the printed sheet …
- From the Queries tab of the Zurich ASNAdmin database, double-click to run
“qryActivityTableByAuditID.” Type the 6-digit ACE# listed on the EFT Report into the
“ENTER AUDIT ID” field and press [ENTER].
- From the query results window, check the row labeled “ActivityInfo1” for an “Approved” line entry.
- If the file shows as Approved (the most likely case), check the row labeled “ActivityDate&Time” to
determine when the file was approved.
~ If the file has been approved recently (since the last EFT process date), the file has probably been paid,
and will appear on the next month’s EFT report. Cross the file off of the invoice report list.
~ If the file has NOT been approved recently, but months ago, call Ed Crygier (847) 240-8000 x.6363 at
Zurich and explain that we have a file that shows as having been approved on such and such a date, yet
is not appearing on our readmittance advice (EFT). Ask him to look into this to see what’s going on.
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Ordering Toner and Other Start-of-Month Procedures
1. Verifying that the Office Has a Sufficient Quantity of Toner
1) Physically go to the customer service toner closet. Verify that AT LEAST the following are contained within the closet:
- 1 Sharp FO6600 (45DR) Drums, 2 Sharp FO6600 (45NDA) Toners, 1 Panasonic UG-5520 Toner,
1 Canon GPR-15 Toner, 1 Mita DP-9100/9120 (TK70) Toner, and 1 Mita DP-9130 (TK-712) Toner.
2) Go to the IT closet and verify that it contains the following:
- 1 Sharp FO6600 (45DR) Drum, 2 Sharp FO6600 (45NDA) Toners, 4 Panasonic UG-5520 Toners,
1 Mita DP-9100/9120 (TK70) Toner, 2 Mita DP-9130 (TK-712) Toners, 3 Canon GPR-15 Toners (for all
Canon ImageRunner models, 1 HP 4050 (27x) Toner, 1 HP 4100 (C61x) Toner, Dell Color 5110cn (1 each color
C, Y, M, & K), 1 HP Laserjet (03A) Toner, and 1 KM-2050 (TK-411) Copier Toner.
3) When any of the current toners or drums is below its detailed minimum level, do one of the following:
- For Sharp, Panasonic, Mita, Canon products, call and place order with Rhonda at Heritage (856-722-7001 x. 21).
NOTE: Give model #s for each fax when ordering and serial #s AND current meter readings for each printer.
- For HP products, send an e-mail to Janet at janetgizziopeterkin@ace-it.com with an HP toner order request.

2. Running Monthly Reports and Billing Statements
1) See the separate document titled “Larry’s Monthly Reporting and Billing Tutorial.doc.” NOTE: This will take much time.

3. Updating Test Company (R43Q) Files for Web Reporting
1) From the AccessShortcuts folder on the Desktop, double-click to open “Shortcut to IT.mdb.”
2) From the Tables tab, double-click to open “tblAssignments.” Click “FileNumber” to highlight the FileNumber column.
Press [CTRL] + [F] simultaneously. From the pop-up, type R43Q621371 in the Find What field and click “Find First.”
3) Once the Find function locates the R43 file, click “Close” in order to close the pop-up.
4) From the ClosedDate field for the specific file, change the date to reflect a day within the month that has just ended.
5) Next, change the date to a recent date in both the ReceivedDate and LossDate fields.
6) Repeat steps 3-6 for the rest of the test R43Q files (#s 621378, 621382, 621385, 621387, 621389) then close the database.
7) From Explorer, browse to F:\Data\First Entry\Images\Copies\621xxx. Select each of the six R43Q files and copy them.
Browse to F:\Data\First Entry\Images and paste the files. Close Explorer and wait a few minutes for the files to process.
8) From the Desktop, double-click to open Approval. Log in and then approve each of the files. Close Approval.
9) From the AccessShortcuts folder, double-click to open “Office.” From the Tables tab, double-click to open “Import.”
10) Select and delete each of the R43Q files and answer “Yes” in response to any pop-up messages. Close Office.mdb.
11) Wait a while for files to transfer to the web. Next, from the Desktop, double-click to open “Internet Explorer.” Login as
the R43Q rep and, from the Reports tab, verify that the files pull properly into the web report. Close Internet Explorer.

4. Paring Down the Size of ACE Log Files
1) From Explorer, browse to F:\Data\First Entry\Logs. For each .log file in the Logs directory, verify that the .log file has a
size less than 10,000 KB. For each file over 10,000 KB:
- Make sure that all computers related to the log are turned off (ex. turn off fax servers when fixing the FaxSvr.log).
- Right-click in the window and select “New -> Folder.” Name the folder year-month-daySaved.
- Right-click on the .log file and select “Cut.” Browse to the newly created folder and select “Paste.”
2) Close Explorer. When the computer systems associated with the logs restart, a new .log will be automatically created.

5. Removing Former Company Reps from the Claim Rep Database
1)
2)
3)
4)
5)

From the desktop, open the “Access Shortcuts” folder and then double-click to open “Ins Comp Admin MDB.”
From the ACE Insurance Company Administration window, press [F11].
From the Queries tab of the pop-up database window, double-click to open “qryClaimRepNamesPreceededbyZ.”
Print the contents of the resulting window and then click the upper right-hand [X] in order to close it.
Retrieve the printout and then browse for EVERY claim rep name starting with the letter z whose name does not truly
start with z (ex: zDavid Jones). Write down the claim rep’s corresponding IDPK#.
6) From the Tables tab of the pop-up database window, double-click to open “tblClaimReps.”
7) For each claim rep number written down, highlight the ClaimRepIDPK column, press [CTRL] + [F], and then from
the Find pop-up window, type in the rep number and press [ENTER]. Click “Close” to close the Find window.
Next, select and delete the contents of the claim rep’s InsuranceCompanyID field.
8) Once finished disassociating all claim reps, click the upper right-hand [X] to close the Access Claim Rep Database.
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Installing Auditing Program Software Updates
(Complete the following steps the Wednesday after the software updates are received in the mail, or immediately after.)

1. Installing Mitchell UltraMate Updates
Loading the Mitchell UltraMate Update CDs
1) Load the latest Mitchell UltraMate update DVD into the Server’s (or an IT workstation’s) DVD-ROM drive.
Click “Cancel” if/when the CD starts to run automatically.
2) From Explorer, browse to C:\UltramateTempDVD. Copy all the information from the CD and paste it into this folder.
3) After 7PM, when all the UltraMate users are logged out of the network, go to the C:\ drive of the Server.
4) Browse to C:\UltramateDVD. Select all the files, then right-click and select “Cut” to remove them from the folder.
5) Next, browse to C:\UltramateDVD-lastmonth. Select all the files and press [DELETE]. Click “Yes” and “Yes to All”
at the “Are you sure?” Pop-up window. Next, right-click in the folder and “Paste.” Click “Yes to All” at the pop-up.
6) Browse to C:\ UltramateTempDVD. Select all the files, then right-click and select “Cut” to remove them.
7) Again, browse to C:\UltramateDVD. Right-click in the folder and select “Paste.” Click “Yes to All” at the pop-up.
8) Close Explorer. Right-click on the “Recycle Bin” and then select “Empty Recycle Bin.” Click “Yes” at the pop-up.
9) From the Start Menu, click “Log Off Administrator …” Answer “Yes” at the pop-up to log out of the server.
10) Turn off the Server monitor and then lock and alarm the server closet.

Updating Mitchell UltraMate on All Workstations
1) Physically go to the auditing department area and start ALL auditor workstations.
2) From EACH Mitchell UltraMate user workstation (AND ALSO from the Consultant workstation):
- From the login window, logon to the auditor’s system.
- From Explorer, browse to M:\ and double-click to run “setup.exe.” The Mitchell update will now launch.
NOTE: If the message “Setup is unable to exclusively lock UltraMate…” appears, browse to C:\Mitchell\ACES
and double-click to run “util_frlock.exe (UltraMate Freelock).” Click “Ignore” to run freelock, click the upper
right-hand [X] to close it, and then rerun “setup.exe.”
- Click “Next” (or “Update UltraMate”) in order to run the update for the software.
- At the UltraMate Setup Complete window, press [CTRL] + [ALT] + [DELETE] instead of clicking “Finish.”
- From the pop-up window, click “Task Manager” and then, from the Applications tab of the Task Manager
window, select “UltraMate 7.0…” and click “End Task” in order to halt the Mitchell Communications app install.
- Click the upper right-hand [X] to close the Task Manager window and then shut down the auditor workstation.

2. Installing Audatex PenPro Updates
1) Physically take the PenPro Software and Vehicle Data update DVD to the server closet.
2) Insert the DVD into the server’s DVD-ROM drive.
(*See the update sheet to determine whether or not a program update is a part of the DVD contents.)
3) For EACH Audatex PenPro user workstation:
- From Windows Explorer, select “Tools -> Map Network Drive …”
- From the Drive pulldown menu, select empty drive letter Z. Type \\server1\cd and then click “Finish.”
- Close Explorer. From the desktop, double-click “PenPro.”
- *If there’s a program update, a “Next” pop-up button will appear. Click the button in order to install the update.
- Once the program update is finished, or if there is not program update, a “Load Data” pop-up button will appear.
Click the button in order to install updated database information.
- After the update is complete, the Audatex PenPro login window will open.
- Click “OK” at the login window.
- Confirm that a PenPro Monthly Update .pdf window launches and then click “OK” to close that window.
- *If a program update was installed, click “Receive …” and then, from the Where drop down menu,
select “CIECA.” Click “Browse …” From the pop-up, browse to C:\ADP\Cieca and click “OK” to re-path
the import directory. Next, click “Done.”
- Click the upper right-hand [X] to close the PenPro claims window.
- Answer “Yes” at the pop-up and click “Exit PenPro” to close Audatex PenPro.
4) Return to the server closet, retrieve the PenPro DVD, and store it upstairs.

3. Installing Cyclemate Updates
1) From the Desktop of the specialty auditor’s workstation, double-click to open “Cyclemate.”
The program will automatically search for and download any necessary updates. Once the updates are finished,
click “Close” at the Readme window.
2) From the upper menu of Cyclemate, select “Data” and then click “Status.” Confirm that the “Manufacturer’s Price as of”
data for each vehicle book falls within the last thirty days. Click “OK” to close the window and then close Cyclemate.
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Archiving Auditing Program Files
(Before proceeding, print out a copy of the ACE Logins report for assistance in accessing the auditors’ workstations.)

1. Archiving Mitchell UltraMate Estimates
Archiving UltraMate Estimates
(Complete this procedure on a Wednesday at mid-month, from EACH of the Mitchell UltraMate workstations.)
1) From Explorer, browse to (personal IT directory)\Excel Docs and double-click to open “Running Updates.xls.”
2) From the bottom of the Excel spreadsheet, click the “Updating-UltraMate Archive” tab. Next, click “File -> Print …”
Click “OK” in order to print the tracking sheet and retrieve it from the printer.
3) Physically go to EACH auditor workstation and power on his workstation.
4) Log on as the user. Open Windows Explorer and browse to C:\Archive. From within the Archive folder, create a
new folder labeled as follows: oldest day in the archive_most recent day in the archive, in 2-digit date format
(for example, 01-15-09_04-15-09).
5) Next, click and drag to highlight ALL folder. Files located in the C:\Archive folder. Right-click and select “Cut.”
Double-click to open the newly created folder and then right-click somewhere in the folder window and select “Paste.”
6) Open UltraMate and log on as ACE. Look at the total estimates number (equal to y in the upper menu’s line x of y
Estimates Displayed) and mark it down on the UltraMate Tracking Sheet.
7) From the top menu bar, select Utilities, and then Archive. Click “Browse …”, select C:\Archive, and click “Set Path.”
8) Click “Select …” to access the Archivable UltraMate files menu list.
9) Scroll to the right portion of the files menu and click on the “Date” field to sort the UltraMate files by date (descending).
10) Scroll down to locate the first file/date to begin archiving (found on the UltraMate Tracking Sheet).
11) Hit the Control-Shift-End keys to select all files to be archived and click “OK.” For Specialty Auditor workstations,
scroll to the “Status” field. Press the [CTRL] key and click to deselect all files NOT “E COMMITTED.”
12) Click “Archive” to archive the estimates. Once archiving is finished, click the folder icon to open the Estimates window.
13) Look at the total estimates number, mark it down on the UltraMate Tracking Sheet.
14) Close the Estimates window (by pressing ESC) and then click the upper right-hand [X] to close UltraMate.

Zipping Archived Estimates and Transferring Them to the Network
1) Click on the “Start” menu button and then select “Run ...” Type F:archive and then press [ENTER].
2) Once the archive files/folders have been zipped and transferred to the network, shut down the workstation.
3) Physically file the UltraMate Tracking Sheet in the Mitchell file folder (located in the upper left cabinet drawer).

2. Archiving Audatex PenPro Estimates
(Complete this procedure on a Wednesday at end-of-month, from EACH of the Audatex PenPro workstations.)
1) Physically go to the Audatex PenPro workstation. From Windows Explorer, browse F:/Archive-PenPro. Right-click
somewhere and select “New -> Folder.” Name the folder after the previous month, current year. Close Explorer.
2) From the desktop, double-click to open “PenPro.” Click “OK” at the login screen.
3) From the Claims menu, click “Send …” From the Send window, change the “Where” pulldown menu to “Disk.”
4) From the Drives: pulldown menu of the lefthand Choose a Directory section, select F:/.
Next, double-click to open Archive-PenPro, then double-click to open the specific month’s subdirectory.
5) Click to select EACH AND EVERY file found in the archivable files list.
6) Click “Move to Disk.” Wait about a minute for the selected files to be archived out of PenPro.
7) Click “OK” at the pop-up window, then click “Done” in order to close the Send window.
8) Next, from the Claims menu, click “Receive …” From the Receive window, change the “Where” pulldown to “Disk.”
9) From the Drives: pulldown menu of the lefthand Choose a Directory section, select F:/.
Next, double-click to open Archive-PenPro, then double-click to open the specific month’s subdirectory.
10) Click to select each file found in the archivable files list with a status of “In Progress.”
11) Click “Move from Disk.” Once the retrieval has finished, click “OK” at the pop-up, then “Done” to close the window.
12) Click the upper righthand [X] to close the PenPro claims window, then click “Yes” at the pop-up. Click “Exit PenPro.”

3. Archiving MSB IntegriClaim Property Estimates
(Complete this procedure at the end of the day on the first day of the month, from a Property workstation.)
1) Physically go to one of the MSB IntegriClaim workstations.
2) From the desktop of the MSB IntegriClaim workstation, double-click to open “IntegriClaim.”
3) From the upper menu of IntegriClaim, click “Tools -> Archive Claims.”
4) From the upper portion of the Archive Claims window, click “Select by Date.”
5) From the Select by Date window, enter the date (equivalent to 6 months prior to the CURRENT DATE) and click “OK.”
The list of claims to be archived will become highlighted.
6) Next, click the “Archive” button and answer “Yes” in response to the pop-up window.
7) When the archive is finished, click “Close” at the Archive Claims window. Close MSB IntegriClaim.
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Monthly E-mail-Related Procedures
1. Emailing Monthly Web Report Reminders to ACE Clients
(Complete this procedure on the first day of the month.)
1) From the Start menu, go to “Programs -> Outlook Express.” Click on the “Drafts” folder.
2) Right-click on each of the two draft messages present and select “Copy to Folder ...” Select “Drafts” and click “OK.”
3) From the Desktop, double-click to open “Microsoft Excel.” Click on the folder icon and open “aceitDOTcomSignups.”
4) From the MGRs to Email! tab, browse to the Email column and delete all rows that are colored (indicating duplicate info).
5) Next, select all data under the Email column and press [CTRL] + [C] in order to copy it (do not copy State Auto info).
6) Return to Outlook Express and double-click to open one of the two draft files addressed to John Campbell.
7) Select all items in the Bcc: field and delete them. Next, press [CTRL] + [V] to paste the copied files into the email.
8) Click “Send” in order to send the email.
9) Repeat steps 5-8, this time copying State Auto email addresses only, and pasting them into the To: field of one of the two
draft files addressed to dave.ebner@stateauto.com. Close Outlook Express.
10) From the Desktop, double-click to open “Microsoft Outlook.” After time, note the email address associated with any
email that failed to send properly. Go to Excel and highlight/color the fields associated w/ these bad email addresses.
11) Click the upper right-hand [X] to close Microsoft Excel.

2. Replacing the Outlook.pst File on the Email Client
(This Procedure should be performed at night, at a time when the .pst file approaches 1GB in size.)
1) Physically go to the Email Client (when no one is using it). From the desktop, double-click to open Microsoft Outlook.
2) Copy down on paper the names of all Inbox subfolders (there should be around 75 folders, named after businesses).
3) Click the “Send/Receive” button. Note on paper all new emails that load into the Inbox and close Outlook.
4) From Explorer, go to F:\Data\Outlook\EmailClient\Outlook and locate “Outlook.pst.” Right-click on the file and rename
it Outlook00_00_00.pst (where 00_00_00 equals the current date).
5) Next, right-click on the previous file Outlook00_00_00.pst file and rename it, moving the date beyond the .pst extension
so that the file will no longer register in Outlook (example: Outlook.pst00_00_00 (today’s date)).
6) Next, right-click on “Outlook.pstforRECREATION” and select “Copy.” Right-click and then “Paste” the file.
7) Right-click on the newly pasted file and rename it “Outlook.pst.”
8) Minimize Explorer. From the desktop, double-click to open Microsoft Outlook.
9) Click “OK” in response to any pop-up messages.
10) Once Outlook has opened the new .pst, a large number of messages will transfer into the Inbox. Quickly remove the
preview pane. To do so, from the upper menu in Outlook, click View -> Current View -> “Customize Current View…”
Click “Other Settings” and then select the “Off” bullet beneath “Reading Pane.” Also uncheck “Show items in Groups.”
11) File the newly transferred messages (that in reality were previously received by employees today), deleting all that are
older than today’s date. Leave any “new” messages noted earlier (which the employees have not viewed) in the Inbox.
12) Click the upper right-hand [X] to close Microsoft Outlook.

3. Replacing the Outlook.pst File on the BSN Email Client
(This Procedure should be performed at night, at a time when the .pst file approaches 1GB in size.)
1) Go to the BSN Email Client (when no one is using it). From the desktop, double-click to open Microsoft Outlook.
2) Click the “Send/Receive” button. Note on paper all new emails that load into the Inbox and close Outlook.
3) From Explorer, go to F:\Data\Outlook\BSNEmailClient and locate “Outlook.pst.”
Right-click on the file and rename it Outlook00_00_00.pst (where 00_00_00 equals the current date).
4) Next, right-click on “Outlook.pstforRECREATION” and select “Copy.” Right-click and then “Paste” the file.
5) Right-click on the newly pasted file and rename it “Outlook.pst.”
6) Minimize Explorer. From the desktop, double-click to open Microsoft Outlook.
7) Click “OK” in response to any pop-up messages.
8) Once Outlook has opened the new .pst, a large number of messages will transfer into the Inbox. Quickly remove the
preview pane. To do so, from the upper menu in Outlook, click View -> Current View -> “Customize Current View…”
Click “Other Settings” and then select the “Off” bullet beneath “Reading Pane.” Also uncheck “Show items in Groups.”
9) File the newly transferred messages (that in reality were previously received by employees today), deleting all that are
older than today’s date. Leave any “new” messages noted earlier (which the employees have not viewed) in the Inbox.
10) Click the upper right-hand [X] to close Microsoft Outlook.
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ACE IT Department Bi-Annual (Twice a year) Procedures
1. Rerun the NOD32 Full System Scan
For each user workstation that has internet access (Print out the Running Updates.xls (Updating-AntiVirus) for reference):
1) Log on to the user’s workstation as the appropriate user.
2) From the lower right-hand corner of the Windows toolbar, double-click the NOD32 icon to launch the program.
3) From the left-hand menu of the ESET NOD32 AntiVirus 4 window, click “Computer scan.”
4) From the resulting display in the right-hand portion of the program window, click “Smart scan”
in order to begin a scan of the system’s hard drive.
5) Upon completion of the scan, click to delete or quarantine any located viruses.
6) From the upper right-hand corner of the ESET NOD32 AntiVirus 4 window, click the [-] button to minimize the program.

2. Rerun SpyHunter and Anti-Malware System Scans
For each user who has SpyHunter, Anti-Malware installed on their system (Print out the Running Updates.xls for reference):
1) Log on to the user’s workstation as the user.
2) From the Start Menu, go to Programs -> popup blockers and click to open “SpyHunter.”
NOTE: The popupblockers folder might be located on the desktop instead of in the Start Menu.
3) From the left-hand menu of the main SpyHunter window, click “Update.” (NOTE: This step may not be necessary.)
4) Next, click the “Program Update” button. Click “OK” in response to the pop-up message if there are no program updates.
If there is an update, once updates have downloaded, check the “Yes, I agree …” checkbox and then click “Next.”
A SpyHunter program update will now be installed on the workstation. Click “Finish” at the “Installation Complete”
Message. Double-click to once again open “SpyHunter.” If necessary, click “Cancel” at the pop-up IE Settings window.
5) From the left-hand menu of the main SpyHunter window, click “Update.”
6) Next, click the “Definitions Update” button. SpyHunter will now download definition updates.
7) Once the updates have been downloaded, click “OK” in response to any pop-up messages.
8) From the left-hand menu of SpyHunter, click “Options.” If checked, uncheck “Start SpyHunter Security Suite on Boot.”
9) From the left-hand menu of the main SpyHunter window, click “SpyHunter Scanner.”
10) From the menu to the right, click “Start Scan” – ensuring that “Smart Scan” and “Fixed drive” (C:) options are checked.
11) Once the scan has completed, check the “Check all parasites” checkbox located in the Infection Details window
and then click “Start Remove.” SpyHunter will now remove all infections.
12) Click the upper right-hand [X] to close SpyHunter.
13) If a program update was downloaded, click the Start Menu button, then locate “SpyHunter” among the menu items listed.
Right-click on it and select “Delete.” Answer “Yes” at the pop-up. Next, browse to the desktop. If another “SpyHunter”
icon has been created there, right-click on it and select “Delete.” Answer “Yes” at the pop-up. Right-click on the
Recycle Bin and select “Empty Recycle Bin.” Click “Yes” in response to the pop-up message.
14) From the Start Menu (or desktop), open the popup blockers folder and click to open “Malwarebytes’ Anti-Malware.”
15) From the main Anti-Malware window, select the Update tab and then click “Check for Updates.” Updates should now
download successfully - If not, continue to “Exit” and re-open Anti-Malware and click “Check for Updates” until the
updates download (at which point a confirmation pop-up message will appear. Click “OK” in response to the message
and then the program will update and then will likely close). If necessary, reopen “Malwarebytes’ Anti-Malware.”
16) Repeat step 14 until the “You have the latest database version” message is displayed.
17) Next, select the Scanner tab and then, with the “Perform quick scan” setting bulleted, click “Scan.”
18) Once the scan has completed, click “OK” in response to the pop-up message.
19) Click the “Show Results” button and then, with all infections checked, click “Remove Selected.”
20) From the NotePad window, click the upper right-hand [X] in order to close the log file and then click “OK” in response
to the pop-up message or “Yes” to reboot, if necessary. If a reboot isn’t needed, click “Exit” to close Anti-Malware.

3. Rerun Windows Update
For each user workstation that has internet access (Print out the Running Updates.xls for reference):
1) For each internet user on the Excel Updating-Windows list, log on to the user’s workstation as the user.
2) After login, from the Start Menu, select “Windows Update.”
3) Click the “Scan for updates” link. After an updateable file scan runs, click “Review and install updates.”
4) Click “Yes” at the pop-up and then, from the lefthand menu, click “Critical Updates and Service Packs.”
5) Click Add/Remove to compile all necessary files, then click “Install Now.” Click “Accept” or “Next” to install files.
6) After installation is complete, click “Finish”, then “OK” to reboot. Upon reboot, logon to the network as the user.
7) Repeat steps 2-6, until all necessary updates have been downloaded and then shutdown the user’s workstation.
8) Note the date of the system update and transfer to the Excel document “Running Updates.xls (Updating-Windows).”
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4. Replacing the Outlook.pst File on the Email Client
(Perform this procedure after 7PM, when noone will be sending email, and when the .pst file approaches 1GB in size.)
1) Physically go to the Email Client workstation.
2) From the upper menu of Microsoft Outlook, click “File” and then select “Import and Export …”
3) From the Choose an action to perform: menu, select “Export to a file” and then click “Next.”
4) From the Create a file of type: menu, select “Comma Separated Values (Windows)” and then click “Next.”
5) From the Select folder to export from: menu, select “Contacts” and then click “Next.”
6) Click “Next” again with the export path set to “C:\Documents and Settings\CS\Desktop\contacts.csv”, then click “Finish.”
7) From the upper menu of Microsoft Outlook, click “Tools” and then select “Accounts …”
8) For EACH email account, select the account and then click “Properties.” From the Advanced tab
of the Account Properties window, uncheck “Leave a copy of messages on server” and click “OK.”
9) Click “Close” to close the Internet Accounts window.
10) From the upper menu of Microsoft Outlook, click “Send/Receive.”
11) Open and print each newly received email message, along with ALL corresponding attachments.
12) Once all messages have been printed, press the [Print Screen] button.
13) Close Outlook. Next, from the Start Menu, click “Programs” and then select “Microsoft Word.”
14) From Microsoft Word, right-click somewhere and “Paste” to paste a copy of the Outlook window into the document.
15) From the upper menu of Word, click the “Print” printer icon in order to print the document.
16) Click the upper right-hand [X] to close Word, answering “No” to any pop-up messages, then retrieve the print out.
17) From Explorer, browse to F:\Data\Outlook\EmailClient\Outlook and locate “Outlook.pst.”
18) Right-click on the file and rename it Outlook00_00_00.pst (where 00_00_00 is the current date’s 2-digit day, mth, yr).
19) Next, right-click on the file named “Outlook.pst4RECREATION” and select “Copy.” Right-click somewhere in an
empty space and select “Paste.” Rename the file “Copy of Outlook.pst4RECREATION” to Outlook.pst.
20) Minimize Explorer. From the desktop, double-click to re-open Microsoft Outlook. Answer “Yes” at the pop-up message
stating that the .pst has changed.
21) Next, from the upper menu of Microsoft Outlook, click “Send/Receive.” Verify that only messages more recent than
the ones on the printed sheet load into the Inbox.
22) From the upper menu of Microsoft Outlook, click “Tools” and then select “Accounts …”
23) For EACH email account, select the account and then click “Properties.” From the Advanced tab of the
Account Properties window, re-check “Leave a copy of messages on server” and click “OK” in order to reset the
mailserver to store messages for a period of 5 days. Click “Close” to close the Internet Accounts window.
24) From the upper menu of Microsoft Outlook, click “File” and then select “Import and Export …”
25) From the Choose an action to perform: menu, select “Import from another program or file” and then click “Next.”
26) From the Select file type to import from: menu, select “Comma Separated Values (Windows)” and then click “Next.”
27) Click “Next” again with the verify file to import path set to “C:\Documents and Settings\CS\Desktop\contacts.csv.”
28) From the Select destination folder: menu, select “Contacts” and then click “Next.”
29) Click “Finish” to import the contact list into Microsoft Outlook. From the upper menu, click “Tools” and then select
“Address Book …” Verify that contacts are present in the pop-up Address Book window and then click [X] to close.

5. Installing MSB IntegriClaim Database Updates
(Perform this procedure four times a year, at the end of each quarter - end Nov, end Feb, end May, and end Aug.)
1) From the desktop, open “Internet Explorer.” Type http://www.msbinfo.com/Downloads/Claims/CostDB in the address
window of Internet Explorer, then press [ENTER]. A webpage titled www.msbinfo.com - /Downloads/Claims/CostDB/
should appear, containing links to downloadable databases. If does NOT, complete the following:
- Type www.msbinfo.com in the address window of Internet Explorer and then press [ENTER].
- From the upper menu of the MSB website, click the “Support” button. Next, from the left-hand Support menu
found on the Support page, click the “Catastrophe Support” link.
- Scroll down the main body of text found on the Catastrophe Support page and click the “Storm Database” link.
2) From the list of downloadable files, right-click on the MOST RECENTLY posted TCC/TCD link and “Save Target As ...”
3) From the pop-up Save As window, change the Save in: location to F:\ and then click “Save.”
4) Repeat steps 2 and 3 in order to save the latest JCPenney’s and Best Buy files to the F:\ drive.
NOTE: If these are NOT available for retrieval from the site, email jack.prokes@marshallswift.com to request.
5) Physically go to one of the MSB IntegriClaim workstations, verifying that no users have the IntegriClaim program open.
6) From the desktop of one of the MSB IntegriClaim workstations, double-click to open “IntegriClaim.”
7) From the upper menu of IntegriClaim, click “Exit.” Check BOTH checkboxes at the pop-up window to back up data.
8) Repeat step 6. From IntegriClaim’s upper menu click “System.” From the System Maintenance window, click “Import.”
9) From the Import Price Database window, click the “[…]” button found to the right of the Import From Path field.
From the Select Import Path pop-up window, pull the drop-down and then select “F:\” and click “OK.”
10) Next, from the Files Available section of the Import Price Database window, select the database to be imported and then
click “Import.” The database files will now import into MSB IntegriClaim. Repeat this step for all databases to be added.
11) When all database importing is finished, click the upper right-hand [X] in order to close MSB IntegriClaim.
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6. Reindexing and Fixing MSB IntegriClaim Tables
(Perform this procedure on the first day of every other month, at a time of day when noone is in the IntegriClaim program.)
1) From the Start Menu, select “MSB IntegriClaim -> IntegriClaim Utilities” and then click “Reindex Tables.”
NOTE: Running this utility will enhance the performance of IntegriClaim (similar to a defrag).
2) A Backup Claim Files window will automatically pop up and begin scanning the IntegriClaim program.
3) After several minutes, once the scan has completed, MSB IntegriClaim will automatically launch.
From the upper menu of IntegriClaim, click the “Exit” button. Click “Exit” again at the pop-up to close IntegriClaim.
4) From the Start Menu, select “MSB IntegriClaim -> IntegriClaim Utilities” and then click “Fix Tables.”
5) From the MSB IntegriClaim Table Utility window, select the “Claim Data” bullet and then click “Scan for Errors.”
6) After several minutes, once the scan has completed (indicated by the message “VERIFY ONLY PROCESSING –
COMPLETE”), click “View Errors.”
7) Click “Close” at the pop-up Verify window. If NO ERRORS were found, skip to step 10.
If any errors were listed in the window, click “Fix Errors.”
8) After several minutes, once the fix process has completed, re-click “Scan for Errors.”
9) Repeat steps 6 – 9, until no errors are found.
10) Next, select the “Accounting Data” bullet and then click “Scan for Errors.”
11) After several minutes, once the scan has completed (indicated by the message “VERIFY ONLY PROCESSING –
COMPLETE”), click “View Errors.”
12) Click “Close” at the pop-up Verify window. If NO ERRORS were found, skip to step 15.
If any errors were listed in the window, click “Fix Errors.”
13) After several minutes, once the fix process has completed, re-click “Scan for Errors.”
14) Repeat steps 11 – 14, until no errors are found.
15) Click the upper right-hand [X] in order to close the MSB IntegriClaim Table Utility window.

7. Creating a Ghost Copy of the Email Server to the Backup Email Server
(Perform this procedure once a quarter, in the evening at a time when few users will likely be logged into the ACE website.)
1) Remove the 500GB hard drive from the backup email server, which should be labeled (and stored in the IT room).
2) Shut down the in-service email server and put a Norton Ghost 2003 SATA Boot Disk in the floppy drive.
3) Connect the drive to the SATA connector which rests atop the in-service email server.
Connect a third party power block to the drive in order to give it power.
4) Boot up the email server and press [F2] in order to enter the BIOS screen.
5) Verify that the primary and secondary hard drives are both set to “on” and that both drives are showing.
6) Save and exit the bios and allow the system to boot from the floppy drive to Norton Ghost.
7) Create a Ghost copy from the primary drive (in-service email server) to the secondary/500GB drive (backup server).
8) Once the Ghost image copy is finished, disconnect the backup drive and return it to the backup server PC.
Also, reboot the in-service email server and start all applications upon EMS login.

8. Running Disk Defragmenter
(Complete this procedure once a year, in November or December, for EVERY computer in the office.)
1) From the desktop, double-click to open “My Computer.” Right-click on “Local Disk (C:)” and select “Properties.”
2) From the Local Disk (C:) Properties window, click the Tools tab and then click “Defragment Now …”
3) From the menu list, click to highlight “(C:)” and click “Defragment.” (The defragment process will take a while.)
4) Click “Close” to close the pop-up window that appears once the defragment process has finished.
5) Click the upper righthand [X] to close Disk Defragmenter. Next, click the upper righthand [X] to close My Computer.

9. Cleaning Out Computers
(Complete this procedure once a year, in April or May, for EVERY computer in the office.)
1) Unplug all devices from the computer.
2) Take the computer outside and spray clean with a can of air.
3) Return the computer to the appropriate desk and plug in all devices.
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10. Daylight Savings-Standard Time Switching: Changing Times on Necessary Office Equipment
(Perform this procedure twice a year, in early Mar. and late Oct. Confirm the exact dates each calendar year.)

A. Changing the Date/Time on a Sharp FO-6600 Fax Machine
1)
2)
3)
4)
5)
6)

From a Sharp FO-6600 fax, press the “Function” button and then “3.” Entry Mode will now appear on the fax display.
Next, press “4.” Date and Time Set Mode will now appear on the fax display.
Enter the date over top of the date appearing on the display. Next, enter the NEW TIME over top of the time appearing.
After entering the time, press the “*” button if the current time is in the AM, or the “#” button if the time is in the PM.
Press the “Start” button to save changes to the time, and then press “Stop” twice in order to return to the main display.
Wait a minute or so and then verify that the machine’s time has been changed and saved properly.

B. Changing the Date/Time on a Canon ImageRunner 3225 Machine
1) From the right-hand panel of a Canon ImageRunner printer/fax, press the “Additional Functions” button.
The Additional Functions Menu will appear on the display.
2) Next, press the “System Settings” button on the screen display. The System Settings Menu will appear on the display.
3) Press the down arrow icon to view page two of the System Settings Menu.
4) Press the “Date and Time Settings” button on the screen display. The Date and Time Menu will appear on the display.
5) From the right-hand panel of the Canon ImageRunner printer/fax, using the numeric keys, enter the correct date and time.
6) Press the “OK” button on the screen display, and then “Done” twice in order to save the time change properly.

C. Changing the Date/Time on a Panafax UF-990 Fax Machine
1)
2)
3)
4)
5)

From a Panafax UF-990 fax, press the “Function” button and then “7.” Set Mode will now appear on the display.
Next, press “1.” Function Parameters will now appear on the fax display. Press the “Set” button.
Enter the date over top of the date appearing on the display. Next, enter the NEW TIME over top of the time appearing.
Press the “Start” button to save changes to the time, and then press “Stop” in order to return to the main display.
Wait a minute or so and then verify that the machine’s time has been changed and saved properly.

D. Changing the Date/Time on the Three Downstairs Closet Honeywell Temperature Panels
1) From a Honeywell temperature panel (in the Server or Billing closet), press the “Set Current Date/Time” button.
2) Press the button again to move the time ahead an hour OR 23 more times to move it back one hour (Press the up/down
arrow keys to change minutes). Finally, press the “Run Program” button to save changes and return to the main display.

E. Changing the Date/Time on the Time Clock
(NOTE: Robert keeps the Time Clock Tutorial in a file that sits atop his desk. Grab this tutorial for reference, if necessary.
1) Open the upstairs closet and grab the time clock key (which reads “AMANO”).
2) Physically go to the time clock. Insert the key in the keyhole of the clock and turn it 45 degrees clockwise.
3) From the time clock panel, press [2] [0] [E].
4) The time clock display will read “001.” Next, type the 2-digit month followed by the 2-digit day when time will
“spring forward” by 1 hour, and then press [#]. For example, if the date is March 9th, the entry would be [0] [3] [0] [9] [#].
5) The time clock display will now read “001 (2).” Type the 2-digit month followed by the 2-digit day when time will
“fall backward” by 1 hour, and then press [E]. For example, if the date is November 2nd, enter [1] [1] [0] [2] [E].
6) To save/exit the setup section of the time clock, now that times have been updated, press the upper left-hand blue [I] key.
7) Turn the key 45 degrees counter-clockwise, remove it, and return it to the upstairs closet.

F. Changing the Date/Time on the Phone System via a Toshiba Phone
(NOTE: The date/time may also be changed via the eManager software. To do so… Login, click “Basic Configuration”,
Click “Date and Time”, then change the time and click “Submit.” To change the date/time on the Stratagy ES
Administration software… Login, and from the upper menu click “Tools -> Date/Time …” Change the time and click OK.”)
1) Dial 400 to connect to the ACE phone system.
2) Next, dial 999#. The system will state “That security code is invalid. Enter your mailbox number. Finish by pressing #.”
3) Again, dial 999#. The system will ask for a security code.
4) This time, dial 999997#.
5) Next, press 8 in order to access the system Administration menu.
6) Press 6 to set the date and time.
7) Next, press 2 to set the time.
8) Using 2-digits for both the hour and the minutes, enter the appropriate time (using military time for PM hrs), then press #.
9) Press 1 and then press 9 in order to save changes to the phone system, then hang up the phone.

G. Changing the Date/Time on the DSC Power832 Alarm System AND the Four FaxServers
1) Remind Robert to change the time on the alarm system… AND manually modify the times of the 4 Win98 faxservers.
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MSB IntegriClaim Reactivation and Office Import
1. Reactivating MSB IntegriClaim
(Note: This procedure should be done every 6 months, when ACE’s IntegriClaim license nears expiration.)

Determining When MSB IntegriClaim is Set to Expire
1) From the desktop of a property workstation, double-click to open “MSB IntegriClaim.”
2) From the upper menu of IntegriClaim, click “Help” and then select “Register Software.”
3) From the pop-up Register MS/B IntegriClaim window, take note of the date that IntegriClaim will expire.

Calling to Reactivate Licenses for MSB IntegriClaim
1) Verify that all MSB IntegriClaim property auditors are out of the MSB IntegriClaim program.
Then, from the desktop of a property workstation, double-click to open “MSB IntegriClaim.”
2) From the upper menu, select “Help” and click on “Register Software.” The Register IntegriClaim window will open.
3) Call the phone number found in the window (888-337-9667). Once connected, press 2 to reactivate the software.
4) Wait for a MSB customer service rep to answer the call.
5) When the MSB customer service rep picks up the phone, first give your name. Then explain that you are with
American Computer Estimating, and that you have 5 user licenses and would like a 3 month extension on them.
6) Once prompted by the MSB customer service rep, read the Serial number and Signature (found in the
Register IntegriClaim window) to him/her.
7) Next, once instructed by the rep, click “Register.” Answer “Yes” in response to any pop-up messages.
8) Enter in the new Serial number and Signature provided by the rep and click “OK” to apply the new registration code.
9) After the code is integrated into the program, IntegriClaim will automatically close.
10) Reopen IntegriClaim and verify that it does not lock. If it does, see the Correcting MSB IntegriClaim Errors procedure.

2. Importing Property Files into the Office Program
(When the Quality Control Manager is away, do this procedure every day - in the evening or early morning.)
1) Verify that all Property auditors are out of the MSB program. Then, physically go to Larry’s PC,
turn on the system, and login.
2) From the system Start menu, select “Programs\MS-DOS Prompt.”
3) At the DOS Prompt, type Larry. Two files will copy to a new directory.
4) Close the DOS Prompt.
5) From the desktop, double-click to open the Access file “DDS Conversion.”
6) From the Select a batch pull down menu, select “<NEW>.” An audit list will be built.
7) Once the audit list is complete, click “Export to Office.” The audit export process will begin.
8) Once the audits have exported, look at the batch list to ensure no files need to be edited (for example, a file’s
Contractor Information must be less than 30 characters to be accepted by ACE Office).
9) Click the upper right-hand [X] to close MSB Conversion.
10) If one of the files from the batch needs fixed …
- From the desktop, double-click to open “DDS Fix.”
- Type in the audit claim number.
- Go to the Contractor Information and retype the information so that equals less than 30 characters.
- Click the upper right-hand [X] to close DDS Fix.
11) From the Desktop, double-click to open “ACE Office.”
12) Verify that all Office users are out of the Office program and then, from the upper menu in Office,
select “Maint” and click on “Import Routine.”
13) Answer “Yes” at the pop-up window to proceed with import.
14) Once complete, a status window will pop up, containing the import details.
15) After perusing the details, click the upper right-hand [X] to close ACE Office.
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Installing and Customizing Windows 2000 on a Workstation
1. Deleting / Recreating a Partition on the Hard Drive and Formatting the Partition
1) Make sure that a keyboard, mouse, monitor, network cable, and power is connected to the workstation.
(NOTE: If the system has PS/2 ports, plug in a PS/2 keyboard and mouse. If not, then plug in a USB keyboard, mouse.)
NOTE: If the system does not have a CD-ROM drive, open the computer and attach a CD-ROM drive ribbon to the system’s
secondary IDE Channel, with jumper pins set to master settings.
2) Turn on the system’s power. Upon system startup, insert the Windows 2000 installation CD.
3) Quickly press the [F12] key to access the Boot Menu (or the necessary key, if the system is NOT a Dell).
NOTE: Not all systems have a Boot Menu feature. For these systems:
- Upon system start up, press [DELETE] or [F2] (if the system is a Dell) in order to access the BIOS Setup window.
From the BIOS Setup, set the Boot Sequence. Set it to “CDROM A, C.”
- If the CD-ROM drive is set to “None”, reset it to “Auto.”
- Press [ESC] and select to save changes and exit the BIOS.
Upon restart, the system will boot from the CD-ROM. Skip the next step (step 4).
4) From the Boot Menu Device List, arrow down and select “CDROM” and then press [ENTER].
5) Next, at the on-screen prompt, press any key in order to boot from the CD-ROM drive.
6) From the Windows 2000 Setup window, press [ENTER] and then press [F8] to agree to the Licensing Agreement.
7) Press [ESC] to continue to the installation list. From the installation list, for each partition item listed, press [D],
[ENTER], and then [L] in order to delete the partition. Once the list shows only “Unpartitioned space”, press [ENTER].
8) Select “Format the partition using the NTFS file system” and then press [ENTER].

2. Installing Windows 2000
1) Click “Next” at the Regional Settings window.
2) At the Personalize Your Software window, type the UserType (Approval, Auditor, Clerical, EmailClient, EmailServer,
FaxServer#, or Manager Name) in the Name field, ACE at the Organization field, and click “Next.”
3) Enter the Windows 2000 license # (included with software, or found on the box) and click “Next.”(May be unnecessary.)
4) Type ACE* (where * is the system #) in the Computer name field and the LOCAL Administrator Password in the two
Administrator Password fields and click “Next.”
5) From the Time Zone drop down menu of the Date & Time Settings window, select “GMT 5:00 Eastern time” and then
click “Next” in order to run the installation.
6) At the Network Settings window, choose the “Custom settings” bullet and click “Next.”
7) Select “File and Printer Sharing for Microsoft Networks.” Click “Uninstall”, “Yes” in order to remove, and then “Next.”
8) Select the “Yes, make this computer a member of the following domain …” bullet, type ACE in the Workgroup or
domain field, and click “Next.” At the pop-up, type the NETWORK Administrator username and password in the
corresponding fields and click “OK.” Wait a few minutes while system components install.
9) After installation, click “Finish.” The system will reboot.

3. Configuring Windows Network Settings
1) Once the system reboots, click “Next” at the Network Connection Wizard window.
2) From the “Add the following user” section of the User Account window, type in the designated user’s username in the
User name field, and ACE in the User domain field, and then click “Next.”
3) At the User Level window, click the “Other” bullet. From the drop down menu, select “Administrators.” Click “Next.”
4) Click “Finish.” Press [CTRL] + [ALT] + [DELETE] and login to the network as the DESIGNATED USER.
5) After the Getting Started with Windows 2000 window pops up, uncheck “Show this screen at startup” and click “Exit.”

4. Copying the Windows 2000 I386 Folder
1) From Windows Explorer, browse to the D:\ (CD-ROM) drive. Right-click on the “I386” folder and select “Copy.”
2) Browse to C:\. Right-click somewhere and select “Paste” and then click the upper right-hand [X] to close Explorer.
3) Remove the Windows 2000 installation CD from the CD-ROM drive. Replace (if applicable) with the Dell Resource CD.

5. Installing Windows 2000 System Drivers
(Install the system drivers in this manner only if the system is a Dell.)
1) Click “OK” at the pop-up installation message. Click “Next” at the Welcome window in order to run the installation.
2) Click “Finish” once the installation is complete. The Dell Resource CD window should automatically open.
If not, from the Start Menu, select Programs -> Dell Accessories -> and click to open “Dell ResourceCD.”
3) Check the “Click here to prevent this from displaying again” checkbox and click “Next.”
4) From the Resource CD Selection window list, install the following drivers:
- Audio (only in rare cases, when the user is to receive sound), Controller, Network, and Video Drivers.
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5) ITEM INSTALLATION DETAILS: Click the appropriate link found beneath Controller Drivers.
6) At the next window, scroll down and select “Extract” to extract the files. Click “Continue” at the pop-up window.
7) Within the Unzip the files field, type C:\Dell\Drivers\Controller and click “Unzip.” Click “OK” then “Install Now.”
8) From the installation window, click through all necessary messages in order to install the controller drivers.
9) Once the installation is complete, click “Finish” with “Yes, I want to restart my computer now” bulleted.
10) Once Windows is up, Press [CTRL] + [ALT] + [DELETE] and login to the network as the user.
Click to reboot the system a second time, and then re-login as the user (if necessary).
11) From the Start Menu, select Programs -> Dell Accessories -> and click “Dell ResourceCD.”
12) From the Resource CD Selection window list, click the appropriate link found beneath Network Drivers.
13) At the next window, scroll down and select “Extract” to extract the files. Click “OK” at the pop-up window.
14) Within the Unzip the files field, type C:\Dell\Drivers\NIC and click “Unzip.” Click “Yes” at the pop-up and then
click the upper right-hand [X] to close the Network Driver Installation window.
15) From the Dell Resource CD window, Scroll up and click “Return” to return to the Resource CD Selection window list.
16) From the Resource CD Selection window list, click the appropriate link found beneath Video Drivers.
17) At the next window, scroll down and select “Extract” to extract the files. Click “Continue” at the pop-up window.
18) Within the Unzip the files field, type C:\Dell\Drivers\Video and click “OK.” Click “Yes” at the pop-up, then “OK.”
19) From the installation window, click through all necessary messages in order to install the video drivers.
20) Once the installation is complete, click “Finish” with “No, I will restart later” bulleted. Close the Resource CD window.
21) Remove the Dell Resource CD. Next, From the Start Menu, select “Settings” and click “Control Panel.” Double-click
“Add/Remove Programs.” From the Add/Remove Programs window, click “Dell ResourceCD” and “Change/Remove.”
22) Select the “Remove” bullet and click “Next.” Click “Yes” at ALL pop-ups and “Finish” to uninstall the Resource CD.
23) Click the upper right-hand [X] to close the Add or Remove Programs window and the Control Panel.

6. Downloading and Installing Windows 2000 Updates
1) From the Start Menu, click “Shut Down …” and click “OK” with “Shut down” selected. If the system is not currently
hooked up at the IT bench area, move and hook it there. Be sure to connect the COMCAST cable into the network jack.
2) Turn on the system’s power. Once Windows is up, login to the system locally as the LOCAL Administrator.
From the Start Menu, click “Windows Update.” From Internet Explorer, click “Connect me to the Internet.”
3) At the Internet Connection Wizard window, select the “Connect through a LAN“ bullet and click “Next.”
4) Select the “Connect through a LAN” bullet again and click “Next”, then uncheck all options and click “Next.”
5) Click the “No” (mail account) bullet and click “Next.” Click “Finish” to connect to the internet.
6) From the Windows Update website, click through all preliminary pop-up messages.
NOTE: The following steps may differ from the notes slightly, as Microsoft occasionally alters their Updates webpages.
7) At the webpage which loads, click the “Windows 2000 Service Packs” link. From the resulting webpage, click the
“Windows 2000 Service Pack 4” link. From the right-hand side of the resulting webpage, click “Go.” Click “Yes”
in response to any pop-ups. From the right-hand side of the resulting webpage, click the “SP4 Express Installation” link.
8) Click the “Run this program from its current location” bullet and then click “OK.” Answer “Yes” at the pop-up.
9) Click through all necessary messages in order to install Microsoft Windows Service Pack 4 and then “Finish” to reboot.
10) Press [CTRL] + [ALT] + [DELETE] and login to the system locally as the LOCAL Administrator.
Once Windows is up, from the Start Menu, click “Windows Update.”
11) From the resulting webpage, click “Install Now” in order to download Windows Update Installer software.
12) After the installer software installs, from the resulting webpage, click the “Internet Explorer Downloads Website” link.
13) From the left-hand menu of the Internet Explorer Downloads webpage, click the “Internet Explorer 6” link.
14) From the Other Windows Version section of the resulting webpage, click the “Install Internet Explorer 6 SP1” link.
15) From the Download Internet Explorer 6 webpage, scroll down and click the “Download Center” link. From the
resulting webpage, click “Download” and then click through all preliminary pop-up messages in order to install.
16) Once the installation is complete, click “Finish” and then “OK” to reboot. Next, repeat step 10.
17) Click “Custom” at the Keep Your Computer Up to Date screen. The site will scan the system for necessary updates.
18) From the resulting webpage, click “Download and Install Now” in order to download the Windows Update Installer.
From the resulting webpage, click “Restart Now.” Next, repeat step 10.
19) Click “Custom” at the Keep Your Computer Up to Date screen. The site will scan the system for necessary updates.
20) Once the list of updates appears, from each left-hand menu, select the checkbox/bullet for all files that need installed.
21) After compiling all necessary files, from the left-hand menu, click the “Install Updates” link and then “Install Updates.”
22) From the installation pop-up, click “I Accept” (and/or “Next”) in order to download and install the update files.
23) Once update installation is complete, click “Restart Now.”
24) Repeat step 10 and then steps 19 - 23 until all necessary Windows 2000 updates have been installed.
25) Once the system is COMPLETELY UPDATED, from the Start Menu, select “Settings” and then click “Control Panel.”
Double-click “Automatic Updates.” From the Automatic Updates window, select the “Download updates,
but let me choose when to install them” bullet and click “OK.” Click the upper right-hand [X] to close the Control Panel.
26) From the Start Menu, click “Shut Down …” and click “OK” with “Shut down” selected. Remove the COMCAST cable
from the network jack and replace it with a regular ACE network cable. Turn on the system’s power.
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7. Customizing Windows 2000
Customizing Windows Explorer
Once Windows is up, Press [CTRL] + [ALT] + [DELETE] and login to the network as the user.
1) From Windows Explorer, right-click somewhere in the right-hand window and select “View -> Details.”
2) From the upper menu of Explorer, select “Tools” and then click “Folder Options …”
3) From the General tab of the Folder Options window, select the “Use Windows classic folders” bullet and click “Apply.”
4) From the View tab, uncheck the following checkboxes/bullets:
- “Hide extensions for known file types”, “Hide protected operating system files” (and answer “Yes” at the pop-up),
“Remember each folder’s view settings”, and “Show My Documents on the Desktop.”
5) Next, click the following checkboxes/bullets:
- “Display the full path in the address bar” and “Show hidden files and folders.” Next, click the
“Like Current Folder” button and answer “Yes” at the pop-up.
6) From the Registered file types list of the File Types tab, scroll down and select VBE, then click “Delete” and answer
“Yes” at the pop-up. Repeat this step, this time selecting VBS.
7) From the Offline Files tab, uncheck “Enable Offline Files.” Click “Apply” and then “OK.” Close Windows Explorer.

Customizing Windows Login Settings
1) From the Start Menu, select “Settings” and then click to open “Control Panel.”
2) Double-click to open “Users and Passwords.” From the Advanced tab, uncheck “Require users to press Ctrl-Alt-Delete.”
3) Click “Apply” and then “OK” to accept settings changes, then click the upper right-hand [X] to close the Control Panel.

Customizing the Recycle Bin
1) From the desktop, right-click on the “Recycle Bin” icon and select “Properties.”
2) Uncheck “Display delete confirmation dialog.” Click “Apply” and then “OK.”

Customizing Desktop and Display Properties
1) From the upper menu of Windows Explorer, select “Tools” and then click “Map Network Drive …”
Type \\server1\files in the Folder field of the Map Drive window and click “Finish” with “Reconnect at logon” checked.
2) From the pop-up Explorer window, double-click to open “ACE desktop.” Right-click and copy “Ace800x600.bmp”
and “ace.scr.” Browse to C:\WINNT. Right-click somewhere and select “Paste.”
3) Next, from C:\WINNT, click to sort by “Type” and delete all non-hidden .bmp files EXCEPT for “Ace800x600.bmp.”
Click to re-sort by “Name”, then browse to C:\WINNT\Web. Select and delete the “Wallpaper” folder.
Browse to C:\Documents and Settings\user\My Documents\. Delete “My Pictures” and click “Yes to All” at the pop-up.
Browse to C:\WINNT\System32. Click to sort by “Type”, scroll down, then select and delete all .scr (screensaver) files.
4) Close both copies of Windows Explorer, then from the desktop, right-click somewhere and select “Properties.”
5) From the Background tab, select “Ace800x600” and then click “Apply.” Next, click “Pattern …”
6) For each pattern:
- Select the pattern, click “Edit Pattern …”, click “Remove” and answer “Yes” to the pop-up, and then click “Done.”
7) Click “OK” to close the Pattern window.
8) From the Screen saver drop down of the Screensaver tab, select “ace.” In the Wait field, type 15 and then click “Apply.”
9) Next, click “Power …” From the Power Schemes tab, set the drop down menus as follows:
- Turn off monitor: “After 2 hours”, Turn off hard disks: “Never”, System standby: “Never.”
10) From the Advanced tab of the Power Options, uncheck “Prompt for password when computer resumes from standby.”
11) From the Hibernate tab of the Power Options, check “Enable hibernate support.” Click “Apply” and then “OK.”
NOTE: There are additional power option considerations when dealing with a laptop computer…
- From the Alarms tab, under Critical battery alarm, click “Alarm Action …”
From the Alarm Actions window, change the “When the alarm goes…” drop down to “Hibernate.” Click “OK.”
Also, from the Advanced tab, change the “When I close the lid of my computer” drop down to “Hibernate”
And the “When I press the sleep button on my computer” to “Do Nothing.”
Also, from the Power Schemes tab, select options for all Running on Batteries options. Click “Apply” then “OK.”
12) From the Appearance tab, be sure “Desktop” is currently selected under “Item” and change the default color to dark blue.
Change the “Item” option to “Selected Items” by clicking on the drop down arrow and change the color to dark purple.
13) From the Effects tab, uncheck “Use transitions effect for menus and tooltips.”
14) From the Settings tab, verify the screen resolution is running at 800 x 600 pixels and the highest color quality
(usually 32-bit, but this depends on the video card). If not, change to these settings and click “Apply.”
Answer “OK” at the pop-up message and then click “Yes.”
15) Click “OK” in order to close the Display Properties window.
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Customizing the Windows Toolbar
1) Right-click on the Windows toolbar and select “Properties.”
2) From the General tab, uncheck “Use Personalized Menus.”
3) From the Start Menu Settings list of the Advanced tab, check “Display Logoff.” Click “Apply” and then “OK.”

Customizing System Properties
1) From the desktop, right-click on “My Computer” and select “Properties.”
2) From the Startup and Recovery section of the Advanced tab, click “Startup and Recovery ...”
From the Startup and Recovery window, uncheck “Display list of operating Systems…” and then click “OK.”
3) From the Hardware tab, click the “Device Manager ...” For each Device Manager item listed under Network adapters:
- Right-click on the network adapter and select “Properties.”
- Click on the Power Management tab (if present).
- Uncheck “Allow the computer to turn off this device…” and then click “OK.”
4) Click the upper right-hand [X] to close the Device Manager and then click “OK” to close the System Properties window.
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Installing and Customizing Windows XP on a Workstation
1. Deleting / Recreating a Partition on the Hard Drive and Formatting the Partition
1) Make sure that a keyboard, mouse, monitor, network cable, and power is connected to the workstation.
(NOTE: If the system has PS/2 ports, plug in a PS/2 keyboard and mouse. If not, then plug in a USB keyboard, mouse.)
2) Turn on the system’s power. Upon system startup, insert the Windows XP installation CD.
3) Quickly press the [F12] key to access the Boot Menu (or the necessary key, if the system is NOT a Dell).
4) From the Boot Menu Device List, arrow down and select “CDROM” and then press [ENTER].
Next, at the on-screen prompt, press any key in order to boot from the CD-ROM drive.
5) From the Windows XP Setup window, press [ENTER] and then press [F8] to agree to the Licensing Agreement.
6) Press [ESC] to continue to the installation list. From the installation list, for each partition item listed, press [D],
[ENTER], and then [L] in order to delete the partition. Once the list shows only “Unpartitioned space”, press [ENTER].
7) Select “Format the partition using the NTFS file system (Quick)” and then press [ENTER].

2. Installing Windows XP
1) Click “Next” at the Regional and Language Options window.
2) At the Personalize Your Software window, type the UserType (Approval, Auditor, Clerical, EmailClient, EmailServer,
FaxServer#, or Manager Name) in the Name field, ACE at the Organization field, and click “Next.”
3) Enter the Windows XP license # (included with software, or found on the box) and click “Next.”(May be unnecessary.)
4) Type ACE* (where * is the system #) in the computer name field and the LOCAL Administrator Password in the two
Password fields and click “Next.”
5) From the Time Zone drop down menu of the Date & Time Settings window, select “GMT 5:00 Eastern time” and then
click “Next” in order to run the installation. After the system reboots, click “OK” to any monitor-related pop-ups.
6) At the Welcome to Microsoft Windows window, click “Next.”
7) At the Help protect your PC window, select the “Not right now” bullet and click “Next.”
8) From the Who will use this computer? window, type owner in the Your name field and click “Next.”
9) Click “Finish” in order to run Windows XP for the first time.

3. Copying the Windows XP I386 Folder
1) From Windows Explorer, browse to the D:\ (CD-ROM) drive. Right-click on the “I386” folder and select “Copy.”
2) Browse to C:\ (and click “Show contents” if need be). Right-click somewhere in C:\ and select “Paste.” Close Explorer.

4. Installing Windows XP System Drivers
(Install the system drivers in this manner only if the system is a Dell.)
1) Remove the Windows XP installation CD from the CD-ROM and replace it (if applicable) with the Dell Resource CD.
2) Click “OK” at the pop-up installation message and “Next” at the Welcome window.
3) Click “Install” to run the installation, then click “Finish” once the installation is complete. The Dell Resource program
should open. If it doesn’t, from the Start Menu, select “All Programs -> Dell Accessories” and click “Dell ResourceCD.”
4) Check the “Click here to prevent this from displaying again” checkbox and click “Next.”
5) From the Resource CD Selection window list, install all check-marked items but Audio drivers (only used in rare cases).
NOTE: Marked items usually include Audio, Controller, Network, and Video Drivers.
6) ITEM INSTALLATION DETAILS: Click the appropriate link found beneath Controller Drivers.
7) At the next window, scroll down and select “Extract” to extract the files. Click “Continue” at the pop-up window.
8) Within the Unzip the files field, type C:\Dell\Drivers\Controller and click “OK.” Click “Yes” at the pop-up, then “OK.”
9) From the installation window, click through all necessary messages in order to install the controller drivers.
10) Once the installation is complete, click “Finish” with “Yes, I want to restart my computer now” bulleted.
11) Once Windows is up, from the Start Menu, select All Programs -> Dell Accessories -> and click “Dell Resource CD.”
12) From the Resource CD Selection window list, click the appropriate link found beneath Network Drivers.
13) At the next window, scroll down and select “Extract” to extract the files. Click “Continue” at the pop-up window.
14) Within the Unzip the files field, type C:\Dell\Drivers\NIC and click “OK.” Click “Yes” at the pop-up, then “OK.”
15) From the installation window, click through all necessary messages in order to install the network drivers.
16) Click “Finish.” Scroll up and click “Return” to return to the Resource CD Selection window list.
17) From the Resource CD Selection window list, click the appropriate link found beneath Video Drivers.
18) At the next window, scroll down and select “Extract” to extract the files. Click “Continue” at the pop-up window.
19) Within the Unzip the files field, type C:\Dell\Drivers\Video and click “OK.” Click “Yes” at the pop-up, then “OK.”
20) From the installation window, click through all necessary messages in order to install the video drivers.
21) Once the installation is complete, click “Finish” with “No, I will restart later” bulleted. Close the Resource CD window.
22) Remove the Dell Resource CD. Next, From the Start Menu, select “Control Panel.” Click “Add or Remove Programs.”
23) From the Add or Remove Programs window, select Dell Resource CD and click “Remove” and then “Yes” to uninstall it.
24) Click the upper right-hand [X] to close the Add or Remove Programs window and the Control Panel.
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5. Downloading and Installing Windows XP Updates
1) From the Start Menu, click “Turn Off Computer” and then “Turn Off.” If the system is not currently hooked up
at the IT bench area, move it there and hook it up. Be sure to connect the COMCAST cable into the network jack.
2) Turn on the system’s power. Once Windows is up, from the Start Menu, click “All Programs” then “Windows Update.”
3) From the Windows Update website, click through all preliminary pop-up messages.
4) Click “Custom” at the Keep Your Computer Up to Date screen. The website will scan the system for necessary updates.
NOTE: The following steps may differ from the notes slightly, as Microsoft occasionally alters their Updates webpages.
5) Click “Yes” at the pop-up, then “Download and Install Now” in order to download Windows Update Installer software.
Once the installation is complete, click “Restart Now.”
6) Once Windows is back up, click “Owner.” From the Start Menu, click “All Programs” then “Windows Update.”
7) Click “Custom” at the Keep Your Computer Up to Date screen. The site will again scan the system for necessary updates.
8) Once the list of updates appears, from each left-hand menu, select the checkbox/bullet for all files that need installed.
9) After compiling all necessary files, click the “Review and install updates” link and then “Install Updates.”
10) From the installation pop-up, click “I Accept” (and/or “Next”) in order to download and install the update files.
11) Once update installation is complete, click “Restart Now.”
12) Repeat steps 6 – 11, until all necessary Windows XP updates have been installed.
13) Once the system is COMPLETELY UPDATED, from the Start Menu, select “Control Panel.” Click “Switch to Classic
View”, then double-click “Automatic Updates.” From the Automatic Updates window, select the “Download updates,
but let me choose when to install them” bullet and click “OK.” Click the upper right-hand [X] to close the Control Panel.
14) From the Start Menu, click “Turn Off Computer” and then “Turn Off.” Remove the COMCAST cable from the
network jack and replace it with a regular ACE network cable. Turn on the system’s power.

6. Configuring Windows Network Settings
1)
2)
3)
4)
5)
6)

7)
8)
9)

Once Windows is back up, click “Owner.” From the Start Menu, right-click on “My Computer” and select “Properties.”
From the Computer Name tab of the System Properties window, click “Network ID.”
At the Network Identification window, click “Next” and “Next” again with “This computer is part of a business” bulleted.
Click “Next” with “My company uses a network with a domain“ bulleted, and then click “Next” again.
From the User Account and Domain Information window, type administrator in the User name field, the
NETWORK Administrator Password in the Password field, ACE in the Domain field, then click “Next” and “Yes.”
(This step may be unnecessary) Type ACE* (where * is the system #) in the Computer name field, ACE in the Computer
domain field, and click “Next.” From the Domain User Name and Password window, type the user’s username in the
User name field, the user’s password in the Password field, and ACE in the Domain field, and then click “OK.”
Once more, type the user’s username in the User name field and ACE in the User domain field, and click “Next.”
Click the “Other” bullet. Verify that the drop down menu is set to “Administrators” and then click “Next.”
Click “Finish” and then “OK.” Click “OK” at the System Properties window, and then “Yes” in order to reboot.
Once Windows is back up, press [CTRL] + [ALT] + [DELETE] and login to the network as the DESIGNATED USER.

7. Activating Windows XP
(Complete this step ONLY if Windows does not get activated automatically.)
1) From the right-hand section of the toolbar, double-click on the keys icon to launch Windows Product Activation.
2) From the Windows Activation website, click through all messages to activate Windows XP. Close Internet Explorer.

8. Customizing Windows XP
Customizing Windows Explorer
1)
2)
3)
4)

From Windows Explorer, right-click somewhere in the right-hand window and select “View -> Details.”
From the upper menu of Explorer, select “Tools” and then click “Folder Options …”
From the General tab of the Folder Options window, select the “Use Windows classic folders” bullet and click “Apply.”
From the View tab, uncheck the following checkboxes/bullets:
- “Automatically search for network folders and printers”, “Hide extensions for known file types”, “Hide protected
operating system files” (and answer “Yes” at the pop-up), “Remember each folder’s view settings”, and
“Use simple file sharing (Recommended).”
5) Next, click the following checkboxes/bullets:
- “Show hidden files and folders”, “Display the contents of system folders”, and “Show Control Panel in
My Computer.” Click “Apply.” Next, click the “Apply to All Folders” button and answer “Yes” at the pop-up.
6) From the Registered file types list of the File Types tab, scroll down and select VBE, then click “Delete” and answer
“Yes” at the pop-up. Repeat this step, this time selecting VBS.
7) From the Offline Files tab, uncheck “Enable Offline Files.” Click “Apply” and then “OK.” Close Windows Explorer.

Customizing the Recycle Bin
1) From the desktop, right-click on the “Recycle Bin” icon and select “Properties.”
2) Uncheck “Display delete confirmation dialog.” Click “Apply” and then “OK.”
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Customizing Control Panel Items
1)
2)
3)
4)
5)
6)
7)
8)

From the Start Menu, click to open “Control Panel.”
From the lefthand menu of the Control Panel, click “Switch to Classic View.” (This step may be unnecessary.)
Double-click to open “Windows Firewall.” From the Exceptions tab, check “File and Printer Sharing”, then click “OK.”
Next, double-click to open “User Accounts.” Next, (if necessary) click “Change the way users log on or off.”
From the User Accounts window, uncheck “Use Fast User Switching” (if necessary) and “Use the Welcome screen.”
Click “Apply Options” and then close the User Accounts window. Again, double-click to open “User Accounts.”
From the Users list, select “owner” and click “Remove.” Answer “Yes” at the pop-up. Repeat this step for “ASP.Net.”
From the Advanced tab, uncheck “Require users to press Ctrl+Alt+Delete.”
Click “Apply” then “OK” to close the User Accounts window, then click the upper right-hand [X] to close Control Panel.

Customizing Desktop and Display Properties
1) From the upper menu of Windows Explorer, select “Tools” and then click “Map Network Drive …”
Type \\server1\files in the Folder field of the Map Drive window and click “Finish” with “Reconnect at logon” checked.
2) From the pop-up Explorer window, double-click to open “ACE desktop.” Right-click and copy “Ace800x600.bmp”
and “ace.scr.” Browse to C:\Windows. Right-click somewhere and select “Paste.”
3) Next, from C:\Windows, click to sort by “Type” and delete all non-hidden .bmp files EXCEPT for “Ace800x600.bmp.”
Click to re-sort by “Name”, then browse to C:\Windows\Web. Select and delete the “Wallpaper” folder.
Next, browse to C:\Documents and Settings\user\My Documents\. Delete “My Pictures” and “My Music.”
NOTE: While Windows 2000 will allow .scr files to be deleted, Windows XP will NOT (they will be recreated).
4) Close both copies of Windows Explorer, then from the desktop, right-click somewhere and select “Properties.”
5) From the Theme drop down menu of the Themes tab, select “Windows Classic” and click “Apply.” The system will
revert to classic display mode.
6) From the Desktop tab, select “Ace800x600” and then click “Apply.” Next, click “Customize Desktop …”
7) From the Desktop Items window, check the following checkboxes (to cause them to appear on the desktop):
- “My Documents”, “My Computer”, “My Network Places”, and “Internet Explorer.”
8) Uncheck “Run Desktop Cleanup Wizard every 60 days” and click “OK.”
9) From the Screen saver drop down of the Screensaver tab, select “ace.” In the Wait field, type 15 and then click “Apply.”
10) Next, click “Power …” From the Power Schemes tab, set the drop down menus as follows:
- Turn off monitor: “After 2 hours”, Turn off hard disks: “Never”, System Standby: “Never.”
11) From the Advanced tab of the Power Options, uncheck “Prompt for password when computer resumes from standby.”
12) From the Hibernate tab of the Power Options, check “Enable hibernation.” Click “Apply” and then “OK.”
NOTE: There are additional power option considerations when dealing with a laptop computer…
- From the Alarms tab, under Critical battery alarm, click “Alarm Action …”
From the Alarm Actions window, change the “When the alarm goes…” drop down to “Hibernate.” Click “OK.”
Also, from the Advanced tab, change the “When I close the lid of my computer” drop down to “Hibernate”
And the “When I press the sleep button on my computer” to “Do Nothing.”
Also, from the Power Schemes tab, select options for all Running on Batteries options. Click “Apply” then “OK.”
13) From the Appearance tab, click “Effects …” Uncheck “Use the following transition effect for menus…” Click “OK.”
14) Click “Advanced.” From the Advanced Appearance window, with the Item drop down set to “Desktop”, change Color 1
to dark blue. Next, change the Item drop down to “Selected Items” and change Color 1 to dark purple. Click “OK.”
15) From the Settings tab, verify the screen resolution is running at 800 x 600 pixels and the highest color quality
(usually 32-bit, but this depends on the video card.) If not, change to these settings and click “Apply.”
Answer “Yes” at the pop-up message and then click “OK.”

Customizing the Windows Toolbar
1) Right-click on the Windows toolbar and select “Properties.”
2) Click on the Start Menu tab, then click the “Classic Start menu” bullet and then “Customize …” From the pop-up
window, check “Display Log Off.” Uncheck “Use Personalized Menus” and click “OK.”
3) From the Taskbar tab, check “Show Quick Launch.” Uncheck “Hide inactive icons.” Click “Apply” and then “OK.”

Customizing System Properties
1) From the desktop, right-click on “My Computer” and select “Properties.”
2) From the Startup and Recovery section of the Advanced tab, click “Settings.”
Uncheck “Time to display list of operating systems” and “Time to display recovery options when needed.” Click “OK.”
3) From the User Profiles section of the Advanced tab, click “Settings.” From the profiles list, select “owner”
(or “account unknown”) and click “Delete” to remove the temp local account created earlier. Click “Yes” and then “OK.”
4) From the Hardware tab, click the “Device Manager.” For each Device Manager item listed under Network adapters:
- Right-click on the network adapter and select “Properties.” Click on the Power Management tab (if present).
- Uncheck “Allow the computer to turn off this device to save power” and then click “OK.”
5) Click the upper right-hand [X] to close the Device Manager and then click “OK” to close the System Properties window.

7

Customizing a System as an ACE Workstation – Beginning Steps
NOTE: The Windows directory on the C:\ drive is named “WINNT” on Windows 2000 installs vs. “Windows” on XP installs.

1. Changing Internet Explorer Settings
1) From the desktop, double-click to open “Internet Explorer.”
2) (The following step is ONLY necessary for Windows 2000.) From Internet Explorer, click “Connect me to the Internet.”
At the Internet Connection Wizard window, select the “Connect through a LAN“ bullet and click “Next.”
Select the “Connect through a LAN” bullet again and click “Next”, then uncheck all options and click “Next.”
Click the “No” (mail account) bullet and click “Next.” Click “Finish” to connect to the internet.
3) From the upper menu of Internet Explorer, click “View -> Toolbars -> Links” to hide the Links toolbar.
4) From the upper menu of Internet Explorer, select “Tools” and then click “Internet Options …”
5) From the General tab, type www.ace-it.com to set it as the default home page.
6) Click “Settings …” From the Settings window, reduce the Amount of disk space to 50 MB. Click “OK.”
7) Change the “Days to keep pages in history” to 5. Click “Apply” then “OK”, and then close Internet Explorer.

2. Setting the Cleanup Batch Program to Delete Temp Files
1) From Explorer, browse to F:\Batch. Right-click and copy “cleanup.bat” and “DELTREE.exe.”
Browse to C:\Windows. Right-click somewhere in the browser window and select “Paste.”
2) Next, right-click on the “cleanup.bat” and select “Edit.”
3) From the cleanup.bat, if the OS is 2000, change the one existing line of code from cd\windows\temp to cd\winnt\temp.
Next, add the following text (after the last line of current text):
cd\docume~1\*user\locals~1\temp
deltree /Y *.*
4) Click the upper right-hand [X] to close cleanup.bat and then click “Yes” to save changes.
5) Open another copy of Explorer and go to C:\Documents and Settings\All Users\Start Menu\Programs\Startup.
6) From the first copy of Explorer, go to F:\Data\Shortcuts. Right-click on “Shortcut to cleanup” and select “Copy.”
Browse to the other Explorer window (showing Startup directory), and then right-click somewhere and select “Paste.”
7) From Explorer, go to C:\Windows\Temp. Right-click and select “New -> etc…” twice to create a junk file and folder.
8) From the other copy of Explorer, go to C:\Documents and Settings\*User \Local Settings\Temp. Again, create junk files.
9) From the Start menu, go to Programs -> Startup -> Shortcut to cleanup. The cleanup.bat program will run.
10) After the cleanup batch file runs, return to Explorer.
11) Verify that all created files have been deleted from the Temp folders of both Explorer windows. Close both windows.

3. Changing the System TCP/IP Address to a Static IP
(NOTE: This step is necessary for only a few select machines, such as the Conversion PC, both Consultant PCs,
Email Client and Email Servers, and the four Faxservers.)
1) From the Start Menu, select “Programs –> Accessories” and then click to open “Command Prompt.”
2) From the Command Prompt, type ipconfig /all and press [ENTER]. A list of Ethernet settings will be displayed.
3) Write down on a sheet of paper the 12-digit Physical Address.
4) From an IT workstation, go to the Start Menu, then select “Programs -> Accessories -> Communications” and click
“Remote Desktop Connection.” From the pop-up window, click “Connect” with server1 in the Computer field to
connect to the ACE server. Type the NETWORK administrator password in the Password field and click “OK.”
5) From the desktop, double-click to open “Administrative Tools.” From the Tools window, double-click to open “DHCP.”
6) From the left menu of the DHCP window, click [+] to expand “Scope.” From the expanded list, click “Reservations.”
7) Next, click the “Reservations” button to sort the reservations in order. Looking at the last 3 digits of the reservations
listed, determine an available reservation number within the scope.
8) From the upper toolbar, click on the button which resembles a yellow star. This is the “Add Reservations” button.
9) From the New Reservation window, type the user in the Reservation name field, the last 3 digits of the IP address
to be reserved in the TCP-IP Address field, and the 12-digit Address (written down earlier) in the MAC address field.
10) Click “Add” and then “Close” in order to close the New Reservation window.
11) Return to the new workstation. From the Command Prompt, type ipconfig /release and press [ENTER].
Wait for the TCP/IP address to be released, then type ipconfig /renew and press [ENTER] to establish the new address.
Verify the IP Address listed reflects the one added at the server. Type exit and [ENTER] to close the Command Prompt.
12) Return to the IT workstation. Click the upper right-hand [X] to close the DHCP and Administrative Tools windows.
13) From the Start Menu, click “Log Off administrator.” Answer “Yes” at the pop-up window to log off the server.
Click “Close” to close the Remote Desktop Connection window. Once again, return to the new workstation.
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4. Setting up Administrator-Level Rights for ALL System Users
1)
2)
3)
4)
5)

From the desktop, right-click on “My Computer” and then click “Manage.”
Click the [+] beside “Local Users and Groups” to expand. Next, click “Groups” to open its contents on the right.
From the right-hand window list, right-click on “Administrators” and select “Properties.” Next, click “Add …”
From the Select Users window, in the Enter the object names field, type Domain Users and click “OK.”
Next, click “Apply” and then “Close” and click the upper-right-hand [X] to close Computer Management.

5. Creating Custom Windows Registry Settings
1) From Explorer, go to C:\Windows and double-click to open “Regedit.exe.”
NOTE: Step #2 is ONLY NECESSARY for XP workstations.
2) From the left-hand menu in Registry Editor, browse to HKEY_CURRENT_USER\SOFTWARE\Microsoft\Windows\
\CurrentVersion\Explorer and click on “Advanced.” From the right-hand menu, right-click somewhere and select
“New -> DWORD Value.” For the new value, type EnableBalloonTips.
NOTE: Step #3 is ONLY NECESSARY for Auditor and IT workstations.
3) From the lefthand menu, browse to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion
and click on “Ports.” From the righthand menu, right-click somewhere and select “New -> String Value.”
For the new value, type C:\Print\estimate.prn.
4) Click the upper right-hand [X] to close the Registry Editor.

6. Removing Unwanted Windows Components
1) From Explorer, browse to “C:\Windows\Inf” and double-click to open “Sysoc.inf.”
2) For each item listed in the second section of the .inf file (beginning with Games), select HIDE, then press
[CTRL] + [X] to cut the text. From the upper menu of sysoc.inf, Select “File” and then click “Save.”
3) From the Start Menu, select “Settings -> Control Panel.” From Control Panel, double-click “Add or Remove Programs.”
4) From the left-hand menu, click on the “Add/Remove Windows Components” button.
5) From the pop-up Add/Remove Programs window, uncheck the following listed Windows components:
- “MSN Explorer”, “Outlook Express” (if the user does NOT get email), “Media Player”, “Windows Messenger.”
NOTE: Listed components vary between Windows 2000 and Windows XP operating systems.
6) Next, double-click “Accessories and Utilities.” Uncheck “Communications”, “Games”, and “Multimedia.”
7) Next, double-click on “Accessories” Uncheck “Desktop Wallpaper”, “Mouse Pointers”, and “Paint.”
Click “OK” twice, and then “Next” and “Finish” in order to remove all unchecked components.
8) Click the upper right-hand [X] to close the Add/Remove Programs window and the Control Panel.
9) Return to the Sysoc.inf file. Retype all removed instances of HIDE to re-hide components.
Click the upper right-hand [X] to close Sysoc.inf and answer “Yes” at the pop-up.

7. Installing Daylight Savings Updates
(Complete the following steps so the workstation will adjust to the correct time on the second Saturday of Mar. and/or Nov.)
1) From Explorer, browse to Server1’s files directory (usually mapped to the G: drive) and double-click to open the
“Daylight Savings Time” folder. Next, double-click to run “DaylightSavingFix.exe.”
2) From the IntelliAdmin Utilities window, click “Apply” in order to install updates on the workstation.
3) Once the pop-up message appears indicating that the time has been updated, click “Cancel.”
4) Click the upper right-hand [X] to close Explorer.
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Customizing a System as an ACE Workstation – Ending Steps
NOTE: The Windows directory on the C:\ drive is named “WINNT” on Windows 2000 installs vs. “Windows” on XP installs.

1. Updating System and BIOS Settings
1) From the Start Menu, click “Shut Down …” and click “OK” with “Shutdown” selected.
(If a CD-ROM was manually connected to the system, detach it and then close up the computer.) Restart the system.
2) Upon system reboot, press [DELETE] or [F2] (if the system is a Dell) in order to access the BIOS Setup window.
3) From the BIOS Setup, set the following:
- Select the Primary Slave, the Secondary Master, and the Secondary Slave each and set them to “None.”
(Unless the user is to have a CD-ROM, in which case its corresponding drive would remain set to “Auto.”)
- Select Drive A: (the floppy drive), and set it to “None” or “Not Installed.” (Unless the user is to have the A:\.)
- Select the Boot Sequence. Set it to “A, C, CDROM” or “A, C, SCSI.” Set the Boot up Numlock Status to “On.”
- Select the System/Admin Password. Be sure [CAPS LOCK] is off, then type the password and press [ENTER].
Retype to confirm the password and press [ENTER]. Click “OK” at the “Supervisor Password Installed” pop-up.
(NOTE: BIOS settings vary, depending upon the system. Therefore, not all of the following options may be present.)
- Select ACPI and then Power Management and set each to “Disable” or “Off.”
- Select PM Control by APM and set it to “No.”
- Select PNP OS Installed and set it to “Yes.”
- Select Resources Controlled by and set it to “Auto.”
4) Press [ESC] and then select to save the changes and exit the BIOS. Once the system has started up, login as the user.

2. System Cleanup
(NOTE: The following steps will vary slightly, depending upon whether the system OS is Windows 2000 or XP.)
1) From Explorer, browse to C:\Documents and Settings. Open (at least) two more Explorer windows and browse to the
same location. From each browser window, browse to a different (non-hidden) profile (Ex: one Explorer will be opened
to C:\Documents and Settings\All Users, another to C:\Documents and Settings\Administrator, etc.).
Next, for each open Explorer window (besides the All Users profile window), do the following:
- Double-click to open the “Desktop” folder. Right-click on any items found and then select “Cut.”
Go to the C:\Documents and Settings\All Users Explorer window. Browse to the “Desktop” folder, right-click
somewhere and select “Paste.” Next, select and delete “Connect to the Internet.”
- Browse to C:\Documents and Settings\(profile)\Start Menu. Right-click any items found - EXCEPT the
“Programs” folder and “desktop.ini” (such .ini files only appear on XP installs) - and then select “Cut.” Go to the
C:\Documents and Settings\All Users Explorer window. Browse to the Start Menu, right-click somewhere and
“Paste.” Next, delete all items except the “Programs” folder, “desktop.ini” and “Microsoft (or Windows) Update.”
- Double-click to open the “Programs” folder. Right-click on any items found - EXCEPT the “Accessories” and
“Administrative Tools” and “Startup” folders, and the “desktop.ini” - and then select “Cut.” Go to the
C:\Documents and Settings\All Users\Start Menu\Programs window. Right-click somewhere and select “Paste.”
Next, delete all of the following items (some may not appear):
- “Games” folder (except in rare cases, when a user is to have games), “Project1” folder, “Clerical”,
“Windows Media Connect”, and “Windows Movie Maker.”
After deleting these items, answer “Yes to All” at the pop-up.
- Double-click to open the “Startup” folder. Right-click on any items found and then select “Cut.”
Go to the C:\Documents and Settings\All Users\Start Menu\Programs\Startup window.
Right-click somewhere and select “Paste.” From the All Users “Startup” folder, delete all items EXCEPT
“Shortcut to cleanup”, “Shortcut to Sweeper” (only listed on auditor systems), and “Enterprise Workflow –
ST Compliance” (only listed on CSAA auditor systems). Return all other Explorer windows up one level.
- Double-click to open the “Accessories” folder. Right-click on any items found - EXCEPT the “Accessibility” and
“System Tools” folders, and the “desktop.ini” - and then select “Cut.” Go to the
C:\Documents and Settings\All Users\Start Menu\Programs\Accessories window. Right-click somewhere and
select “Paste.” Next, from the All Users window, delete all of the following items (some may not appear):
- “Communications” folder, “Entertainment” folder, “Address Book”, and “Paint.”
After deleting these items, answer “Yes to All” at the pop-up.
- Double-click to open the “Accessibility” folder. Right-click on any items found - EXCEPT the “desktop.ini” and select “Cut.” Go to the C:\Documents and Settings\All Users\Start Menu\Programs\Accessories\
Accessibility window. Right-click somewhere and select “Paste.”
- Browse up one level, then double-click to open the “System Tools” folder. Right-click on any items found EXCEPT the “desktop.ini” - and select “Cut.” Go to the C:\Documents and Settings\All Users\Start Menu\
Programs\Accessories\System Tools window. Right-click somewhere and “Paste.” Close this Explorer window.
- Return all other Explorer windows up two levels and delete “Accessories” and answer “Yes to All” at the pop-up.
Close all but one of the Explorer windows.
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2) From the desktop, rearrange the desktop icons in the following order (starting with the upper left corner):
- My Documents, My Computer, My Network Places, Recycle Bin, Internet Explorer,
Microsoft Outlook (or Express), Backup Ultramate Estimates, ACEViewer, Shortcut to clerical, UltraMate,
Approval, Client Profiles, Car Parts Sites, Office Application, ACE Auto Management, followed by
Microsoft office products and then other items in any order. (NOTE: Icons that appear on the desktop will vary.)
Right-click on the desktop and select “Line up Icons” to align the icons. (This step is only necessary for Windows 2000.)
3) If the user is not to have internet access:
- For Windows 2000: From the desktop, right-click on “Internet Explorer” and select “Properties.” From the
Advanced tab, scroll down and uncheck “Show Internet Explorer on the desktop.” Click “Apply” and then “OK.”
- For Windows XP: From the desktop, right-click somewhere and select “Properties.” From the Desktop tab, click
“Customize Desktop …” From the Desktop Items window, uncheck “Internet Explorer.” Click “OK” twice.
- For both Windows 2000 and XP: From the lower-left portion of the desktop toolbar, right-click on the
“Internet Explorer” icon and click “Delete.” Answer “Yes” to the pop-up message.
4) If the user is not to have email:
- From the desktop, click to highlight the user’s email program and then press [SHIFT] + [DELETE] to remove it.
- From the lower-left of the toolbar, right-click on the “Outlook Express” icon, click “Delete”, and then “Yes.”
5) If Microsoft 97 was installed on the system, from the desktop, right-click on the top blue bar of the right-hand Office
toolbar and “Exit.” Answer “No” at the pop-up message to remove the toolbar.
6) From Explorer, go to C:\Program Files. Delete the “Clerical” folder. Click “Yes” and “Yes to All” at the pop-ups.
Repeat this step, selecting the “Project1” folder (only displayed if Approval was installed on the system).
7) Next, right-click on the “ACE” folder and select “Properties.” From the permissions list within the Security tab, select
“Users” and then check to allow “Full Control.” Click “Apply” and “OK” to accept settings changes.
8) If necessary, from the left-hand menu of Explorer, right-click on the “files on server1” folder and click “Disconnect.”
9) From the upper menu of Explorer, select “Tools” and then click “Folder Options …”
10) From the View tab, click the “Do not show hidden files and folders” bullet and check the “Hide protected
operating system files” checkbox. Click “Apply” and “OK” and then click the upper right-hand [X] to close Explorer.
11) From the Start Menu, select “Programs.” At the Programs -> list, point the mouse to an empty space, right-click and
then click “Sort by Name.” Point the mouse away from the Programs list to exit the Start Menu.
12) Right-click on the toolbar (bottom) and select “Properties.” To remove all items from the “Documents” folder:
- For Windows 2000 systems, from the Advanced tab of Taskbar Properties, click “Clear.”
Click “OK” to close the Taskbar and Start Menu Properties window.
- For Windows XP systems, from the Start Menu tab, click “Customize …” From the pop-up, click “Clear.”
Click “OK” and then “OK” again to close the Taskbar and Start Menu Properties window.
13) From the desktop, right-click on the Recycle Bin, select “Empty Recycle Bin”, and answer “Yes” to the pop-up message.

3. Customizing Windows Profiles
(NOTE: The following steps will vary slightly, depending upon whether the system OS is Windows 2000 or XP.)
1) To set the user profile as the default:
- For Windows 2000 systems, from the desktop, right-click on “My Computer” and select “Properties.”
From the User Profiles tab, click to select the profile “ACE\the user” and then click “Copy To …”
From the Copy To window, click “Browse …” Go to C:\Documents and Settings and click “OK.”
In the Copy to field, after “C:\Documents and Settings”, type \Default User.
Click “OK” to set the user profile the default for new users, click “Yes” at the pop-up, and then click “OK” again.
- For Windows XP systems, from the Start Menu, select “Shut Down ...” Click “OK” with “Shut down” selected.
Restart the system and log in as (the local) Administrator, selecting the local computer (vs. ACE). Click “OK.”
Next, after the system has logged in, from the desktop, right-click on “My Computer” and select “Properties.”
From the User Profile section of the Advanced tab, click on the “Settings” button.
From the Profiles list of the User Profiles window, select the profile “ACE\the user” and then click “Copy To …”
From the Copy To window, click “Browse …” Go to C:\Documents and Settings and click “OK.”
In the Copy to field, after “C:\Documents and Settings”, type \Default User.
Click “OK” to set the user profile the default for new users, click “Yes” at the pop-up, and then click “OK” again.
For Windows XP systems, from the Start Menu, select “Log off (user).” Answer “Yes” to any pop-ups.
Log in to the system as the user, and select the ACE network and click “OK.”
2) To allow any user who logs into the system to receive administrator-level rights by default:
- From the desktop, right-click on “My Computer” and then click “Manage.”
- Click the [+] beside “Local Users and Groups” to expand. Next, click “Groups” to open its contents on the right.
- From the right-hand window list, right-click on “Administrators” and select “Properties.” Next, click “Add …”
- From the Select Users window, in the Enter the object names field, type Domain Users and click “OK.”
- Next, click “Apply” and then “Close” and click the upper-right-hand [X] to close Computer Management.
3) Cross over all items to the system, referencing the ACE user deployment procedures and then shutdown the system.
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Setting up an ACE Auditor Workstation
1. Installing a Windows Operating System
1) See either the Installing Windows 2000 or Windows XP on a Workstation procedure.

2. Preliminary Customization on the Workstation
1) See the Customizing a System as an ACE Workstation - Beginning Steps procedure.

3. Installing and Testing Clerical, ACEViewer, and Sweeper
1) See steps in the Installing and Testing ACE Custom Software procedure.

4. Setting up the Workstation in the Environment Variables
1)
2)
3)
4)

From the desktop, right-click on “My Computer” and select “Properties.”
From the Advanced tab, click on “Environment Variables.” From the System Variables menu, click “New.”
Type Machine in the Variable name field and * (where * is the machine’s designated #) in the Variable value field.
Click “OK”, and then “OK” two more times in order to close the My Computer Properties window.

5. Installing UltraMate 7
1)
2)
3)
4)
5)
6)

From the Start menu, select “Run …” then type M:\SETUP.EXE and click “OK.”
If necessary, at the pop-up message displaying a list of software prerequisites, click “Install” to install them.
Click “Next” at the Welcome to the Installation Wizard for Ultramate window.
Click the “I accept” bullet at the License Agreement window and then click “Next.”
Click “Next” with “Single User” bulleted to install UltraMate in single user mode.
At the Company Information window, type AMERICAN COMPUTER ESTIMATING in the Company Name field.
Verify that Independent Adjuster, Claim Number (or File Number, depending upon the Auditor), and USA are
the selected bullets and click “Next.”
NOTE: To determine whether setup should be by Claim or File Number, go to the Auditor’s CURRENT workstation and:
- From the upper menu of Mitchell UltraMate, click the yellow folder icon, then double-click to open a specific file.
- Click on the Admin tab, and then the General tab. If the Claim Number field is grayed out, the setup is by Claim.
If the File Number field is grayed out, the setup is by File.
7) With C: set as the destination drive, click “Next.”
8) Click “Install” at the following window to begin the installation.
9) At the N.A.D.A. Book window, from the Default N.A.D.A. Book drop-down menu, select “Eastern” and click “Done.”
10) At the UltraMate Setup Complete window, press [CTRL] + [ALT] + [DELETE] instead of clicking “Finish.”
From the pop-up window, click “Task Manager” and then, from the Applications tab of the Task Manager window,
select “UltraMate 7.0…” and click “End Task” to avoid accidentally installing the Mitchell Communications program.
NOTE: If the Mitchell Communications program was accidentally installed, do the following:
- From Windows Explorer, browse to C:\Documents and Settings\All Users\ Start Menu\Programs\Startup
and then select and [DELETE] “Mitchell Communications Alert Checker.”
- Click on the Start menu button and then select “Run ...” From the Run window, type msconfig and click “OK.”
From the Startup tab of the System Configuration Utility, uncheck “McDm” and click “OK.” Click the “Restart”
Button in response to the prompt.
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6. Changing UltraMate 7 Properties
1) From the desktop, double-click to open “UltraMate.” In the User ID and Password fields, type Mitchell and click “OK.”
2) From UltraMate’s menu bar, click “System Info” and select “Configuration -> Configure User Information …”
3) From the User Manager window, click “New.” From the User Detail window:
- Type ACE in the User ID and Last Name fields. Leave the First Name field blank.
- Select “Administrator” for the Authorization Group and “Audit” for the Classification.
- In the Password and Verify Password fields, type ACE (in CAPS). Click “OK” to continue.
- Click “Close” to close the User Manager window.
4) From the menu bar, click “System Info” and select “Configuration -> Configure System Information …”
5) From the Value Added Options tab, check the “EMS” checkbox and click “OK.”
6) From the menu bar, click “System Info” and select “Preferences …”
7) From the Estimate Reports tab, check the “Text Print Image*” checkbox located under “Print with.”
8) From the Miscellaneous tab, type M: in the Primary Location field and M: in the Secondary Location, then click “OK.”
9) From the upper menu of UltraMate, select “File -> Logoff.” From the pop-up login window, login with ACE as both
the User ID and Password. Double-click the UltraMate banner (blue bar) to open the program to full screen size.
11) From the File Selection window, under the Estimates tab, click the “Estimate Id” tab to sort files by estimate number.
12) (Complete this step once files are crossed into UltraMate) Next, double-click on a COMMITTED estimate to open it.
From the upper menu of the estimate window, select “View” and then click to select “Classic View.” Close the estimate.
13) Click the upper right-hand [X] in order to close UltraMate.
14) From the Start Menu, click “Shut Down …” and click “OK” with “Shutdown” selected. Wait for the system to shut off.
15) Once the system is off, press the power button in order to reboot. Once the system has started up, login as the auditor.

7. Verifying that Sweeper is Functioning
1) Press [CTRL] + [ALT] + [DELETE]. From the Windows Security window, click “Task Manager.”
2) Verify that Sweeper appears in the Applications list. Click the upper right-hand [X] to close the Windows Task Manager.

8. UltraMate Printer Setup
1) See step 3 in the Setting up a Local or Network Printer procedure, Setting up a Specific Local Printer for UltraMate.

9. Creating a Backup for UltraMate
1) From Explorer, go to F:\Data\Ultrmate. Right-click and select “New -> Folder.” Name the folder the workstation #.
NOTE: If the # already exists, rename it OLD # (where # equals the workstation #), then create and name the new folder.
2) From a second copy of Explorer, go to F:\Batch and double-click to open “setback.bat.” From the pop-up window, press
any key to run setback.bat. After the file runs, the DOS-Prompt window will close. Close the second copy of Explorer.
3) Browse to F:\Data\Ultrmate\* (where * is the workstation #) and verify that a folder named “Archive” is present.
4) From the desktop, right-click on the newly created “Backup Ultramate Estimates” icon and select “Properties.”
5) From the Program tab, click “Change Icon …” and click “OK” at the pop-up message. Browse to C:\Windows\system32,
select “pifmgr.dll”, and click “Open.” Click “OK” twice in order to accept the current icon as the default.
6) Next, from the desktop, double-click “Backup Ultramate Estimates” to test run the backup program.
7) Go to Explorer and verify that 2 more files (useraux.zip and userdata.zip) are present in F:\Data\Ultrmate.
8) Browse to in C:\Backup and verify that the same 2 files are present.
9) Return to the desktop, right-click on “Backup Ultramate Estimates”, and then select “Copy.”
10) From Explorer, browse to C:\Documents and Settings\All Users\Start Menu\Programs\Startup. Right-click and “Paste.”

10. Creating Access to Client Profiles
1)
2)
3)
4)

From Explorer, browse to F:\Data\Shortcuts.
Right-click on “Company Guidelines” and select “Copy.”
Browse to C:\Documents and Settings\All Users\Desktop. Right-click somewhere on the desktop and select “Paste.”
Double-click to open Company Guidelines and verify that the company guidelines client list web page opens properly.

NOTE: Some of the following steps will not need to be done, depending on the user (check the auditor’s CURRENT system).

11. Installing Acrobat (Reader or Full Version) and WinZip
1) See steps in the Installing and Testing Acrobat Reader, WinZip, and eFax procedure.

12. Installing and Testing Excel and/or Word Viewer
1) See steps in the Installing and Testing Excel and Word Viewers procedure.

13. Installing and Customizing the Audatex Website
1) See the Installing and Customizing the Audatex Website Utilities procedure.

2

14. For Subro and Property Auditors: Installing and Testing Specialty and/or Property Reports
1) See steps in the Installing and Testing the Specialty and Property Reports Programs procedure.

15. For Property Auditors: Installing and Testing MSB IntegriClaim
1) See the Installing and Testing MSB IntegriClaim procedure.

16. For Audatex PenPro Auditors: Installing and Customizing Audatex PenPro
1) See the Installing and Customizing Audatex PenPro procedure.

17. For Audatex PenPro Auditors: Creating a Backup for PenPro
1) From Explorer, browse to F:\Data\Penpro. Right-click and select “New -> Folder.” Name the folder the workstation #.
NOTE: If the # already exists, rename it OLD # (where # equals the workstation #), then create and name the new folder.
2) Click the upper right-hand [X] to close Explorer.
3) From the Start Menu, click “Shut Down …” and click “OK” with “Log off user” selected. Wait for the system log out.
4) After user (PenPro) login, verify that pop-up Command Prompt window indicates that files are being zipped.
5) From Explorer, browse to F:\Data\Penpro\Machine #. Verify that 2 files (ppcomm.zip and userdb.zip) are present.
6) Click the upper right-hand [X] to close Explorer.

18. For CSAA Auditors: Additional Setup Procedures for a CSAA Auditor Workstation
1) See the Additional Setup Procedures for a CSAA Auditor Workstation procedure.

19. Setting up and Testing an Email Account
1) See steps in the Setting up and Testing an Email Account procedure.

20. Installing and Customizing NOD32 AntiVirus
1) See the Installing, Updating, and Customizing NOD32 AntiVirus Software procedure.

21. Setting up Shortcuts to Car Parts Websites
1) From Explorer, browse to F:\Data\Shortcuts. Right-click on the “Car Parts Sites” folder and select “Copy.”
2) Browse to C:\Documents and Settings\All Users\Desktop. Right-click somewhere and select “Paste.”
3) Next, browse to C:\Documents and Settings\User\Favorites. Again, right-click somewhere and select “Paste” in order to
paste the shortcuts into the favorites menu of Internet Explorer.
4) Click the upper right-hand [X] to close Explorer.

22. Final Customization on the Workstation
1) See the Customizing a System as an ACE Workstation - Ending Steps procedure.

23. Deploying the Workstation
1) See steps in the Deploying an ACE Workstation procedure.
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Additional Software Setup for an ACE Total Loss Valuation Workstation
(To setup a ValueMate Auditor Workstation, follow the Auditor Workstation Procedure, then follow these Steps. ValueMate is only
necessary for auditors to check old back-dated claim information. The program has been replaced by WorkCenter Total Loss.)

1. Installing Mitchell ValueMate Software
1) Retrieve the latest CD version of Mitchell ValueMate software. Insert the ValueMate CD into the CD-ROM drive.
2) Next, click “Yes” in response to the automatic pop-up database copy from CD-ROM pop-up question.
3) At the Company Information window: In the Name field, type AMERICAN COMPUTER ESTIMATING, in the
Street 1 field, type 1155 PHOENIXVILLE PIKE, in the Street 2 field, type SUITE 109, in the City field, type
WEST CHESTER, select PA from the State arrow menu, and type 19380 in the Zip field, in the Phone 1 field,
type 610-429-5200 and in the Phone 2 field, type 610-429-5205. Click “OK.”
4) From the Valuation Guides window, for each guide EXCEPT Canadian Redbook: From the Value Guide drop-down
menu list, select the next guide to be added. Type in the password that corresponds with the guide and click “Add.”
NOTE: You will need to call Mitchell support at 800.448.4401 to determine the password to be entered for each guide. Relay ACE’s account
#692374 and the Workstation ID (found on the Valuation Guides window) to the support person and make sure they are aware that ACE rightly
has access to ALL guides (except Canadian Redbook), not just the Eastern Region. Demand the support person check ACE’s records to confirm
this if he is not willing to give all guide passwords. If the support person still will not comply, have ACE’s president call to get the passwords.

5) Click “OK” and then “Yes” in response to the “Is info complete?” pop-up window to begin the installation.
6) Close the Readme file and Explorer upon installation completion.
7) From the Mitchell International window, press [CTRL] + right-click on the ValueMate and ValueMate Update icons.
Drag them to the desktop and select “Copy Here.” Close the Mitchell International window.

2. Customizing Mitchell ValueMate
1) From the desktop, double-click to open “ValueMate.” Login to the program using Mitchell for the UserID and Password.
2) From the upper menu of ValueMate, click on “System” and then select “Security.” Click “Add” to add a new user.
3) From the New User window: In the Logon Name: field, type ACE and in the Password: field, type ACE, in the First
Name field, type ACE and in the Last Name field, type ACE, in the Street 1 field, type 1155 PHOENIXVILLE PIKE,
in the Street 2 field, type SUITE 109, in the City field, type WEST CHESTER, select PA from the State arrow menu,
and type 19380 in the Zip field, in the Country field, type USA, in the Accessor ID field, type in the same information
that was used for the Logon Name (usually auditor’s inits), in the Phone 1 field, type 610-429-5200 and in the Phone 2
field, type 610-429-5205. Click “OK.”
4) Repeat step 3, adding following users’ Logon Name, Password, First and Last Name info: Richard, KMC, Kevin, Mike.
5) Close the System Users window, click the upper right-hand [X] to close ValueMate, and eject the ValueMate CD.

3. Installing Mitchell WorkCenter Total Loss Valuation Software
1) Retrieve the latest CD version of Mitchell WorkCenter Total Loss Valuation software.
2) From the Windows toolbar of the auditor workstation, double-click on the NOD32 AntiVirus software eyeball icon in
order to expand the program. From the left-hand menu of NOD32, click “Setup” and then, from the main window, click
the “Antivirus and antispyware protection” link. From the following window, under the Real-time file system protection
heading, click the “Disable” link and then click the upper right-hand [X] to close the program.
3) Insert the Mitchell WorkCenter Total Loss CD in the CD-ROM drive. An installation window will automatically appear.
4) Click “Next” at the Welcome window, then click the “Yes, I disabled anti-virus and firewall software” button and “Next.”
5) Select the “I accept …” bullet at the License Agreement window and click “Next.”
6) Click “Next” twice and then “Install” in order to install the WorkCenter software.
7) Uncheck “Show the readme file” and then click “Finish” to launch the program.
8) Remove the Mitchell WorkCenter Total Loss CD from the CD-ROM drive.
9) From the toolbar, double-click on the NOD32 AntiVirus icon to expand the program. From the main window, under the
Real-time file system protection heading, click the “Enable” link then click the upper right-hand [X] to close the program.

4. Customizing Mitchell WorkCenter Total Loss Valuation Software
1) From the WorkCenter Total Loss Login window, type mitchell in the Password field and click “OK.”
Click “OK” in response to the “No host information found in platform setup” message.
2) At the Platform Setup window, type XX in the Organizational ID field, BSIA in the User ID field, and password in the
Password and Confirm Password fields, and then click “Initialize Host” and answer “OK” at the pop-up message.
3) The Platform Setup window will close automatically. From the upper menu, click “System Setup”, then “User Setup …”
4) Click the “Add New” button at the pop-up User Setup window. Type ACE in the User Name, Password, First Name,
Confirm Password, and Last Name fields and then click “OK.”
5) Click “Close” to close the User Setup window and then click the upper right-hand [X] to close the WorkCenter program.
6) From the desktop, double-click to relaunch “WorkCenter.” From the Login window, type ace in the User Name and
Password fields and click “OK.” Once again, click the upper right-hand [X] to close the WorkCenter program.
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Setting up an ACE Clerical Workstation
1. Installing a Windows Operating System
1) See either the Installing Windows 2000 or Windows XP on a Workstation procedure.

2. Preliminary Customization on the Workstation
1) See the Customizing a System as an ACE Workstation - Beginning Steps procedure.

3. Printer Setup
1) See step in the Setting up a Local or Network Printer procedure.

4. PDF Writer/Printer Setup
1) From Explorer, browse to \\server1\files\Disks\Adobe Acrobat\AcroSoft_CutePDF-PDFwriter and double-click
to run “CuteWriter.exe.” Click “Run” at the pop-up and then “OK” in order to launch the installer.
2) Click “Yes” and “Yes” again at the License window in order to install the writer and “OK” once the installation is done.
3) Click the Upper right-hand [X] to close the pop-up Internet Explorer window, then, from Explorer double-click
to run “converter.” Click “Run” at the pop-up and then “Setup” in order to install the converter.

5. Installing and Testing Clerical, ACEViewer, and Approval
1) See steps in the Installing and Testing ACE Custom Software procedure.

6. Installing Acrobat (Reader or Full Version) and WinZip and eFax Messenger
1) See steps in the Installing and Testing Acrobat Reader, WinZip, and eFax procedure.

7. Installing and Testing Microsoft Office 2000 or ‘03
1) See steps in the Installing and Customizing Microsoft Office procedure.

8. Installing and Testing Specialty and/or Property Reports
NOTE: Specialty must be set up on ALL Clerical Workstations but Property may not need to be set up, depending on the user.
1) See steps in the Installing and Testing the Specialty and Property Reports Programs procedure.

9. Setting up and Testing an Email Account
1) See steps in the Setting up and Testing an Email Account procedure.

10. Installing Java Software
1)
2)
3)
4)
5)
6)

From the desktop, double-click to open “Internet Explorer.” Type www.java.com in the address field and press [ENTER].
Once Java.com’s homepage has loaded, click the “Free Java Download” button.
At the resulting webpage, click “Free Java Download” again, and then, from the pop-up window, click “Run.”
Click “Run” again and then click “Install” at the Java Setup – Welcome window.
Uncheck the “Yes, I want Bing Toolbar” checkbox and then click “Next.”
Click “Close at the Java Setup – Complete window and then click the upper right-hand [X] to close Internet Explorer.

11. Setting up BodyShopNet Photos, Ariba POs, ACE-it.com Signups, Internet Favorites Access, etc.
1) From Windows Explorer, browse to F:\Data\Shortcuts. Right-click on “BSN Photos”, “aceitDOTcomSignups”,
“Ariba_POs”, “Customer Service Favs”, and “Shortcut to Cover Sheets” then select “Copy.”
2) Browse to C:\Documents and Settings\All Users\Desktop, right-click somewhere in the Explorer window, and “Paste.”
3) Browse back to F:\Data\Shortcuts, then right-click on “Customer Service Favs” and select “Copy.”
4) Browse to C:\Documents and Settings\CS\Favorites, right-click somewhere in the Explorer window, and “Paste.”
5) Click the upper right-hand [X] to close Windows Explorer.

12. Installing and Customizing NOD32 AntiVirus
1) See the Installing, Updating, and Customizing NOD32 AntiVirus Software procedure.

13. Final Customization on the Workstation
1) See the Customizing a System as an ACE Workstation - Ending Steps procedure.

14. Deploying the Workstation
1) See steps in the Deploying an ACE Workstation procedure.
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Setting up an ACE Manager Workstation
1. Installing a Windows Operating System
1) See either the Installing Windows 2000 or Windows XP on a Workstation procedure.

2. Preliminary Customization on the Workstation
1) See the Customizing a System as an ACE Workstation - Beginning Steps procedure.

3. Printer Setup
1) See step in the Setting up a Local or Network Printer procedure.
NOTE: Some of the following steps will not need to be done, depending on the user (check the manager’s CURRENT system).

4. Installing and Testing Microsoft Office 97 (Access Only)
1) See steps in the Installing and Customizing Microsoft Office procedure.

5. Installing, Updating, and Testing Microsoft Office 2000 (or 2003)
1) See steps in the Installing and Customizing Microsoft Office procedure.

6. Installing and Testing the ACE Office Program
1) See steps in the Installing and Testing ACE Custom Software procedure.

7. Installing and Testing Clerical, ACEViewer (and Approval, Depending on the User)
1) See steps in the Installing and Testing ACE Custom Software procedure.

8. Installing the ACE Management Program
1) See step in the Installing and Testing ACE Custom Software procedure.

9. Installing and Customizing the Audatex Website
1) See the Installing and Customizing the Audatex Website Utilities procedure.

10. Installing and Customizing Symantec ACT 2000
1) See the Installing and Customizing Symantec ACT 2000 procedure.

11. Installing Acrobat (Reader or Full Version) and WinZip and eFax Messenger
1) See steps in the Installing and Testing Acrobat Reader, WinZip, and eFax procedure.

12. Installing and Customizing Symantec PCAnywhere
1) See the Installing and Customizing Symantec PCAnywhere procedure.

13. Installing and Customizing Symantec Winfax
1) See the Installing and Customizing Symantec Winfax procedure.

14. Installing and Testing Print Shop 12
1) See the Installing and Testing Print Shop 12 procedure.

15. Installing and Customizing Peachtree
1) See the Installing and Customizing Peachtree procedure.

16. Setting up and Testing an Email Account
1) See steps in the Setting up and Testing an Email Account procedure.

17. Installing and Customizing NOD32 AntiVirus
1) See the Installing, Updating, and Customizing NOD32 AntiVirus Software procedure.

18. Installing and Testing Pop-up Blockers
1) See the Installing and Testing Pop-up Blockers procedure.
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19. Final Customization on the Workstation
1) See the Customizing a System as an ACE Workstation - Ending Steps procedure.

20. Deploying the Workstation
1) See steps in the Deploying an ACE Workstation procedure.
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Setting up an ACE IT Workstation
1. Installing a Windows Operating System
1) See either the Installing Windows 2000 or Windows XP on a Workstation procedure.

2. Preliminary Customization on the Workstation
1) See the Customizing a System as an ACE Workstation - Beginning Steps procedure.

3. Printer Setup
1) See step in the Setting up a Local or Network Printer procedure.

4. Installing and Testing Microsoft Office 97 (Access Only)
1) See steps in the Installing and Customizing Microsoft Office procedure.

5. Installing, Updating, and Testing Microsoft Office 2000 (or 2003)
1) See steps in the Installing and Customizing Microsoft Office procedure.

6. Installing and Testing the ACE Office Program
1) See steps in the Installing and Testing ACE Custom Software procedure.

7. Installing and Testing Clerical, ACEViewer, and Approval
1) See steps in the Installing and Testing ACE Custom Software procedure.

8. Installing the ACE Management Program
1) See step in the Installing and Testing ACE Custom Software procedure.

9. Installing and Customizing the Audatex Website
1) See the Installing and Customizing the Audatex Website Utilities procedure.

10. Installing and Customizing Symantec ACT 2000
1) See the Installing and Customizing Symantec ACT 2000 procedure.

11. Installing Acrobat Full Version and WinZip and eFax Messenger
1) See steps in the Installing and Testing Acrobat Full Version, WinZip, and eFax procedure.

12. Installing and Customizing Symantec PCAnywhere
1) See the Installing and Customizing Symantec PCAnywhere for Host Access procedure.

13. Installing and Customizing UltraMate, Setting up the Printer, and Creating a Backup for UltraMate
1) See steps 4 - 9 in the Setting up an ACE Auditor Workstation procedure.

14. Setting up the Error Message Pop-up Utility
1) From Explorer, browse to F:\Data\Shortcuts. Right-click on “Shortcut to MsgPopup.exe” and select “Copy.”
2) Browse to C:\Documents and Settings\All Users\Start Menu\Programs\Startup. Right-click somewhere and “Paste.”
3) Click the upper right-hand [X] to close Explorer.

15. Setting up and Testing an Email Account
1) See steps in the Setting up and Testing an Email Account procedure.

16. Installing and Customizing NOD32 AntiVirus
1) See the Installing, Updating, and Customizing NOD32 AntiVirus Software procedure.

17. Installing and Testing Pop-up Blockers
1) See the Installing and Testing Pop-up Blockers procedure.

18. Installing All Other Necessary Applications
1) Since the IT workstations are highly customized, go to the specific user’s current system and determine all other
applications that need to be installed. Return to the new workstation and install these applications.
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19. Final Customization on the Workstation
1) See the Customizing a System as an ACE Workstation - Ending Steps procedure.

20. Deploying the Workstation
1) See steps in the Deploying an ACE Workstation procedure.
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Setting up an ACE Email Client
1. Installing a Windows Operating System
1) See either the Installing Windows 2000 or Windows XP on a Workstation procedure.

2. Preliminary Customization on the Workstation
1) See the Customizing a System as an ACE Workstation - Beginning Steps procedure.

3. Printer Setup
1) See step in the Setting up a Local or Network Printer procedure.

4. Installing and Testing Microsoft Office 97 (Access Only)
1) See steps in the Installing and Customizing Microsoft Office procedure.

5. Installing, Updating, and Testing Microsoft Office 2000 (or 2003)
1) See steps in the Installing and Customizing Microsoft Office procedure.

6. Installing and Testing Clerical, ACEViewer, and Approval
1) See steps in the Installing and Testing ACE Custom Software procedure.

7. Installing Acrobat Reader and WinZip and eFax Messenger
1) See steps in the Installing and Testing Acrobat Reader, WinZip, and eFax procedure.

8. Installing and Customizing Symantec PCAnywhere
1) See the Installing and Customizing Symantec PCAnywhere procedure.

9. Setting up and Testing an Email Account
1) See steps in the Setting up and Testing an Email Account procedure.

10. Installing and Customizing NOD32 AntiVirus
1) See the Installing, Updating, and Customizing NOD32 AntiVirus Software procedure.

11. Final Customization on the Workstation
1) See the Customizing a System as an ACE Workstation - Ending Steps procedure.

12. Deploying the Workstation
1) See steps in the Deploying an ACE Workstation procedure.
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Setting up an ACE Email Server
NOTE: Several steps in this procedure require the participation of Bob Puppo and Robert Gizzio in order to
complete the Email Server Setup/Deployment.
1. Installing a Windows Operating System
1) See either the Installing Windows 2000 or Windows XP on a Workstation procedure.

2. Preliminary Customization on the Workstation
1) See the Customizing a System as an ACE Workstation - Beginning Steps procedure.
NOTE: Set up the DHCP reservation for this machine on the server as 192.168.200.210 – after the current Email Server’s
reservation has been deleted from DHCP and its IP address released and renewed (so that it picks up a different IP).
*Also, do not update Internet Explorer to version 7.0. It must remain on version 6.0 for some apps to function.
NOTE2: From the Control Panel, double-click to open “Automatic Updates” and select “Turn off Automatic Updates.”
This will prevent the system from downloading and installing Internet Explorer 7 and other unwanted updates.

3. Printer Setup
1) See step in the Setting up a Local or Network Printer procedure.
NOTE: The ASN printer (which prints to the Canon Imagerunner 3225 printer/scanner/fax machine in the Clerical Dept.)
and Management printer should be added and the ASN printer should be set as the default.

4. Installing and Testing Microsoft Office 97 (Access Only)
1) See steps in the Installing and Customizing Microsoft Office procedure.

5. Installing, Updating, and Testing Microsoft Office 2000 (or 2003)
1) See steps in the Installing and Customizing Microsoft Office procedure.

6. Installing and Testing Clerical, ACEViewer, and Approval
1) See steps in the Installing and Testing ACE Custom Software procedure.

7. Installing Acrobat Full Version and WinZip and eFax Messenger
1) See steps in the Installing and Testing Acrobat Full Version, WinZip, and eFax procedure.

8. Installing and Customizing Symantec PCAnywhere
1) See the Installing and Customizing Symantec PCAnywhere procedure.
NOTE: PCAnywhere Preferences must be set (in addition to Remote settings) for the Email Server’s ports.
The port numbers to be set are: 6531, 6532 (TCP,UDP). The IP address to be set up is 192.168.200.210.
NOTE2: After the new Email Server has been put in place, from an IT workstation, verify that you can log in using
the existing Email Server remote.

9. Installing EclaimServer, PEInetMsgSrv, PESiteMonitor, and Specialty Utilities
1)
2)
3)
4)
5)
6)
7)
8)
9)

Physically go to the current Email Server.
From Explorer, go to F:\. Create a folder called EMSnew.
From the desktop, select EclaimServer, PEInetMsgSrv, and Ariba Invoice and copy them.
From Explorer, go to F:\EMSnew, right-click somewhere in the folder and then click “Paste.”
Browse to C:\Program Files. Select and copy the folder “PEInetMsgSrv.” Paste it in F:\EMSnew, then close Explorer.
Go to the new Email Server and open Explorer.
Browse to F:\EMSnew. Select and cut EclaimServer, PEInetMsgSrv, and Ariba Invoice.
Browse to C:\Documents and Settings\All Users\Desktop, right-click somewhere, and then click “Paste.”
From Explorer, go to C:\Documents and Settings\All Users\Start Menu\Programs\Startup.
Right-click somewhere in the folder and select “Paste Shortcut.” Select the EclaimServer shortcut and delete it.
10) From Explorer, go to F:\EMSnew. Select and cut the folder “PEInetMsgSrv.” Browse to C:\Program Files and paste.
11) Next, browse to F:\Data\First Entry\InternetServer\Package and double-click to open “Setup.exe.”
12) Click “OK” at the Welcome window and then click the large button to begin installation.
13) Click “Continue” to begin installation and then “OK” once the installation is complete.
14) From Explorer, move up one level to F:\Data\First Entry\InternetServer and double-click to run “ACEHTTPService.exe”
(This will set up the files to allow the claims portal to function properly). Click [X] to close the application’s window.
15) Reboot the system and ensure all programs load upon startup. Quickly stop each program – These programs
should NOT be running until the system has been deployed as the new (and sole) email server.
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10. Setting up the Ariba Invoicing Program
1) From Explorer, browse to F:\Data\First Entry\ARIBAInvoice\Setup and double-click to open “Setup.exe.”
2) Click “OK” at the program installation window, then follow the prompts to install the Ariba Invoicing Program software.
3) Click the upper right-hand [X] to close Windows Explorer.

11. Setting up and Testing an Email Account
1) See steps in the Setting up and Testing an Email Account procedure.
NOTE: See the current email server’s Outlook settings and mimic them. For instance, the eclaims email account should be
set as the default account, with ACE set up as the user name for the account. Also, export the aribaorders and
eclaims email accounts from the current server and import them into the new Email Server accounts, setting eclaims
as the default.
NOTE2: Before switching out the current email server, go to the properties of the aribaorders email account, uncheck
“Leave a copy of messages on the server”, and save settings changes. Click to Send/Receive to send and receive
messages, and also to clean all messages for the Aribaorders account off the mailtrust email server.
NOTE3: Once the new Email Server is in place, close Outlook and move the Outlook.pst file from C:\Documents and
Settings\EMS\Local Settings\Application Data\Microsoft\Outlook to F:\Data\Outlook\EmailServer, after renaming
the .pst file already in that directory to Outlook.pstDATE (where DATE equals the current date).
NOTE4: When bringing across the original .pst file in the deployment stage, paste it in a new folder on C:\ named “data.”

12. Installing and Customizing NOD32 AntiVirus
1) NOTE: NO ANTIVIRUS SOFTWARE IS TO BE INSTALLED ON THIS SYSTEM. IF IT WAS ACCIDENTALLY
INSTALLED, SEE STEP 12b. OTHERWISE SKIP 12b.

12b. Excluding Directories from File Scanning on NOD32 AntiVirus
1)
2)
3)
4)
5)
6)
7)

From the lower right-hand corner of the Windows toolbar, click the NOD32 icon to launch the program.
From the NOD32 (v. 2.7) Control Center window, click “AMON.” A large pop-up window will appear. Click “Setup.”
From the Detections tab of the pop-up AMON Setup window, uncheck “Network” (located in the Media subsection).
From the Exclusions tab, click “Add …” From the pop-up window, click “Folder …”
Browse to C:\Program Files, then click “ACE” and “OK.” Click “OK” again to add the directory to the exclusions list.
Click “OK” to close the AMON Setup window.
From the upper right-hand corner of the NOD32 Control Center window, click the down arrow to minimize the program.

13. Testing EclaimServer, PEInetMsgSrv, PESiteMonitor, and Specialty Utilities
NOTE: THIS STEP SHOULD BE COMPLETED AS A PART OF THE DEPLOYMENT, ONCE THE OLD EMAIL
SERVER HAS BEEN REMOVED FROM PRODUCTION.
1) Reboot the new Email Server.
2) After EMS login, verify that several programs automatically run upon startup. From the desktop, double-click to open
Microsoft Outlook and then EclaimServer.
3) Click “Unblock” at the “Windows Firewall has blocked” pop-up message.
4) Go to a workstation containing the Approval program and email a test audit.
5) Verify that the audit email is sent from the new Email Server properly.
6) Maximize PESiteMonitor (which should be running) and verify its interval is set at 2.

14. Installing Java Software
NOTE: Java must be installed on the system in order to facilitate proper BodyShopNet.com user account login.
1) From the desktop, double-click to open “Internet Explorer.” Type www.java.com in the address field of the
Internet Explorer window and press [ENTER].
2) Click the “Free Java Download” button and then follow prompts to install the java software on the system.

15. Final Customization on the Workstation
1) See the Customizing a System as an ACE Workstation - Ending Steps procedure.

16. Deploying the Workstation
NOTE: AT THIS TIME, CONTACT BOB PUPPO/ROBERT GIZZIO TO AID IN DEPLOYING THE SYSTEM.
1) See steps in the Deploying an ACE Workstation procedure.
NOTE: Before deploying this workstation, set up a time with the programmer Bob Puppo (who needs to do some work on his
end in order to get the Email Server to function properly). Also, remind him to enable the BodyShopNet website for
passthrough (so that BodyShopNet access will function in addition to ACE-it.com access).
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Setting up an ACE Fax Server
1. Installing Windows 98 on a Workstation
NOTE: ACE Fax Servers must be set up with the Windows 98 Operating System.

Deleting / Recreating a Partition on the Hard Drive
1)
2)
3)
4)

Make sure that a keyboard, mouse, monitor and power is connected to the workstation, but NOT the network cable.
Boot the workstation from a “Windows 98 Startup Disk” floppy disk.
From the Microsoft Windows 98 Startup (in DOS), select #2, “Start computer without CD-ROM” and press [ENTER].
At the DOS Prompt, in order to delete/create the partition for the hard drive, run FDISK.
- Answer “Y” to enable large disk support and press [ENTER].
- Type 3 (to delete the current partition) and press [ENTER].
- Type 1 to delete the primary DOS partition and press [ENTER].
- Press [ENTER] twice and type Y then hit [ENTER] to delete the partition.
- Hit [ESC] and then choose option #1 – Create DOS partition …
- Press [ENTER] again to choose option #1 – Create a Primary partition.
- After the system verifies the integrity of the drive, press [ENTER] to answer “Y” (to make the partition active).
- Once finished press [ESC] to exit FDISK. Shut off the workstation by pulling the power cord and wait 5 seconds.

Formatting the Hard Drive and Installing Windows 98
1) Install a CD-ROM drive in the workstation, if one is not already present.
2) Plug in the power cord and restart the workstation. Upon restart, press [DELETE] to enter the system BIOS.
3) Set the CD-ROM drive as the secondary master (if it is not automatically), and as the primary boot device.
4) Exit the BIOS and save the settings changes that were made.
5) Upon automatic reboot, insert a Windows 98SE CD into the CD-ROM.
6) At the DOS menu, arrow down to “2. Boot from CD-ROM” and press [ENTER].
7) At the Win98 DOS option menu, press [ENTER] with option 1, “Start Windows 98 Setup from CD-ROM”, selected.
8) Press [ENTER] at the Microsoft Windows 98 Setup window.
9) Press [ENTER] with “Format this drive” selected. Wait a few minutes while the hard drive formats.
10) After the hard drive has finished formatting, press [ENTER]. A brief system check will be performed prior to the setup.
11) After Scandisk has run, click “Continue” at the Windows 98 Setup window.
12) Click on the bullet “C:\WINDOWS” at the Choose Directory window, then press [ENTER].
(If the default directory reads “C:\WINDOWS.000” select “Other Directory” and remove the .000.)
13) Select the bullet next to “Custom” at the Setup Options window, then click on “Next.”
14) From the Select Components window:
- Uncheck Accessibility, Communications, Internet Tools, Multimedia, Online Services, and Outlook Express.
- Double-click Accessories. Locate and deselect Paint and Screen Savers, and then click “OK” and then “Next.”
15) In the Computer Name field of the Identification window type UserType (Approval, Auditor, Clerical, EmailClient,
EmailServer, FaxServer#, or Manager Name).
16) Type ACE in the Workgroup field, and Workstation in the Computer Description field, then click “Next.”
17) Click “Next” at the Computer Settings and Establishing Your Location windows.
18) Click “Next” at the Startup Disk window, “Cancel” at the pop-up window and then “OK” at the 2nd pop-up window.
19) Click “Next” at the Start Copying Files window to begin the file copy process.
20) Remove the Windows 98 Startup Disk and click “OK” to reboot the workstation.
21) After system reboot, at the User Information window enter UserType (Approval, Auditor, Clerical, EmailClient,
EmailServer, FaxServer#, or Manager Name).in the Name field. Type ACE in the company field, and click on “Next.”
22) At the License Agreement window, click the “I accept the Agreement” bullet and then click “Next.”
23) Enter the Windows 98 license # (included with software) at the Windows Product Key window, and click on “Next.”
24) Click “Finish” to begin setup. From the Date/Time Properties window, select “(GMT – 05:00) Eastern Time …”
Remove the Windows 98SE CD from the CD-ROM drive and then click “Apply” and “OK.” The system will reboot.
25) Upon restart, press [DELETE] to enter the system BIOS.
26) Set the A: drive as the primary boot device, the C: drive as the secondary device, and the CD-ROM as the third device.
Exit the BIOS and save the settings changes that were made.
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Configuring Windows Network Settings
1) Upon Windows startup, uncheck “Show this the next time Windows starts” and click “Close” at the Welcome to Windows
98 window. If necessary, click “Cancel” at the login prompt.
2) From the desktop, if Network Neighborhood is present… right-click on it, select “Properties” and proceed to step 13.
Otherwise, right-click on My Computer and select “Properties.”
3) Select the Device Manager tab of the System Properties window.
4) Expand the “Other Devices” section by clicking the + sign and select “PCI Ethernet Controller.”
5) Click on “Remove” and then “OK” to the warning message.
6) Click on “Refresh” and the Update Device Driver Wizard will start.
7) Insert the floppy disk labeled “3Com Etherlink Ver. 5.1 3C90X Disk 2” and then click on “Next.”
8) Windows should have found the drivers on the floppy disk and have the name of a 3Com network card listed.
9) Click on “Finish” then on “OK.” Click on the pull down arrow from the Copying Files window and select “A:\”
10) Click on “OK.” Click on “OK” again to clear the Network window.
11) In the Computer Name field of the Network window type ACE*, where * is the workstation ID#.
12) Type ACE in the Workgroup field, and FaxServer in the Computer Description field.
13) Select the Configuration tab. Select the generic “Dial-Up Adapter” and click “Remove.”
Verify that “Client for Microsoft Networks”, the specific Dial-Up network card, and “TCP/IP” are the only items listed.
14) Select the “Client for Microsoft Networks” and click on “Properties.”
15) Check “Log on to Windows NT domain”, type ACE in the Windows NT domain field, and then click “OK.”
16) Click on “OK” to close the Network window.
17) Remove the floppy disk and then click “Yes” to the System Settings Change request to restart the workstation.

Downloading and Installing Windows 98 Updates
1)
2)
3)
4)

Go to an IT workstation. From the desktop, double click to open “ACE Router.”
At the pop-up window, type admin in the User Name field, password in the Password field, and click “OK.”
From the lefthand menu of the Netgear Router window, click on the “Block Service” link.
To allow internet access on all ACE computers, uncheck the “Enable” checkbox next to “Internet Access.”
Click “Apply” and then click the upper righthand [x] to close the Netgear Router window.
5) Return to the workstation. From Explorer, go to (the mapped server1\files drive)\Shortcuts to Setups
and double-click InternetExplorer5-5.
6) Select the “I Accept the agreement” bullet at the Welcome to setup dialog box and click “Next.”
7) Select the “Install Now” bullet and click “Next” to begin download/installation.
8) After the installation is complete, click “Finish” to reboot the system.
9) When Windows is back up, logon to the network as Administrator.
10) From the Start Menu, select “Windows Update.” (Steps 11 – 14 may be unnecessary.)
11) From Internet Explorer, click “Connect me to the Internet.”
12) At the Internet Connection Wizard window, select the “Connect through a LAN“ bullet and click “Next.”
13) Select the “Connect through a LAN” bullet again and click “Next”, then uncheck all options and click “Next.”
14) Check the “No mail account” checkbox and click “Next”, then click “Finish” to connect to the internet.
15) Click “Yes” at the pop-up window message to install Windows Update V4 Control.
16) Click the “Scan for updates” link. After an updateable file scan runs, click “Review and install updates.”
17) Click “Yes” at the pop-up and then, from the lefthand menu, click “Critical Updates and Service Packs.”
18) Click Add/Remove to compile all necessary files, then click “Install Now.” Click “Accept” or “Next” to install files.
19) After installation is complete, click “Finish”, then “OK” to reboot. Upon reboot, logon to the network as the User.
20) From the Start Menu, select “Windows Update.”
21) Repeat steps 16 – 20, until all available Windows updates have been downloaded.
22) Return to the IT station and, from the Netgear Router, recheck the “Enable” checkbox to block internet access.

2. Customizing Windows 98
Customizing Windows Explorer
1) When Windows is back up, logon to the network as Administrator.
2) Delete your password out of the New password field in the Set Windows Password window and then click on “OK.”
3) From Explorer, browse to C:\Windows. Right-click somewhere in the “Contents of ‘My Computer’ “ section
and select “View -> Details.”
4) From the upper menu of Explorer, select “View” and then click “Folder Options …”
5) From the General tab, select the “Classic style” bullet.
6) From the View tab, check “Display the full path in the title bar.” Click the “Show all files” bullet and uncheck
“Hide file extensions for known file types.” Click the “Like Current Folder” button. Click “Yes” at the pop-up window.
7) Click “Apply” and then “OK” to close the Folder Options window.
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Customizing the Recycle Bin
1) From the desktop, right-click on the “Recycle Bin” icon and select “Properties.”
2) Uncheck “Display delete confirmation dialog.” Click “Apply” and then “OK.”

Customizing Desktop and Display Properties
1) Right-click somewhere on the desktop and click “Properties.”
2) Go to the Settings tab. If the Color palette is set to 256 Color and the Desktop area to 640x480 pixels, proceed to Step 10
(because Windows already recognizes the system’s video card). Otherwise, click on “Advanced ...”
3) From the Adapter tab, click “Change …”
4) Click “Next” at the Update Device Driver window. Click “Search for a better driver” and click “Next.”
5) Check the “Specify a Location” checkbox and click “Browse …”
6) To install the driver(s), click “Browse …” and go to (the mapped server1\files drive)\drivers\video\* (depending on card).
7) Once the driver(s) are located, click “OK” and then “Next” to complete installation.
8) Click “Finish” and then “Yes” in order to reboot the workstation.
9) After Administrator login, right-click on the desktop and click “Properties.” Verify the system is now set to 640 x 480.
10) From the Appearance tab, be sure “Desktop” is currently selected under “Item” and change the color to dark blue.
11) Change “Item” option to “Selected Items” by clicking on the pull down menu arrow and change the color to dark purple.
12) From the Background tab, verify that the Wallpaper is set to “[None].” Click “Apply”, then “OK” with “Apply the
settings without restarting” bulleted. Click “Yes” in response to the pop-up message and “Yes” to retain the new settings.
13) From the Screen Saver tab, verify that “[None]” is selected.
14) Next, click “Settings …” Change the Turn off monitor option to “After 5 hours” and the Turn off hard disks to “Never.”
Click “Apply and then “OK.” Click “Apply” and then “OK” again to close the Display Properties window.

Customizing System Properties
1) From the desktop, right-click on “My Computer” and select “Properties.”
2) From the Device Manager tab, for each Device Manager item listed under Network adapters:
- Right-click on the network adapter and select “Properties.”
- Click on the Power Management tab (if present).
- Uncheck “Allow the computer to turn off this device…” and then click “OK.”
3) Click “OK” to close the System Properties window.

3. Setting the Autoexec Batch Program to Delete Temp Files
1) From the Start menu, select “Programs\MS-DOS Prompt.” From the MS-DOS Prompt:
- Type cd\ and press [ENTER].
- Type edit autoexec.bat and press [ENTER].
- Once in autoexec, press [ENTER] and arrow up to the top blank line.
- Type @ECHO OFF and press [ENTER].
- Type C:\ and press [ENTER].
- Type CD\WINDOWS\TEMP and press [ENTER].
- Type DELTREE /Y *.* and press [ENTER].
- Point the mouse to the File menu, click “Exit” and click “Yes” to save changes.

4. Installing and Testing ACEViewer
1) See the step in the Installing and Testing ACE Custom Software procedure.

5. Installing and Testing the ACE Fax Server
1)
2)
3)
4)
5)
6)
7)
8)

From Explorer, go to F:\Data\First Entry\EclaimFax\Server and double-click to open “setup.exe.”
Click “OK” at the Welcome window. Click the large installation button to install the Fax Server.
Click “Continue” to continue installation and then “OK” once the installation is complete.
From Explorer, now go to F:\Data\Shortcuts. Right-click the ACE Fax Server shortcut and select “Copy.”
Go to the desktop, right-click and select “Paste.”
Double-click to open the ACE Fax Server. Click “Unlock” and then press [ENTER] at the pop-up window.
Check the checkbox beside “No Msg Processing” and then click “Start Msg Scan” to verify that the program runs.
Click “Stop Msg Scan” and then, once stopped, uncheck “No Msg Processing.” Close the ACE Fax Server.

6. Installing and Customizing Symantec PCAnywhere
1) See the Installing and Customizing Symantec PCAnywhere procedure.
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8. Installing Symantec Winfax (10.0)
1)
2)
3)
4)
5)
6)
7)
8)

Insert a WinFax CD into the CD-ROM and click the “INSTALL” button to begin the installation.
Click “Next” at the Welcome window and “Yes” to accept the Software License Agreement.
At the User Information window, type FaxServer* in the “Name” field, ACE in the “Company” field, and click “Next.”
Click “Next” at the Destination Folders window.
Click “Next” at the Setup Type window with the bullet next to “Typical.”
Click “Next” at the Select Program Folder and Start Copying Files windows.
Click “Finish” at the File Copy Complete window to complete installation.
At the Setup-CSID window, type ACE in the CSID field, 6104295205 in the
fax number field, and 6104295200 in the phone number field and click “Next.”
9) Select “WinFax Pro Sharing” as the device and click “Next.”
10) Click “No” in response to the pop-up question about configuring now.
11) Click “Next” at the Enable Controller window with “Yes” bulleted.
12) Click “Next”, “Cancel” at the Registration window, and “Yes” in response to the pop-up message.
13) Click “Finish” and then “No” in response to the README file pop-up question.
14) Click “Cancel” at the LiveUpdate window.
15) Click “No” in response to the “Would you like to run Message Manager now?” pop-up message.
16) Click “Exit”, then remove the WinFax CD from the CD-ROM.
17) From the Start menu, select “Shut Down …” and shutdown the system.

9. Installing the COM1 and COM2 Modems
1) Physically install an AOpen FM56-PM modem in the computer and then start the system.
2) Insert the AOpen Fax/Modem Suite cd into the CD-ROM drive.
3) After Administrator login, Windows will recognize a new device.
4) Click “Next” at the first New Hardware Wizard window.
5) Click “Next” with “Search for best driver” bulleted.
6) Check “Specify a Location” and then click “Browse …”
7) Go to D:\, locate the specific driver needed for Windows 98, and click “OK.”
8) Click “Next.” Click “Next” again to install the drivers and “Finish” to complete the installation.
9) From the desktop, right-click on My Computer and select “Properties.”
10) From the Device Manager tab, locate the AOpen modem (under Modem) and click “Properties.”
11) From the Modem tab, move the speaker volume down to “Off.”
12) Click “OK” twice to accept settings changes, remove the AOpen cd, and then shutdown the system.
13) Physically connect the USRobotics 56K Faxmodem to the computer and then start the system.
14) Insert the USRobotics Installation Essentials cd into the CD-ROM drive.
15) After Administrator login, Windows will recognize a new device.
16) Click “Next” at the first New Hardware Wizard window.
17) Click “Next” with “Search for best driver” bulleted.
18) Check “Specify a Location” and then click “Browse …”
19) Go to D:\, locate the specific driver needed for Windows 98, and click “OK.”
20) Click “Next.” Click “Next” again to install the drivers and “Finish” to complete the installation.
21) Remove the USRobotics cd.
22) From the desktop, right-click “My Computer” and select “Properties.”
23) From the Device Manager tab, locate the USRobotics modem (under Modem) and click “Properties.”
24) From the Modem tab, move the speaker volume down to “Off.”
25) Click “OK” and then “OK” again to exit the System Properties window.

10. Configuring the COM1 and COM2 Modems
1) From the Start Menu, go to Settings -> Control Panel.
2) Double-click to open “Modems.”
3) Under “What area code are you in now?”, type 555.
4) Under “If you dial a # to access an outside line, what is it?”, type 91. Click “Close.”
5) From the General tab of the Modems Properties window, click “Dialing Properties.”
6) Click “Area Code Rules …”, check “Always dial the area code (10-digit dialing)”, and click “OK.”
7) Click “Apply” and then “OK.”
8) From the Diagnostics tab, select the USRobotics modem and click “More Info …” (The system will query the modem.)
9) Now select the AOpen modem and click “More Info …” (Again, the system will query the modem.)
10) To verify that both modems will be able to handle regular usage, repeat steps 9 and 10 three to four times.
11) Click “OK” to close the Modems Properties window and then close the Control Panel.
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11. Changing Symantec Winfax (10.0) Settings
1) From the desktop, double-click to open WinFax Pro Message Manager.
2) Uncheck the “Show any unlinked applications …” and click “OK.”
3) Go to the upper toolbar and select “Tools -> Program Setup …”
4) Select “Modems and Communications Devices” and click “Properties …”
5) Select the AOpen modem and click “Properties.” Click “Yes” in response to the pop-up message.
6) Click “Next” to query the modem. After querying is complete, click “Next.”
7) Click “Finish.” At the Select Locations pop-up window, check only the “Default” checkbox and click “OK.”
8) Click “Yes” in response to the pop-up message.
9) Under Country, use the pull down arrow to select “United States of America (1).”
10) Click “Area Code Rule” and uncheck “Ask me whether calls to exchange within the area codes are …” Click “OK.”
11) Click “Apply” and then “OK.”
12) Move the speaker volume to “Off.”
13) Under Communications port, use the pull down arrow to select COM2 and to set the modem speed to 38400 bps.
14) Click “Apply” and then “OK.”
15) Select the USRobotics modem and click “Properties.” Click “Yes” in response to the pop-up message.
16) Click “Next” to query the modem. After querying is complete, click “Next.”
17) Click “Finish.” At the Select Locations pop-up window, check only the “Default” checkbox and click “OK.”
18) Click “Yes” in response to the pop-up message.
19) Under Country, use the pull down arrow to select “United States of America (1).”
20) Click “Area Code Rule” and uncheck “Ask me whether calls to exchange within the area codes are …”
21) Select the 555 area code and click “Properties.”
22) Check “Always dial the [555] area code”, select the “All calls are local” bullet and then click “OK.”
23) Click “OK” and then “OK” again.
24) Move the speaker volume to “Off.”
25) Under Communications port, use the pull down arrow to select COM1 and to set the modem speed to 38400 bps.
26) Click “Apply” and then “OK.”
27) Verify that both modems are checked “Active” and click “OK” and then “Close.”
28) Close Winfax and reboot the system. After administrator login, double-click to reopen WinFax Pro Message Manager.
29) Go to the upper toolbar and select “Tools -> Program Setup …”
30) Select “Send” and click “Properties …”
31) Under the General tab, uncheck “Include a cover page.”
32) Under the Header tab, change the information in the Left field to read… From: ACE 610-429-5205 To: @R.
33) From the Advanced tab, verify that both modems are checked and click “OK.”
34) Select “Receive” and click “Properties …”
35) Uncheck “Automatically answer incoming calls.”
36) Go to the “When answering on” drop down arrow and select the other modem.
37) Uncheck “Automatically answer incoming calls” and click “OK.”
38) Select “Dialing and Location” and click “Properties …”
39) Under the General tab, increase the “Number of retries for busy numbers” to 20.
40) Decrease the “Number of retries for no answer” to 0 and set the “Retry every” to 60 seconds and click “OK.”
41) Select “Modems and Communications Devices” and click “Properties …”
42) For each of the 2 modems, select “Properties”, and from the Fax tab, check “ECM for Sending” and check
“ECM for receiving.” Click “OK.” Click “Apply” and then “OK.” Click “Close” and then close WinFax.

12. Printer and Batch File Setup
1) From the Start menu, select “Settings -> Printers.” Double-click on the “Add Printer” icon.
2) At the Add Printer Wizard window, click “Next.” Click on the bullet for Network printer and click “Next.”
3) In the Network path field, type \\Server1\CS-TransRpt and click “Next” with “No” bulleted.
4) In the Printer name field, type FaxServ-TransRpt and click “Next” with “Yes” bulleted (to set the printer as the default).
5) Select “No” to avoid printing a test page and click “Finish.”
6) Once the printer appears as an icon in the Printers window, right-click on it and select “Properties.”
7) From the General tab, click “Print Test Page.” Click “Yes” in response to the pop-up “Did the test page print correctly?”
8) From the Paper tab, click “More Options …” From the Output bin pull-down menu of the pop-up, select “Face-Up.”
9) Click “OK” twice to accept settings changes and then click the upper [X] to close the Printers window.
10) Go downstairs and retrieve the test print from the printer.
11) From Explorer, browse to F:\Batch. Copy the file “SetTime.bat” and paste it in the C:\ directory.
12) Copy the newly copied “SetTime.bat” and, from the desktop, right-click and select “Paste Shortcut.” Close Explorer.
13) Right-click on the icon. From the Program tab, click “Change Icon …”
14) Select the traffic light from Pifmgr.dll and click “OK” twice in order to accept settings changes.
15) From the Start menu, select “Shut Down …” and shutdown the system.
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13. Disabling the Floppy Drive and Password Protecting BIOS
1) Upon system reboot, press [DELETE]. A BIOS Setup window will appear. From the BIOS Setup, set the following:
(Note, that BIOS settings vary, depending upon the system. Therefore, not all of the following options may be present.)
- First, select Load Turbo defaults by selecting “Yes.”
- Select the Primary Slave, the Secondary Master, and the Secondary Slave each and set them to “None.”
- Select Drive A: (the floppy drive), and set it to “None” or “Not Installed.”
- Select the Boot Sequence and set it to “A, C, CDROM” or “A, C, SCSI.”
- Select the Boot up Numlock Status and set it to “On.”
- Select ACPI and then Power Management and set each to “Disable” or “Off.”
- Select PM Control by APM and set it to “No.”
- Select PNP OS Installed and set it to “Yes.”
- Select Resources Controlled by and set it to “Auto.”
- Select the System Password. Be sure that [CAPS LOCK] is off, then type in the *password* and press [ENTER].
Confirm the password and press [ENTER]. Click “OK” at the “Supervisor Password Installed” message.
2) Save the changes and exit BIOS.
3) When Windows is back up, logon to the network as Administrator.
4) From Explorer, browse to (the mapped server1\files drive)\DISKS\SystemUpdates\win95 and double-click
to run “mdac_typ.exe.”
5) From the License Agreement window, check “Yes, I accept the terms of the license agreement” and click “Next.”
6) Click “Next” to begin the Data Access Components and “Finish” when the setup is complete.
7) Shutdown the system.

14. System Cleanup
1) From the desktop, drag “Online Services”, “Connect to the Internet”, “Set Up MSN Internet Access”, “Internet
Explorer”, and “Winfax Drag & Drop Depot” to the Recycle Bin. Right-click on “My Documents”,
select “Remove from Desktop”, and answer “OK” to the pop-up.
2) Rearrange the desktop icons in the following order…
- ACEViewer, WinFax PRO Message Manager, ACE Fax Server, Enable Host Mode, Shortcut to SetTime.bat.
Right-click on the desktop and select “Line up Icons” to align the icons.
3) Right-click on the Start menu button and click “Explore.”
4) Double-click to open the Programs directory.
5) Delete the “ACEViewer” folder, “Internet Explorer”, and “Clerical.”
6) Double-click on the Accessories folder and delete the “Entertainment” and “Internet Tools” folders.
7) Go to C:\Program Files. Select and delete “ACEViewer.” From the pop-up, click “Delete All Files.”
8) From Explorer, go to “C:\Windows\Inf” (unhide) and double-click to open “Applets.inf.”
9) From the .inf file, scroll to the portion of code “[SCREENSAVERS]” and change to “[NOSCREENSAVERS].”
10) Scroll to the portion of code containing “[MSPAINT]” and change to “[NOMSPAINT].”
11) Save and then close the .inf file. Next, double-click to open “Appletpp.inf.”
12) Scroll to the portion of code containing “[GAMES]” and change to “[NOGAMES].”
13) Save and then close the .inf file, and then rehide the “hidden” files in Explorer.
14) Go to C:\Windows. Arrange the files by Type and then delete all .bmps. Rearrange the files by Name.
15) Browse to C:\Windows\Web\Wallpaper. Select and delete “Windows98.htm” and then close Explorer.
16) From the desktop, right-click somewhere and select “Properties.”
17) From the Background tab of the Display Properties window, verify that None is the only background option.
18) Click the “Pattern …” button. From the Pattern window, click on each pattern. For each pattern, select the pattern and
click “Edit Pattern …” Click “Remove”, “Yes” at the pop-up message, and then “Done.”
19) Close the Display Properties window, and, from the desktop, right-click on the toolbar (bottom) and select “Properties.”
20) From the Start Menu Programs tab of the Taskbar Properties window, click the “Clear” button to remove all items
from the Start Menu/Documents folder.
21) From the desktop, right-click on the Internet Explorer icon (contained within the lower left portion of the menu bar)
and select “Delete.” Answer “Yes” in response to the pop-up message.
22) From the desktop, right-click on the Recycle Bin and select “Empty Recycle Bin.”
Click “Yes” in response to the “Are you sure you want to delete?” pop-up message.
23) From the toolbar menu, right-click on the Outlook Express icon and select “Delete.” Answer “Yes” at the pop-up.
Repeat this step for the Internet Explorer icon.
24) Click “OK” to close the window, verify that the Start Menu/Documents is now empty, and shutdown the system.
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Setting up a Local or Network Printer
(The following steps may vary slightly, depending upon whether the system OS is Windows 2000 or XP.)

1. Setting up a Generic Local Printer (for Audatex PenPro)
1) From the Start menu, select “Settings -> Printers and Faxes.”
2) Double-click on “Add Printer.” At the Add Printer Wizard window, click “Next.”
3) Click on the “Local printer” bullet, then uncheck “Automatically detect and install my Plug and Play printer”
and click “Next.”
4) Verify that “Use the following port” is bulleted and the drop down menu option “LPT1” is selected. Click “Next.”
5) From the Manufacturer menu list of the Install Printer Software window, click “Generic.”
From the Printers menu list, click “Generic / Text Only.” Click “Next.”
6) From the Name Your Printer window, verify that the Printer name set at Generic / Text Only.
Answer “Yes” or “No” to the default printer question (“Yes” if it is the default) and click “Next.”
7) From the Printer Sharing window, click “Next” with “Do not share the printer” bulleted.
8) Click “No” in response to “Do you want to print a test page?” and click “Next.”
9) Click “Finish.” Click the upper right-hand [X] to close the Printers and Faxes window.

2. Setting up the ADP_PDF_Auto Network Printer (for Audatex PenPro)
1)
2)
3)
4)
5)

From the Start menu, select “Settings -> Printers and Faxes.” Double-click on the “Add Printer” icon.
At the Add Printer Wizard window, click “Next.” Click on the bullet for Network printer and click “Next.”
Select the “Type the printer name…” bullet, type \\SERVER1\ADP_PDF_Auto in the printer field and click “Next.”
Click “Next” with “Yes” bulleted in response to “Do you want to use this printer as the default printer?”
Click “Finish.” Click the upper right-hand [X] to close the Printers and Faxes window.

3. Setting up a Specific Local Printer (for Mitchell UltraMate)
(NOTE: The UltraMate printer should already be specified in the Registry and the system then rebooted before proceeding.)
1) From Explorer, go to C:\. Right-click somewhere to create a new folder and name it Print.
2) From the Start menu, select “Settings -> Printers and Faxes.” Double-click on “Add Printer.”
3) At the Add Printer Wizard window, click “Next.”
4) Click on the “Local printer attached to this computer” bullet, then
uncheck “Automatically detect and install my Plug and Play printer” and click “Next.”
5) Verify that “Use the following port” is bulleted. From the drop down, select “C:\Print\Estimate.prn” and click “Next.”
6) From the Manufacturer menu list of the Install Printer Software window, click “Generic.”
From the Printers menu list, click “Generic / Text Only.” Click “Next.”
7) In the Printer name field of the Name Your Printer window, type Mitchell UltraMate Printer and click “Next.”
If necessary, answer “Yes” to the default printer question and click “Next.”
8) From the Printer Sharing window, click “Next” with “Do not share the printer” bulleted.
9) Click “No” in response to “Do you want to print a test page?” and click “Next.” Click “Finish” to create the printer.
10) From the Printers and Faxes window, right-click on the Mitchell UltraMate Printer and select “Properties.”
11) From the General tab, click “Print Test Page.” Click “OK” in response to the pop-up message.
12) From Explorer, browse to C:\Print and verify that the file “Estimate.prn” is present. Close Explorer.
13) Click “OK” to close the Printer’s window, then click the upper right-hand [X] to close the Printers and Faxes window.

4. Setting up a Network Printer
(NOTE: Determine which printer(s) the specific user should have set up on his or her workstation before proceeding.
Perform the following for EACH printer to be installed on the workstation.)
1) From Explorer, type \\server1 in the address bar and press [ENTER]. A list of shares (including printers) will appear.
2) Locate the printer to be installed and then double-click it.
3) A pop-up Connecting to (printer) window will appear. Wait a few moments for the printer to initialize.
4) Once the printer initializes, click the upper right-hand [X] to close the printer’s window.
5) From the Start menu, select “Settings -> Printers and Faxes.”
6) Next, right-click on the specific printer and select “Properties.”
7) From the General tab, click “Print Test Page.” Click “OK” in response to the pop-up message.
8) Click “OK” to close the Specific Printer window.
9) Click the upper right-hand [X] to close the Printers and Faxes window.
10) Retrieve the test prints from all established printers.
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Installing and Testing ACE Custom Software
(Complete the following to install Clerical, ACEViewer, Approval, Auto Management, Sweeper and/or ACE Office program.)

1. Installing and Testing Clerical
1) From Explorer, browse to (the mapped server1\files drive)\Shortcut to Setups\Setup Clerical
and double-click on “Setup Clerical.”
2) Click “OK” at the ACE Clerical Setup window and then click on the large installation button.
Answer “Yes” to all pop-up messages and click “OK” once the installation is complete.
3) From the Setup Clerical folder of Explorer, right-click on “comdlg32.ocx” and select “Copy.”
4) From a second copy of Explorer, browse to C:\Windows\System32. Right-click somewhere and select “Paste.”
Answer “Yes” at the pop-up, if necessary.
5) From the Start Menu, select “Programs –> Accessories” and then click to open “Command Prompt.”
6) From the Command Prompt, type cd.. and press [ENTER]. REPEAT. Next, type cd\windows(or winnt)\system32
and press [ENTER]. Finally, type regsvr32 comdlg32.ocx and press [ENTER]. Click “OK” at the pop-up message.
Type exit to close the Command Prompt.
7) From the second copy of Explorer, browse to F:\Data\Shortcuts, right-click on “Shortcut to clerical”, and select “Copy.”
8) From a third copy of Explorer, browse to C:\Documents and Settings\All Users\Desktop. Right-click and click “Paste.”
9) From the desktop, double-click to open “Shortcut to clerical” and click “OK” at the Login, using the user’s User Name.
10) From the upper menu, click on the yellow folder to open a new claim. Enter a test number (6 digits) and click “OK.”
11) Verify that data populates into the data fields and then click the upper right-hand [X] to close Clerical.

2. Installing and Testing ACEViewer / Active Reports
1)
2)
3)
4)
5)
6)
7)
8)

From Explorer, browse to (the mapped server1\files drive)\Shortcut to Setups. Double-click to run “Setup ACEViewer.”
Click “Next” at the Welcome window, “Accept” at the License Agreement, and “Next” at the Start Installation window.
Click “Finish” to close the installation program.
From a second copy of Explorer, browse to F:\Data\Shortcuts, right-click on “ACEViewer”, and then select “Copy.”
From a third copy of Explorer, browse to C:\Documents and Settings\All Users\Desktop. Right-click and click “Paste.”
From the desktop, double-click to open “ACEViewer.” Enter a test number (6 digits) in the Audit field and “View.”
Verify a file pulls up into the viewer, then click the upper right-hand [X] to close both the file window and ACEViewer.
If Approval is not to be installed on the workstation, click to close all open Explorer windows.

3. Installing and Testing the Approval Program
(This step is NOT necessary when setting up an auditor workstation.)
1) From Explorer, browse to (the mapped server1\files drive)\Shortcut to Setups. Double-click to run “Setup Approval.”
2) Click “OK” at the Project 1 Setup window and then click the large button to begin the installation process.
3) Click “Continue” to add Project 1 to the program files list and “OK” to complete the installation.
4) From a second copy of Explorer, browse to F:\Data\Shortcuts, right-click on “Approval”, and then select “Copy.”
5) From a third copy of Explorer, browse to C:\Documents and Settings\All Users\Desktop. Right-click and click “Paste.”
6) Close all open Explorer windows.
7) From the desktop, double-click on “Approval” and click “OK” at the Login, using the user’s User Name.
8) Enter a number in the ACE Audit # field and press [ENTER]. Verify that info pulls up properly, then close Approval.

4. Installing and Testing the Auto Management Program
(This step is ONLY necessary when setting up a manager workstation.)
1) From Explorer, browse to F:\Data\First Entry\AutoManagement. Right-click on “Kermit.ico” and then select “Copy.”
From a second copy of Explorer, browse to C:\Windows. Right-click somewhere and select “Paste.” Close this Explorer.
2) From the first Explorer, double-click to open the “Setup” folder and then double-click to run “setup.exe.”
3) Click “OK” at the ACE Auto Mgmt Setup window, then click the large button and “Continue” to begin the installation.
4) Click “OK” at the pop-up. Next, from Explorer, double-click to open “SharpGrid” and “sg2001100.”
Double-click to open “SharpGrid1100Update.exe.”
5) Click “Next” at the Welcome window. Click “Accept” at the License Agreement window.
6) Click “Next” 4 times to begin the installation and then “Finish” once the installation is complete.
7) From Explorer, browse to F:\Data\Shortcuts, right-click on “ACE Auto Management”, and then select “Copy.”
8) Next, browse to C:\Documents and Settings\All Users\Desktop. Right-click and click “Paste.” Close Explorer.
9) From the desktop, right-click on “ACE Auto Management” and select “Properties.”
10) From the Shortcut tab, click “Change Icon …” and click “OK.” Click “Browse.” Browse to C:\Windows,
select the kermit.ico file, and click “Open” and then “OK.” Click “Apply” and then “OK” to change the icon.
11) From the desktop, double-click to open “ACE Auto Management” and click “OK” at the Login, using
the user’s User Name. Verify the program opens, then click the upper right-hand [X] to close Auto Management.
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5. Installing and Testing the Sweeper Program
(This step is ONLY necessary when setting up an auditor workstation.)
1) From Explorer, browse to F:\Data\Shortcuts, right-click on “Shortcut to Sweeper”, and then select “Copy.”
2) Next, browse to C:\Documents and Settings\All Users\Start Menu\Programs\Startup. Right-click somewhere
and select “Paste.” Click the upper right-hand [X] to close Explorer.

6. Installing and Testing ACE Office
(This step is ONLY necessary when setting up a manager workstation.)

Installing ACE Office
1) From Explorer, go to F:\Off\Setup and double-click on “Setup.exe.”
2) At the Welcome window, click “Next.” Click “Next” at the Select Program window and “Finish” to complete installation.
1a) From Explorer, go to F:\Off\Offsetup\Sheridan\Calendar Widgets 1.0 and double-click on “Setup.exe.”
2a) From Select Options, check ONLY the “Install Calendar Widgets 32-bit Components” checkbox and click “OK.”
3a) Click “OK” at the Select Directories window and “Yes” to start copying files. Click “OK” at all pop-up install prompts.
4a) Click “OK” in response to the Installation Complete pop-up message. Close the Readme file.
1b) From Explorer, go to F:\Off\Offsetup\Sheridan\Calendar Widgets 1.0b and double-click on “Setup.exe.”
2b) Click “OK” and then “No” twice. Click “OK” at all pop-ups once the installation is complete. Close the Readme file.
1c) From Explorer, go to F:\Off\Offsetup\Sheridan\Data Widgets 2.0 and double-click on “Setup.exe.”
2c) Click “OK” and then “OK” again at the Registration Info window, with the user’s FirstName LastName in the
Name field and ACE in the Company field. Click “Yes” at the pop-up message.
3c) Click “Next” at the following two windows. At the Backup Replaced Files window, select “No” and click “Next.”
4c) At the Add Items to Start Menu window, select “No” and click “Next.”
5c) From Select Components, check ONLY the “Data Widgets 32-Bit OCX Components” checkbox and click “Next.”
6c) Click “Start Install” and “OK” once installation is complete. Close the Readme file.
1d) From Explorer, go to F:\Off\Offsetup\Sheridan\Data Widgets 2.0a and double-click on “Setup.exe.”
2d) Click “Next” at the Welcome window, select “No” at the View Readme window, and click “Next.”
3d) At the Backup Replaced Files window, select “No” and click “Next.” Click “Start Install.” Close the Readme file.
1e) From Explorer, go to F:\Off\Offsetup\Sheridan\Data Widgets 2.0b and double-click on “Setup.exe.”
2e) Click “Next” at the first two windows. Click “I Agree” to the License Agreement.
3e) Click “Next”, with the user’s FirstName LastName in the User Name field and ACE in the Organization field.
4e) Click “Next” at the Select Destination Directory window and “Yes” in response to the pop-up message.
5e) From Backup Replaced Files, select “No” and “Next.” From Select Components, check ONLY the “32 Bit Components”
checkbox and click “Next.” Click “Start Install” and once complete, click “OK” at all pop-ups. Close the Readme file.
1f) Log out of the computer and log in as (the network) Administrator (other accounts cannot access the Source directory).
2f) From a second copy of Explorer, browse to F:\Source\Office\Existing\Package. Double-click on “Setup.exe.”
Click “OK” at the Office Setup Welcome window.
3f) Click the installation button to install ACE Office and then click “Continue.” Answer “No” in response to ALL of the
Version Conflict pop-ups. After completed, click “OK” and “Ignore” twice at the pop-up Error messages. Click “OK.”
4f) Log out of the computer and log back in as the specific user.
1g) From Explorer, browse to F:\Off\Setup\Report Viewer and double-click on “Setup.exe.”
2g) At the Serial Number and Product Key window, type LGX 00052923 in the Serial Number field,
QVJSHRRD 42 in the Product Key field and click “Next.” Click “Accept” at the License Agreement window.
3g) Click “Next” at the User Information window, with the user’s FirstName LastName in the
Name field and ACE in the Company field. At the Setup Options window, select the “Custom” bullet and click “Next.”
4g) At the ARPEGGIO Viewer window, check all items EXCEPT “Third party components” and click “Next.”
5g) Click “Yes” at the two pop-ups. Click “Next” at the Select Private Directories window and click “Yes” to the pop-up.
6g) After the installation is complete, click “No” to skip the registration process and “No” again to skip over the Readme file.
1h) From the Office Application window, right-click on “Office Application” and select “Copy.” From Explorer, browse to
C:\Documents and Settings\All Users\Desktop, right-click somewhere and “Paste.” Close the Office Application window.
2h) From the Start menu, go to “Settings - > Control Panel.” Double-click to open “Regional and Language Options.”
(NOTE: The following step may vary slightly, depending upon whether the operating system is Windows 2000 or XP.)
3h) From the Regional Options tab of the Regional and Language Options window, click “Customize …”
4h) From the Date tab, change the Short date format drop down menu to “MM/dd/yyyy.” Click “Apply” and then “OK.”
5h) Click “OK” to close the Regional and Language Options window and then click [X] to close the Control Panel window.
6h) Repeat steps 1f – 4f. Close both Explorer windows.
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Testing ACE Office
1)
2)
3)
4)

From the desktop, double-click to open “Office Application.”
From the upper menu of ACE Office, select “Reports” and then click “Report Wizard.”
Select “Auto – Results Report” and click “Next.”
Select “CA STATE AUTO ASSOCIATION” from the Insurance Company drop down menu and “LAS VEGAS DESK”
from the Insurance Office drop down menu. Back up the Start Date 3 or 4 days and click “Next.”
5) Click “Next” and then “Finish” to pull the report.
6) If the report opens properly, click the upper right-hand [X] to close the report viewer window and then click “Cancel.”
Click the upper right-hand [X] to close the ACE Office program and answer “Yes” to the pop-up message.
7) If the report does not open properly, complete the following steps (which are not likely to be necessary):
8) From the Start Menu, select “Settings” and then click “Control Panel.”
9) Double-click to open “Administrative Tools” and then double-click to open “Data Sources (ODBC).”
10) From the User DSN tab, click “Add …” From the menu list, select “Microsoft Access Driver (*.mdb) and click “Finish.”
11) From the ODBC Microsoft Access Setup window, in the Data Source Name field, type Office Database.
12) Click the “Select …” button and browse to F:\Off\Data. Select “office.mdb” and then click “OK” twice.
13) Click “OK” to close the ODBC Data Source Administrator window and then click the upper right-hand [X] to
close the Control Panel.
14) Repeat steps 1 - 6 to re-test the ACE Office program.
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Setting up, Customizing, and Testing an E-mail Account
1. Initial Email Account Setup
1) From the desktop, double-click to open Internet Explorer. Browse to the website http://webmail.mailtrust.com.
2) From the Choose an Account: drop-down menu, select “Control Panel.”
3) In the field beneath the drop-down, type in the administrator username (an IT person’s firstnamelastname).
4) In the field beneath the username field, type in the IT person’s administrator password and then click “Log In.”
5) From the left-hand menu of the Mailtrust control panel, click “Email Accounts.”
6) Next, click the “Mailboxes” link and then the “ace-it.com” domain link.
7) From the mailboxes webpage, click the “Add Mailbox” button.
8) From the Add new mailbox screen, type the new account user’s firstnamelastname in the Mailbox field.
9) Type the user’s password in the Password field, then retype it in the Re-type Password field.
10) Click “Save” to create the new account, then click “Log Out.” Click the upper righthand [X] to close Internet Explorer.
(Complete steps 2, 3 using Outlook Express, Outlook 2000, or Outlook 2003, depending on the version the user is to receive.)

2. Setting up and Customizing the Microsoft Email Program
Setting up and Customizing Microsoft Outlook Express
1) From Explorer, browse to C:\Documents and Settings\user\Start Menu\Programs. Right-click on “Outlook Express and
Select “Copy.” Browse to C:\Documents and Settings\All Users\Desktop. Right-click somewhere and select “Paste.”
2) From the desktop, double-click to open “Outlook Express.”
3) Click “Cancel” at the Startup window and answer “Yes” in response to the pop-up question.
Continue to click “Cancel”, if necessary, until the main Outlook Express window is displayed.
4) From the lower left-hand portion of Outlook Express, click [X] in order to close the Contacts window.
5) Click to highlight “Inbox.” Then, from the upper menu of Outlook Express, select “View -> Layout …”
6) From the Layout Properties window, click to uncheck “Show Preview Pane.” Click “Apply” and then “OK.”
7) From the upper menu of Outlook, select “Tools” and then click “Options …”
8) From the General tab of the Options window, check “When starting, go directly to my ‘Inbox’ folder” and change the
“Check for new messages” time to 10 minutes.
9) From the Security tab, uncheck “Do not allow attachments to be saved or opened…” and “Block images and other
external content in HTML e-mail.” Click “Apply” and then “OK.”
10) From the upper menu of Outlook, select “Tools” and then click “Accounts …” From the All tab, for each account listed,
click to select the account, then click “Remove” in order to remove the account and answer “Yes” at the pop-up window.
11) Click “Close” to close the Accounts window, then click the upper right-hand [X] to close Outlook Express.

Setting up and Customizing Microsoft Outlook (2000) - UNVERIFIED
1) Insert the Microsoft Office 2000 CD into the CD-ROM.
Next, from the desktop, double-click to open “Microsoft Outlook.”
2) Click “Next” at the Startup window and “Next” again at the Email Service Options window with “Internet Only” bulleted.
(NOTE: The following steps will create a dummy account which will later be deleted.)
3) Type ACE in the Display name field and click “Next.” Type x and click “Next”, then answer “Yes” at the pop-up.
4) Type x in the Incoming mail server field and x in the Outgoing mail server field, and then click “Next.”
5) Type x in the Account name field and T in the Password field. Leave “Remember password” checked and click “Next.”
6) Click “Next” with “Connect using my local area network (LAN)” bulleted.
7) Click “Finish” and then “Cancel” at the Symantec Winfax Starter Edition window to complete the setup.
8) Click “Yes” in response to the pop-up message to set Outlook as the default mail manager.
9) From the Microsoft Outlook program window, right-click on the left-hand menu and select “Hide Outlook Bar.”
10) From the upper menu, select “View -> Folder List.” Next, click “View -> Current View” and select “Define Views …”
11) From the Define Views window, with <Current view settings> highlighted, click “Modify ...”
12) Next, click “Other Settings …” and from the Other Settings window, uncheck “Show Preview Pane.”
13) Click “OK” to accept settings changes and then “OK” again.
14) Repeat steps 11 - 13 with “Messages” highlighted, then click “Apply View” to close the Define Views window.
15) From the upper menu of Outlook, select “Tools” and then click “Accounts …”
16) Select the generic account just created and click “Remove.” Answer “Yes” in response to the pop-up message.
17) Click “Close” at the Internet Accounts window and then, from the upper menu, select “Tools” and click “Options …”
18) From the Mail Delivery tab, check “Send messages immediately when connected”
and “Check for new messages every ten minutes.”
19) From the Other tab, click “Advanced options …” Verify that the Startup in this folder drop down menu is set to “Inbox.”
Click “OK” and “OK” again to close Options. Close Outlook, then remove the Office 2000 CD from the CD-ROM.
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Setting up and Customizing Microsoft Outlook (2003)
1) From the desktop, double-click to open “Microsoft Office Outlook.”
2) Click “Next” at the Startup window and “Next” again at the Email Accounts window with “Yes” bulleted.
(NOTE: The following steps will create a dummy account which will later be deleted.)
3) At the Server Type window, select the “POP3” bullet and click “Next.”
4) At the E-mail Settings (POP3) window, type x into the following information fields:
- Your Name, E-mail Address, Incoming mail server, Outgoing mail server, User Name, Password.
5) Click “Next” and answer “No” at the pop-up in order to leave the account settings alone. Next, click “Finish.”
6) Click the upper right-hand [X] to close ANY pop-up failed email notification messages.
7) From the Microsoft Outlook program window, right-click on the left-hand menu and select “Hide Outlook Bar.”
8) From the upper menu of Microsoft Outlook, click “Tools” and then select “Customize …”
9) From the Customize window, check “Always show full menus” and then click “Close.”
10) From the All Mail Folders section of the left-hand menu, click to highlight “Inbox.” From the upper menu of Microsoft
Outlook, select “View -> Arrange By” and then click to uncheck “Show in Groups.”
11) Next, from the upper menu of Microsoft Outlook, select “View -> Reading Pane” and then click “Off.”
12) Repeat steps 10 – 11, highlighting each of the following: “Junk E-mail”, “Outbox”, and “Sent Items” folders.
13) From the upper menu of Outlook, select Tools -> and click “E-mail Accounts …”
14) From the Email Accounts window, click “Next” with “View or change existing e-mail accounts” bulleted.
15) Select the generic account just created and click “Remove.” Answer “Yes” in response to the pop-up message.
16) Click “Close” at the Email Accounts window and then click the upper right-hand [X] to close Microsoft Outlook.

3. Creating / Importing an Email Account into the Microsoft Email Program
Setting up and Testing an Email Account in Microsoft Outlook Express
1) From the desktop, double-click “Outlook Express.” From the upper menu, select “Tools” and then click “Accounts …”
2) From the Mail tab, click “Import …” (NOTE: It is quicker to import an existing account and customize it for a specific
user than it is to create a new account from scratch.) Next, browse to F:\, click on “emailaccount.iaf” and click “Open.”
3) Select the email account listed in the Internet Accounts window and click “Properties.”
4) From the General tab, type the user’s FirstnameLastname@ace-it.com in the Mail Account field.
5) Highlight, then right-click and “Copy” the Mail Account field contents. Right-click and “Paste” it into the Name
and E-Mail address fields (and change the first and last names to LOWERCASE in the E-Mail address field).
Next, highlight, then right-click and “Copy” the contents of the E-Mail address field.
6) Verify “Include this account when receiving mail or synchronizing” is checked.
7) From the Servers tab, verify that the Incoming mail (POP3) field reads pop.emailsrvr.com and the
Outgoing mail (SMTP) reads smtp.emailsrvr.com.
8) From the Account name field, right-click and “Paste” to paste the user’s email address.
Type the user’s email password into the Password field.
9) Beneath the Outgoing Mail Server field, check “My server requires authentication” and then click “Settings …”
From the pop-up Outgoing Mail Server window, click the “Use the same settings as my incoming mail server” bullet.
10) Click “OK.” From the Delivery section of the Advanced tab, check “Leave a copy of messages on server”
and, beneath it, “Remove from server after 5 days.” Click “Apply” and then “OK.”
11) Click “Close” to close the Internet Accounts window and click the upper right-hand [X] to close Outlook Express.
12) Go to the user’s CURRENT station. From the upper menu in Outlook/Outlook Express, click “Tools -> Accounts …”
13) Select the user’s email account in the Internet Accounts window and click “Properties.”
14) From the Advanced tab, uncheck “Leave a copy of messages on server.” Click “Apply” and then “OK.”
15) From the upper menu of Outlook, click “Send/Receive.” The user’s Outlook will delete all existing messages off of the
mail server after it receives new mail. Return to the Account properties, re-check “Leave a copy of messages on server”,
and click “Apply” and then “OK.” Click the upper right-hand [X] to close the user’s Outlook/Outlook Express.
16) Return to the NEW workstation. From the desktop, double-click to open “Outlook Express.”
17) From the upper menu of Outlook Express, click the “Create Mail” button to create a new email message. Type the user’s
email address in the To … field and TEST in the Subject field, and then click “Send.”
18) Next, from the upper menu, click “Send/Receive.” After a time, verify that email sends and then receives properly.
19) Select all email messages then press [SHIFT] + [DELETE] to remove them and click “Yes” at the pop-up (all the user’s
emails will be crossed over from their current system at a later stage (see the step in the deployment procedure)).
20) Click the upper right-hand [X] to close Outlook Express.
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Setting up an Email Account in Microsoft Outlook (2000)
1) From the desktop, double-click to open “Microsoft Outlook.”
2) From the upper menu in Microsoft Outlook, click “Tools” and then select “Accounts …”
3) From the Internet Accounts window, click “Import …” (NOTE: It is quicker to import an existing account and customize
it for a specific user than it is to create a new account from scratch.)
4) Next, browse to F:\, click on “emailaccount.iaf” and click “Open.”
5) Select the email account listed in the Internet Accounts window and click “Properties.”
6) From the General tab, type the user’s FirstnameLastname@ace-it.com in the Mail Account field.
7) Highlight, then right-click and “Copy” the Mail Account field contents. Right-click and “Paste” it into the Name
and E-Mail address fields (and change the first and last names to LOWERCASE in the E-Mail address field).
Next, highlight, then right-click and “Copy” the contents of the E-Mail address field.
8) Verify “Include this account when receiving mail or synchronizing” is checked.
9) From the Servers tab, verify that the Incoming mail (POP3) field reads pop.emailsrvr.com and the
Outgoing mail (SMTP) reads smtp.emailsrvr.com.
10) From the Account name field, right-click and “Paste” to paste the user’s email address.
Type the user’s email password into the Password field.
11) Beneath the Outgoing Mail Server field, check “My server requires authentication” and then click “Settings …”
From the pop-up Outgoing Mail Server window, click the “Use the same settings as my incoming mail server” bullet.
12) Click “OK.” From the Delivery section of the Advanced tab, check “Leave a copy of messages on server”
and, beneath it, “Remove from server after 5 days.” Click “Apply” and then “OK.”
13) Click “Close” to close the Internet Accounts window and click the upper right-hand [X] to close Microsoft Outlook.
14) Go to the user’s CURRENT station. From the upper menu in Outlook/Outlook Express, click “Tools -> Accounts …”
15) Select the user’s email account in the Internet Accounts window and click “Properties.”
16) From the Advanced tab, uncheck “Leave a copy of messages on server.” Click “Apply” and then “OK.”
17) From the upper menu of Outlook, click “Send/Receive.” The user’s Outlook will delete all existing messages off of the
mail server after it receives new mail. Return to the Account properties, re-check “Leave a copy of messages on server”,
and click “Apply” and then “OK.” Click the upper right-hand [X] to close the user’s Outlook/Outlook Express.
18) Return to the NEW workstation. From the desktop, double-click to open “Microsoft Outlook.”
19) From the upper menu of Outlook, click “New” to create a new email message. Type the user’s email address
in the To … field and TEST in the Subject field, and then click “Send.”
20) From the upper menu of Outlook, click “Send/Receive.” After a time, verify that email sends and then receives properly.
21) Select all email messages then press [SHIFT] + [DELETE] to remove them (because all of the user’s emails will be
crossed over from their current system at a later stage (see the step in the deployment procedure)).
22) Click the upper right-hand [X] to close Outlook.

Setting up an Email Account in Microsoft Outlook (2003)
1)
2)
3)
4)
5)

From the desktop, double-click to open “Microsoft Office Outlook.”
From the upper menu in Microsoft Outlook, click “Tools” and then select “E-mail Accounts …”
From the E-mail Accounts window, select the “Add a new e-mail account” bullet and then click “Next.”
At the Server Type window, select the “POP3” bullet and click “Next.”
At the E-mail Settings (POP3) window, type the following information into the following fields:
- The user’s FirstnameLastname@ace-it.com in the Your Name field.
- The user’s firstnamelastname@ace-it.com (first and last names in LOWERCASE) in the E-mail address field.
- pop.emailsrvr.com in the Incoming mail server field.
- smtp.emailsrvr.com in the Outgoing mail server field.
- The user’s firstnamelastname@ace-it.com (first and last names in LOWERCASE) in the User Name field.
- The user’s email password in the Password field.
6) Next, click “More Settings …” From the General tab of the Internet Mail Settings window, type the user’s
FirstnameLastname@ace-it.com in the Mail Account field.
7) From the Outgoing Server tab, check the “My outgoing server (SMTP) requires authentication” checkbox and verify
that “Use same settings as my incoming mail server” is bulleted.
8) From the Advanced tab, check “Leave a copy of messages on the server” and, beneath it, “Remove from server
after 5 days.” Click “OK.”
9) Next, from the E-mail Accounts window, click “Test Account Settings …” From the pop-up Test Account Settings
window, verify that all accounts tested successfully. Click “Close” and then click “Next” and “Finish.”
10) Select all email messages then press [SHIFT] + [DELETE] to remove them (because all of the user’s emails will be
crossed over from their current system at a later stage (see the step in the deployment procedure)).
11) Click the upper right-hand [X] to close Microsoft Outlook.

7

4. Increasing Security Measures within Outlook (to Reduce the Threat of Viruses)
(NOTE: This procedure is NOT necessary for workstations with Outlook Express.)
1) From the desktop, double-click to open the user’s Outlook program.
2) From the upper menu of the Outlook program, select “Tools” and then click “Options …”
3) From the Security tab, within the Zone: field, change the setting to “Restricted Sites.”
4) Click on “Zone Settings …” and then click “OK” in response to the pop-up warning message.
5) From the Security window, click on “Custom Level …”
6) From the Security Settings window, re-set the bullets under the listed headings as follows:
(NOTE: The headings listed will vary, depending upon whether the OS installed is Windows 2000 or XP.)
- Allow per-session cookies (not stored) = Enable
- Font download = Disable
- Java permissions = High Safety
- Access data sources across domains = Enable
- Drag and drop or copy and paste files = Disable
- Launching programs and files in an IFRAME = Enable
- Navigate sub-frames across different domains = Enable
- Submit nonencrypted form data = Enable
7) Click “OK” and then “Yes” in response to the pop-up message to accept settings changes. Next, click “OK” twice.
8) Click the upper right-hand [X] to close the user’s Outlook program.
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Additional Setup Procedures for a CSAA Auditor Workstation
1. Setting up the Default Program for Photo Viewing
NOTE: This step is not necessary for workstations installed with the Windows XP operating system.
1) From Explorer, browse to (the mapped server1\files drive)\CSAA Photos. Scroll down to “Copy of acenote.jpg”, rightclick on it, and select “Open With …”
2) From the Open With window, click to highlight “Imaging.”
3) Check the “Always use the selected program to open this kind of file” checkbox and then click “OK.”

2. Setting up Access to the CSAA Photos Folder
1) From Explorer, browse to F:\Data\Shortcuts. Right-click on “CSAA Photos” and select “Copy.”
2) From a second copy of Explorer, browse to C:\Documents and Settings\All Users\Desktop.
Right-click somewhere and select “Paste.”

3. Setting up a Default Photo Viewer
1) From the desktop, double-click to open the newly pasted “CSAA Photos.”
Scroll to the bottom of the CSAA Photos Explorer window and locate “Copy of acenote.jpg.”
2) Right-click on “Copy of acenote.jpg” and select “Open With” and then click “Choose Program …”
3) From the Programs list of the Open With window, select “Windows Picture and Fax Viewer” and then click “OK.”
NOTE: The Windows Picture and Fax Viewer program is ONLY available with the Windows XP operating system.
4) Verify that the photo pulls successfully into the Windows Picture and Fax Viewer program.
5) Click the upper right-hand [X] to close the Windows Picture and Fax Viewer program and then close Explorer.

4. Setting up Access to the CSAA Labor Rates Program
1) From the first copy of Explorer, browse to F:\Data\Shortcuts. Right-click on “CSAA Labor Rates” and select “Copy.”
2) From the second copy of Explorer, browse to C:\Documents and Settings\All Users\Desktop.
Right-click somewhere and select “Paste.” Close the second Explorer window.
3) From the desktop, double-click to open “CSAA Labor Rates.”
4) From the City drop down list of the CSAA Labor Rates program, select ANY city. Verify data pulls properly into the
Shop Rates fields and then click the upper right-hand [X] to close the CSAA Labor Rates program.

5. Setting up the NuGen Compliance Tool
1) From Explorer, browse to F:\Data\First Entry\CSAA-NuGen\NuGenCompliance and then double-click to open
“Compliance281Full.exe.”
2) Click “Next” at the Setup window and “Next” again to begin the installation.
3) Once the installation is complete, click “Finish.”
4) From the Start Menu, click “Shut Down …” and click “OK” with “Shut down” selected.
5) Turn on the system’s power. Once Windows is up, login to the system locally as the auditor.
6) From the right-hand corner of the Windows toolbar, double-click on the hammer icon to open the Compliance Tool.
7) From the upper menu of the Compliance Tool, click the Configuration tab.
8) Next, click the “Add” button. Browse to C:\Cieca\Mitchell\Export and click “OK.”
9) The path will now appear in the EMS Estimate locations field. Click “Save Configuration.”
10) Click the upper right-hand [X] and answer “No” at the pop-up to close the Compliance Tool.

6. Testing the NuGen Compliance Tool
1) Perform this step later, when deploying the workstation. (See the Testing the NuGen Compliance Tool step in the
Deploying an ACE Workstation procedure.)
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Installing and Customizing Audatex PenPro
1. Audatex PenPro Printer and Generic Printer Setups
1) See steps in the Setting up a Local or Network Printer procedure.

2. Audatex PenPro Installation
1)
2)
3)
4)

Retrieve the latest PenPro Software and Vehicle Data update DVD from the IT cabinet/closet, then go to the ACE server.
Insert the PenPro DVD into the server’s DVD-ROM drive. Return to the new auditor workstation.
From the upper menu of Explorer, click “Tools” and then “Map Network Drive …”
From the Map Network Drive window, type \\server1\cd in the Folder field, uncheck “Reconnect at logon”,
and click “Finish.”
5) From the pop-up Explorer window, double-click to open the “install” and then the “pplite” folder.
Double-click to open “setup.exe.”
6) Click “Next” at the PenPro Setup window and then click “Next” with “Copy all vehicles to my hard disk” bulleted.
7) Click “Continue” at any pop-up messages in order to install Audatex PenPro.
8) Once the program update is finished, a “Load Data” pop-up button will appear. Click the button in order to install
updated database information.
9) Once the data installation is complete, click “Finish”, then click the upper right-hand [X] to close Explorer.
10) Physically go to the ACE server and retrieve the PenPro DVD, then return it to the IT cabinet/closet.

3. Auxatex PenPro Customization
1) From the desktop, double-click to open “PenPro.” Click “OK” at the login window.
2) From the ID [-New User-] window, type ACE in the Signon Name field. Leave Password blank. Click the “Add” button.
3) From the Add/Edit PenPro ID window, for all IDs to be set up:
- Type the ID provided by the client in the PenPro ID field.
- In the Description field, type in descriptive regional/office information for the company’s office ID.
- Click “OK”, leaving the Password field blank (unless the company supplies a password).
For Example, HoraceMann IDs and Descriptions are set to the following:
- #1: 261E1042436 , HMANN-EAST
- #2: 261W1042436 , HMANN-WEST
4) Once all necessary IDs have been entered, click the “Confirm” button.
5) Click “Confirm” again with “New IDs” bulleted. The Communication Results window will pop-up and a connection
to the Audatex Host will be established, in order to set up the new IDs.
6) Once ID verification has finished, click “Return to PenPro.” The ID Setup window will reemerge.
7) Click the Audatex logo in the upper left-hand corner of the window, then select to uncheck “Pen tools.”
Once again, click on the Audatex logo and select “Save” in order to save changes.
8) Click the upper right-hand [X] in order to close the Setup window. Answer “Yes” in response to the pop-up.
9) Click “OK” to log in to Audatex PenPro and verify that all new IDs appear in the upper right-hand drop down menu.
10) Next, click “Receive …” From the Where drop down menu of the Receive window, select “CIECA.”
11) Click “Browse …” From the pop-up, browse to C:\ADP\Cieca and click “OK” to re-path the import directory.
12) Click “Done” and then click the upper right-hand [X] to close the PenPro claims window. Answer “Yes” at the pop-up
and click “Exit PenPro” to close Audatex PenPro.

4. Setting up Audatex PenPro Files to Copy over to the Network
1) From Explorer, browse to F:\Data\Shortcuts.
2) Right-click on “ADPback” and then select “Copy.”
3) Next, browse to C:\Documents and Settings\All Users\Start Menu\Programs\Startup. Right-click and “Paste.”
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Installing and Testing MSB IntegriClaim
NOTE: Before re-installing, back up IntegriClaim data, scan for errors, and create a temp copy of the “Public:\DDS” folder.
Also, make certain that no one is in the IntegriClaim program before performing any installations of the software.

1. MSB IntegriClaim Re-installation
MSB IntegriClaim Re-installation
1)
2)
3)
4)
5)
6)

Physically go to the server closet and insert the MSB IntegriClaim installation CD into the server’s CD-ROM drive.
Physically go to one of the 6 property workstations.
Open Windows Explorer. Type \\server1\CD in the Address field and press [ENTER].
From the pop-up copy Windows Explorer, browse to the D:\ drive and double-click to open “ICInst.exe.”
Click “Next” at the Welcome window.
At the Select Installation Type window, select the “Network – Workstation Only” bullet and click “Next.”
(NOTE: If this is the FIRST installation of IntegriClaim on any system, select “Network – Data and Workstation” bullet.)
7) Click “Next” at the Enter Installation Code dialog box, leaving the code field empty.
8) Click “Next” at the Select Program Directory.
9) From the Data Directory window, click “Browse …” Browse to F:\DDS\Data, then click “OK” followed by “Next.”
10) Click “Next” at the Select BDE Directory window and “Next” again at the Ready to Install window to begin installation.
11) Click “Finish” upon installation completion and click “OK” in response to the pop-up message.
12) Click “OK” in order to restart the system. Logon to the system as the Auditor.

MSB IntegriClaim Setup upon Re-installation
1)
2)
3)
4)
5)
6)
7)
8)

From the desktop, double-click to open “MSB IntegriClaim” (after ALL IntegriClaim users are out of the program).
Click “OK” in response to the error message stating that MSB has reached its maximum user allowance.
From the Directory Login window, under “Login as …”, select the specific user from the drop down list and click “OK.”
From the main screen of MSB, go to the upper menu and click “Help -> Register Software.”
Now, call MSB Support (888-337-9667) to (re)activate user accounts, reading information from the Registration window.
Once call has been conducted, click the upper right-hand [X] to close MSB IntegriClaim. Next, reopen the program.
From the upper menu of IntegriClaim, click “Options” and then select “Preferences …”
From the Banner tab of the User Preferences window, check “Always Use “Advanced” for New Claims.”
Uncheck ALL other checkboxes.
9) From the Defaults-1 tab, select “DDS Residential and Commercial” at both the Main DB Default and the Contents DB
Default drop-down menus. Next, check the “ZIP/Postal Based” checkbox (located to the right of Region DB).
10) Click “Save” in order to save changes.
11) Next, click “Claims.” From the search list, double-click to open a specific claim in order to verify it pulls open properly.
12) Once again, click the upper right-hand [X] to close IntegriClaim.

2. MSB IntegriClaim Installation Upgrade from a Previously Installed Version
MSB IntegriClaim Upgrade Installation
1) Physically go to the server closet and insert the MSB IntegriClaim installation CD into the server’s CD-ROM drive.
2) Physically go to one of the 6 property workstations.
3) Open Windows Explorer. Type \\server1\CD in the Address field and press [ENTER].
4) From the pop-up copy Windows Explorer, browse to the D:\ drive and double-click to open “ICInst.exe.”
5) Click “Next” at the Welcome window.
6) At the Select Installation Type window, select the “Network – Data and Workstation” bullet and click “Next.”
7) Click “Next” at the Enter Installation Code dialog box, leaving the code field empty.
8) Click “Next” at the Select Program Directory.
9) Click “Next” at the Select BDE Directory window.
10) Click “Next” at the Ready to Install dialog box to begin installation.
11) Click “Finish” upon installation completion and click “OK” in response to the pop-up message.
12) Click “OK” in order to restart the system. Logon to the system as the Auditor.
13) Repeat steps 3 - 12 for the other 5 property workstations, clicking “Network – Workstation Only” bullet at step 6 for all.

MSB IntegriClaim Setup upon Upgrade Installation
NOTE: IntegriClaim Setup steps should NOT be necessary for upgraded property workstations. Preferences should migrate
over from the previously installed version of IntegriClaim.
1) From the desktop, double-click to open “MSB IntegriClaim” (after ALL IntegriClaim users are out of the program).
2) Wait a few minutes for IntegriClaim to verify the table structures.
3) Click “No” at the pop-up, in order to skip importing system data and then click to exit MSB IntegriClaim.
4) To ensure ACE property apps still function upon upgrade, open a closed (but not cancelled) file in IntegriClaim, make a
change and save changes, then run the property import program - verifying that the altered file appears in the import list.
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Installing and Testing the Conversion Program
1. Installing the New Process Conversion Program
1) Log out of the computer and log in as (the network) Administrator (other accounts cannot access the Source directory).
2) From Explorer, browse to F:\Source\Setups\SetupConversion and double-click
to open “setup.exe.”
3) Click “OK” at the Conversion Setup pop-up window.
4) Click the large button to begin the installation.
5) Click “Yes” in response to all of the version conflict pop-up messages.
6) Once the installation is complete, click “OK” in response to the pop-up message.
7) Log out of the computer and log back in as the specific user.
8) From Explorer, browse to F:\Data\Shortcuts. Right-click on “New Process” and select “Copy.”
9) From a second copy of Explorer, browse to C:\Documents and Settings\All Users\Desktop.
Right-click somewhere and select “Paste.”
10) Return to the first copy of Explorer. Right-click on “CARS.ICO” and select “Copy.”
11) Browse to C:\Program Files\conversion, then right-click somewhere and select “Paste.”
12) Click the upper right-hand [X] to close one of the copies of Explorer.
13) From the desktop, right-click on “New Process” and select “Properties.”
14) From the Shortcut tab, click “Change Icon ...” From the Change Icon window, click “Browse …”
Browse to C:\Program Files\conversion, select “CARS.ICO” and then click “Open” and then “OK.”
15) Click “Apply” and then “OK” to close the New Process Properties window.

2. Installing the Active Reports Program
1)
2)
3)
4)
5)
6)

From Explorer, browse to F:\Data\First Entry\Conversion\ARUpdate and double-click to open “ArStdSP2.4.1.1283.exe.”
Click “Next” at the Welcome window.
Click “Accept” at the License Agreement window.
Click “Next” in order to begin the installation.
Click “Finish” once the installation has finished.
Click the upper right-hand [X] to close Explorer.

3. Transaction Report Printer Setup
1) See step in the Setting up a Local or Network Printer procedure.
NOTE: The printer must be named CS-TransRpt (not CS-TransRpt on Server1) in order for the New Process program
to function properly.

4. Testing the New Process Conversion Program
(To be done at night, when noone in Clerical is utilizing the program.)
1) From the desktop, double-click to open “New Process.”
2) Click the “Start” button and verify that the program message text displays “Scanning network for claims to process.”
3) From the desktop, double-click to open “Shortcut to clerical.”
4) Open a test file in Clerical, make a change to it, and then close it.
5) Click the upper right-hand [X] to close Clerical.
6) From New Process, verify that the closed file properly processes.
7) Click the upper right-hand [X] to close the New Process Program.
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Installing and Testing the Specialty and Property Reports Programs
1. Setting up the Specialty Printer OR Property Printer
1)
2)
3)
4)

From the Start Menu, click on “Settings” and then click “Printers and Faxes.”
From the Printers and Faxes window, verify that “Specialty Printer on server1” appears.
If not, set up the printer (see the Setting up a Local or Network Printer procedure).
Click the upper right-hand [X] to close the Printers and Faxes window.

2. Transferring Microsoft Spell Checker/Auto Correct Files
(NOTE: The following steps are ONLY necessary to complete for property and subrogation auditors.)
1) Go to the auditor’s CURRENT workstation and open Explorer.
2) From Explorer, browse to C:\Windows and then double-click to open “registry.exe.”
3) From the left-hand menu in Registry Editor, browse to HKEY_CURRENT_USER\SOFTWARE\Microsoft\Office\8.0\
\Common\ and click on “AutoCorrect.” NOTE: The path of the AutoCorrect folder may vary slightly, depending upon
what operating system and Microsoft Office utilities are installed on the workstation.
4) From the right-hand menu, look at the item labeled “Path” to determine the auditor’s default .acl autocorrect file.
5) Click the upper right-hand [X] to close the Registry Editor.
6) From Explorer, click the “Type” tab to organize files by type. Browse to locate ALL listed .acl file(s). Right-click on
the auditor’s default .acl file and select “Copy.” Next, click the “Name” tab to reorganize files by name.
7) From a second copy of Explorer, browse to F:\. Create a folder on the network F:\ drive named _temp. Double-click to
open “Temp”, then right-click somewhere and select “Paste” to paste the default .acl file in the folder.
8) Return to the NEW workstation. From Explorer, browse to F:\_temp. Right-click on the .acl file(s) and select “Copy.”
Browse to C:\Windows, right-click and “Paste.” Answer “Yes” at the pop-up. Browse to F:\ and delete “_temp.”

3. Installing Access Runtime
NOTE: If the system DOES NOT have Microsoft Access installed, install Access Runtime
1) From the Start Menu, select “Shut Down …” From the pull-down menu, select Log off (user) and click “OK.”
2) Logon to the system as the Administrator. If necessary, uncheck “Show this screen at startup” and click “Exit.”
3) From Explorer, go to F:\Source\AccessRuntimeInst\Compnet and double-click to open “Setup.exe.”
4) Click “Continue” at the Access Runtime Welcome window.
5) Click “OK” and then “Custom” for custom setup.
6) Click “Continue” with all four options checked to begin installation. Click “OK” at the installation successful pop-up.
7) From Explorer, browse up to F:\Source\AccessRuntimeInst. Right-click on System.mdw and select “Copy.”
8) Browse to C:\Windows\System32, right-click somewhere and then select “Paste.” Close Explorer.
9) From the Start Menu, select “Shutdown … -> Log off administrator.” Logon to the system as the Auditor.

4. Installing and Testing Specialty and/or Property Reports
Installing Specialty Reports
1) From Windows Explorer, for systems containing Microsoft Access:
- Browse to F:\Data\Shortcuts\Specialty Reports Shortcuts. Right-click on “Specialty Reports” and select “Copy.”
For systems containing Access Runtime:
- Browse to F:\Data\Shortcuts\Specialty Reports Shortcuts\Runtime. Right-click “Specialty Reports” and “Copy.”
2) Browse to C:\Documents and Settings\All Users\Desktop. Right-click somewhere and select “Paste.”
3) Next, browse to F:\Data\ACCESS\Specialty\Tools. Right-click “SUBRO97.ico” and then select “Copy.”
4) From a second copy of Explorer, browse to C:\Windows, right-click somewhere and select “Paste” to paste the file.
Click the upper right-hand [X] to close the second copy of Explorer.
5) From the desktop, right-click on “Specialty Reports” and select “Properties.”
6) From the Shortcut tab, click “Change Icon …” Click “OK” in response to the pop-up message.
7) From the Change Icon window, click “Browse …” Browse to C:\Windows, select “SUBRO97.ico”, and click “Open.”
8) Click “OK.” Next, click “Apply” and then “OK” to set the Specialty Report icon.
NOTE: If Specialty and/or Property Reports programs are being set up is a Windows 2000 PC, complete the following:
9) From the Start Menu, browse to Settings and then click to open “Control Panel.”
10) From the Control Panel, double-click to open “Fonts.”
11) From the upper menu of the Fonts window, select File -> “Install New Font …”
12) From the Add Fonts window, from the Drives: pulldown menu, select “f:\\server1\public.”
From the left-hand Folders menu, double-click to open the “Data” folder. Next, open the “ACCESS” folder, then
“Specialty”, and then finally the “Fonts” folder. Four fonts will automatically appear in the List of Fonts: menu window.
13) Click to highlight all four fonts and then click “OK” in order to install the fonts on the system.
14) Click the upper right-hand [X] in order to close the Fonts window.
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Testing Specialty Reports
1) From Explorer, browse to F:\Data\ACCESS\Specialty\Tools and double-click to run “Shortcut to InitSpecialty.exe”
Double-click to run the file a second time and, if necessary, click “OK” at the pop-up.
2) From the Specialty Reports program window, click “Exit Specialty Reports” and then close Explorer.
3) From the desktop, double-click to open “Specialty Reports.” From Specialty, click “Go to Subrogation Reports.”
4) Click “Print a Subrogation Report.” From the Print a Report window, type 497031 and click “OK” to pull the file.
5) Verify that the file pulls up in Active Reports viewer. From the viewer, click “Print” to print the file and then “Close.”
If the Active Reports viewer does not pull a file properly:
- From Explorer, go to C:\Program Files\ACE\Common.
- From the Start menu, select “Programs -> Accessories” and click to open “Command Prompt.”
- From the prompt, navigate to C:\Program Files\ACE\Common and then type regsvr32 /u specrptctrl.ocx.
- From Explorer and delete the file “specrptctrl.ocx.” Browse to F:\Data\First Entry\Specialty\RptControl4Access.
Copy “specrptctrl.ocx” and paste it into C:\Program Files\ACE\Common. Close Explorer.
- From the Command Prompt, type regsvr32 specrptctrl.ocx. Close the Command Prompt.
6) Retrieve the test print-out from the Specialty printer.
7) For auditor workstations, from the upper left-hand corner of the Specialty Reports program, click the “Auto” button.
Verity that the auditor’s autocorrect .acl file pulls properly into the AutoCorrect window and then click “Cancel.”
8) If the retrieved print-out looks correct, click the upper right-hand [X] to close Specialty Reports.

Installing Property Reports
1) From Windows Explorer, for systems containing Microsoft Access:
- Browse to F:\Data\Shortcuts\Specialty Reports Shortcuts. Right-click on “Property Reports” and select “Copy.”
For systems containing Access Runtime:
- Browse to F:\Data\Shortcuts\Specialty Reports Shortcuts\Runtime. Right-click “Property Reports” and “Copy.”
2) Browse to C:\Documents and Settings\All Users\Desktop. Right-click somewhere and select “Paste.”
3) Next, browse to F:\Data\ACCESS\Property. Right-click on “property.ico” and then select “Copy.”
4) Browse to C:\Windows, right-click somewhere and select “Paste” to paste the file.
5) From the desktop, right-click on “Property Reports” and select “Properties.”
6) From the Shortcut tab, click “Change Icon …” Click “OK” in response to the pop-up message.
7) From the Change Icon window, click “Browse …” Browse to C:\Windows, select “property.ico”, and click “Open.”
8) Click “OK.” Next, click “Apply” and then “OK” to set the Property Report icon.

Testing Property Reports
1)
2)
3)
4)

From the desktop, double-click to open “Property Reports.”
Click “Print a Property Report.” From the Print a Report window, type A04C32456 and click “OK” to print a test page.
Retrieve the test print-out from the Specialty printer.
If the retrieved print-out looks correct, click the upper right-hand [X] to close Property Reports.
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Installing, Updating, and Customizing Microsoft Office
(Complete one of the following steps, depending upon which version of Office is to be installed.)

1. Microsoft Office 97
Installing Microsoft Office 97
1) Insert a Microsoft Office 97 CD into the CD-ROM. At the Microsoft Office 97 window, click “Install Microsoft Office.”
2) Click “Continue” at the Welcome to Microsoft Office 97 Installation window.
3) At Name Information, type the designated user’s FirstName LastName in the Name field, ACE in the
Organization field, and click “OK.” Click “OK” to confirm the name information.
4) Type 8067-2112492 in the 11-digit CD Key field and click “OK.” Click “OK” again to accept the Product ID listed.
5) Click “Change Folder …” In the Path field of the Change Folder window, type
C:\Program Files\Microsoft Office 97 and click “OK.”
6) Click “Yes” to create the new folder, and click “OK” to install to this location.
7) Click on the “Custom” button, and from the Microsoft Office 97 – Custom installation window, click “Select All.”
8) Uncheck Microsoft Binder, Microsoft Excel, Microsoft Word, Microsoft PowerPoint, Microsoft Outlook, Web Page
Authoring (HTML), Microsoft Bookshelf Basics, Converters and Filters, and Getting Results Book. Click “Continue.”
(NOTE: The purpose of installing Microsoft Office 97 is simply to set up Access 97 and its components on a system.
The user will receive a newer version of all other Office products.)
9) Type Microsoft Office 97 in the Program Group field and click “Continue” to install Microsoft Office 97.
10) Click “OK” once the installation is complete.
11) Click the upper right-hand [X] to close the Microsoft Office 97 window and then remove the CD from the CD-ROM.

Testing and Customizing Microsoft Office 97
1)
2)
3)
4)
5)
6)
7)

From the Start menu, select “Programs -> Microsoft Access 97 -> Microsoft Access.”
Click “Start using Microsoft Access.” A Microsoft Access database window will pop up.
Right-click on the cartoon paper clip (otherwise known as the Microsoft Assistant) and select “Options ...”
From the Options tab, uncheck “Respond to F1 key” and click “OK.” Click on the [X] to close the Microsoft Assistant.
From the database list in the Microsoft Access window, select the “Northwind” database and click “OK.”
Click “OK” at the Northwind window. Next, from the Tables tab, double-click to open any database table listed.
Verify that the database opens properly and then click the upper right-hand [X] to close the Microsoft Access window.

2. Microsoft Office 2000
Installing Microsoft Office 2000
1) Insert a Microsoft Office 2000 CD into the CD-ROM. The CD should run automatically.
2) At the Welcome to Microsoft Office 2000 window, verify that the designated user’s FirstName LastName appears in the
User name field and ACE in the Organization field. Type the license # (on the CD) in the CD key field and click “Next.”
3) Click the “I accept …” bullet to agree to the License Agreement and click “Next.”
4) Click the “Customize …” button. Click “Next” to install Office 2000 to C:\Program Files\Microsoft Office.
5) Check “Keep these programs” (Access 97) and click “Next.” (This will not be available if Access 97 was not installed.)
6) Click on the icon next to Microsoft Office and select “Run all from My Computer.” (All icons will change to white.)
7) Click on the icon next to Microsoft Access and select “Not Available.” Click “Install Now.”
8) After installation, click “OK” at the pop-up window.

Updating Microsoft Office 2000
1)
2)
3)
4)

From the desktop, double-click to open “Internet Explorer.” From Internet Explorer, go to http://www.microsoft.com.
From the left-hand column of the Microsoft home page, click the “Office Update” link.
From the Office Update web page, click “Check for Updates.” Click through several messages to retrieve the update list.
Once the update list web page loads, click “Agree and Install.” Click through several messages in order to retrieve
the updates. Updates will now download and install (allow time).
5) Once the updates are completed, click “Yes” in order to reboot the workstation.
6) Once Windows is up, login as the user.
7) Repeat steps 1 - 4.
8) Once additional updates are completed, click “Finish.”
9) Click the “check for Updates that I still need to install” link.
10) Repeat step 4. Once additional updates are completed, click “Finish.”
11) Repeat steps 2 – 4, followed by 8, until all updates are installed (the website will indicate all products are up-to-date).
12) Close Internet Explorer and remove the Microsoft Office 2000 CD from the CD-ROM.
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Testing and Customizing Microsoft Office 2000
1) From Explorer, browse to C:\Documents and Settings\All Users\Start Menu\Programs. Right-click all installed Office
program shortcuts (except “Microsoft Outlook”) and select “Copy.”
Browse to C:\Documents and Settings\All Users\Desktop. Right-click somewhere and select “Paste.” Close Explorer.
2) From the desktop, double-click to open “Microsoft Word.”
3) Right-click on the cartoon paper clip (otherwise known as the Microsoft Assistant) and select “Options.”
4) From the Options tab, uncheck “Use the Office Assistant” and click “OK.”
5) Click the “Start using Microsoft Word” button and then “Accept” at the pop-up.
6) From the upper menu of Microsoft Word, click “Tools” and then select “Customize …”
7) From the Customize window, uncheck both “Menus show recently used commands first”
and “Standard and Formatting toolbars share one row.” Click “Close.”
8) From the upper menu of Word, click “File” and then select “Page Setup ...”
9) From the Page Setup window, set all margins to 1” (except Gutter). Click “Default …” and answer “Yes” at the pop-up.
10) From the upper menu of Word, click “Format” and then select “Font …”
11) From the Font drop down menu, select “Arial.” Click “Default …” and answer “Yes” at the pop-up.
12) From the upper toolbar menu of Word, change the zoom drop down from 100% to “Page Width.”
13) Click the upper right-hand [X] to close Microsoft Word and answer “No” to any pop-ups.
14) From the desktop, double-click to open “Microsoft Excel.”
15) From the upper menu of Microsoft Word, click “Tools” and then select “Customize …”
16) From the Customize window, uncheck “Standard and Formatting toolbars share one row” and then click “Close.”
17) Click the upper right-hand [X] to close Microsoft Excel.
18) If necessary, from the desktop, double-click to open “Microsoft PowerPoint.” From the pop-up window, click “OK”
with “Blank presentation” bulleted and then click “OK” again. Verify that the program works properly, then click the
upper right-hand [X] to close Microsoft PowerPoint.

3. Microsoft Office 2003
Installing Microsoft Office 2003
1) Insert a Microsoft Office XP CD into the CD-ROM. The CD should run automatically.
2) At the Microsoft Office Product Key window, type in the Office XP license # (found on the CD cover) and click “Next.”
3) From the User Information window, Enter the user’s FirstName LastName in the User name field, Initials in the
Initials field, and ACE in the organization field, then click “Next.”
4) From the Type of Installation window, click the “Custom Install” bullet and click “Next.”
5) Check the checkbox beside ALL Microsoft Office programs to be installed and click “Next.”
6) Click “Install” in order to install Microsoft Office.
7) At the Setup Completed window, verify that BOTH checkboxes are unchecked and click “Finish.”

Updating Microsoft Office 2003
1)
2)
3)
4)
5)
6)
7)
8)

From the desktop, double-click to open “Internet Explorer.” From Internet Explorer, go to http://www.microsoft.com.
From the lefthand column of the Microsoft home page, click the “Office Update” link.
From the Office Update web page, click “Check for Updates.” Click through several messages to retrieve the update list.
Once the update list web page loads, click “Agree and Install.” Updates will now download and install (allow time).
Once the updates are completed, from the Installation Result window, click “Finish.”
From the following window, click “Check for updates that I still need to install.”
Repeat steps 4 - 6, until all updates are installed (the website will indicate all products are up-to-date).
Click the upper right-hand [X] to close Internet Explorer.
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Testing and Customizing Microsoft Office 2003
1) From Explorer, browse to C:\Documents and Settings\All Users\Start Menu\Programs and double-click
to open the “Microsoft Office” folder. Right-click all installed Office program shortcuts and select “Copy.”
Move up one directory level. Right-click somewhere and select “Paste.”
Browse to C:\Documents and Settings\All Users\Desktop. Right-click somewhere and select “Paste.” Close Explorer.
2) From the desktop, double-click to open “Microsoft Office Word 2003.”
3) Click the “Accept” button to accept the License Agreement terms.
4) From the pop-up Activation Wizard window, click the “I want to activate over the Internet” bullet and then click “Next.”
Once windows activates, from the following window, click “Close.”
5) From the upper menu of Microsoft Word, click “Tools” and then select “Customize …”
6) From the Customize window, check “Always show full menus” and “Show Standard and Formatting toolbars on 2 rows.”
7) Click “Close.” Next, from the upper menu of Microsoft Word, click “Tools” and select “Options …”
8) From the View tab of the Options window, uncheck “Startup Task Pane” and then click “OK.”
9) From the upper menu of Word, click “File” and then select “Page Setup.”
10) From the Page Setup window, set all margins to 1” (except Gutter). Click “Default …” and answer “Yes” at the pop-up.
11) From the upper menu of Word, click “Format” and then select “Font …”
12) From the Font drop down menu, select “Arial.” Click “Default …” and answer “Yes” at the pop-up.
13) From the upper toolbar menu of Word, change the zoom drop down from 100% to “Page Width.”
14) Close Microsoft Word and answer “No” to any pop-ups.
15) From the desktop, double-click to open “Microsoft Office Excel 2003.”
16) From the upper menu of Microsoft Word, click “Tools” and then select “Customize …”
17) From the Customize window, check “Show Standard and Formatting toolbars on 2 rows” and then click “Close.”
18) Next, from the upper menu of Microsoft Word, click “Tools” and select “Options …”
19) From the View tab of the Options window, uncheck “Startup Task Pane” and then click “OK.” Close Microsoft Excel.
20) If necessary, from the desktop, double-click to open “Microsoft PowerPoint.” From the pop-up window, click “OK”
with “Blank presentation” bulleted and then click “OK” again. Verify that the program works properly, then click the
upper right-hand [X] to close Microsoft PowerPoint.
21) Remove the Office 2003 CD from the CD-ROM drive.

4. Installing the Microsoft Office 2007 Compatibility Pack
1) From Windows Explorer, type \\SERVER1\FILES\Disks\Microsoft\Off2007 Compatibility in the address bar
and then press [ENTER].
2) Double-click to open “FileFormatConverters.exe.”
3) From the Compatibility Pack window, check the “I accept” checkbox and then click “Continue” in order to install.
4) Click “OK” in response to the “Installation is complete” pop-up message window.
5) Click the upper right-hand [X] to close Windows Explorer.
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Installing and Testing Excel and Word Viewers
1. Installing and Testing Microsoft Excel Viewer
Installing Microsoft Excel Viewer
1)
2)
3)
4)
5)

From Explorer, browse to (the mapped server1\files drive)\Disks\Microsoft\Viewers.
Double-click to open “xlviewer.exe.”
From the Microsoft Office Excel Viewer 2003 window, check the “I accept…” checkbox and click “Next.”
Click “Install” to install the Excel Viewer and then click “OK” once the installation is finished.
From Explorer, browse to C:\Documents and Settings\All Users\Start Menu\Programs, right-click on
“Microsoft Office Excel Viewer 2003” and then click “Rename.” Type Excel Viewer and press [ENTER] to rename.
6) Right-click on “Excel Viewer” and select “Copy.”
7) Browse to C:\Documents and Settings\All Users\Desktop, right-click somewhere and select “Paste.”
8) Click the upper right-hand [X] to close Explorer.

Testing Microsoft Excel Viewer
1) From the desktop, double-click to open “Excel Viewer.”
2) From the pop-up Open window, browse to F:\Data\Winword\Marketing. Select an .xls file and click “Open.”
3) Verify the file opens properly, then click the upper right-hand [X] to close the Excel Viewer.

2. Installing and Testing Microsoft Word Viewer
Installing Microsoft Word Viewer
1)
2)
3)
4)
5)

From Explorer, browse to (the mapped server1\files drive)\Disks\Microsoft\Viewers.
Double-click to open “wdviewer.exe.”
From the Microsoft Office Word Viewer 2003 window, check the “I accept…” checkbox and click “Next.”
Click “Install” to install the Word Viewer and then click “OK” once the installation is finished.
From Explorer, browse to C:\Documents and Settings\All Users\Start Menu\Programs, right-click on
“Microsoft Office Word Viewer 2003” and then click “Rename.” Type Word Viewer and press [ENTER] to rename.
6) Right-click on “Word Viewer” and select “Copy.”
7) Browse to C:\Documents and Settings\All Users\Desktop, right-click somewhere and select “Paste.”
8) Click the upper right-hand [X] to close Explorer.

Testing Microsoft Word Viewer
1) From the desktop, double-click to open “Word Viewer.”
2) From the pop-up Open window, browse to F:\Data\Winword. Select a .doc file and click “Open.”
3) Verify the file opens properly, then click the upper right-hand [X] to close the Word Viewer.
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Installing, Updating, and Customizing NOD32 AntiVirus Software
1. Installing NOD32 (4.0)
1)
2)
3)
4)
5)
6)

From Explorer, browse to \\server1\files\Disks\Nod32\4.0vsn30daytrial and double-click to open “eav_nt32_enu.msi.”
Click “Next” at the Welcome to the ESET NOD32 Antivirus Setup Wizard window.
Click the “I Agree” bullet at the License Agreement window and then click “Next.”
Click Next with “Typical (recommended best settings)” bulleted.
Click “Next” at the following window with “Enable ThreatSense.Net” checked.
At the Automatic Update window, enter the appropriate user’s username in the User name field, the user’s password
in the Password field, and click “Next.”
7) Click “Next” with “Enable ThreatSense.Net Early Warning System” checked.
8) Select the “Enable detection of potentially unwanted applications” option from the drop-down menu, then click “Next.”
9) Click “Install” in order to begin the installation of NOD32.
10) Once the installation has finished, click “Finish.”

2. Customizing NOD32 Settings and Updating NOD32 Virus Protection
1) From the lower right-hand corner of the Windows toolbar, double-click the NOD32 icon to launch the program.
2) Press [F5] on the keyboard to reveal the NOD32 Setup window.
3) From the left-hand section of the Setup window (under the “Tools” section), click “System updates.”
From the System updates drop-down menu, select “No updates” and then click “OK.”
4) Next, from the left-hand menu of the ESET NOD32 AntiVirus 4 window, click “Update.”
5) From the resulting display in the right-hand portion of the program window, click “Update virus signature database”
in order to download the latest protection updates for NOD32.
6) From the upper right-hand corner of the ESET NOD32 AntiVirus 4 window, click the [-] button to minimize the program.

3. Running the NOD32 Full System Scan
1) From the left-hand menu of the ESET NOD32 AntiVirus 4 window, click “Computer scan.”
2) From the resulting display in the right-hand portion of the program window, click “Smart scan”
in order to begin a scan of the system’s hard drive.
3) Upon completion of the scan, click to delete or quarantine any located viruses.
4) From the upper right-hand corner of the ESET NOD32 AntiVirus 4 window, click the [-] button to minimize the program.
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Installing and Testing Acrobat (or Reader), WinZip, and eFax
1. Installing and Testing Adobe Acrobat Full Version (6.0)
1)
2)
3)
4)
5)
6)

Insert the Adobe Acrobat 6.0 CD into the CD-ROM drive. The CD should start automatically.
From the Adobe Acrobat 6.0 AutoPlay window, click “Install Acrobat 6.0 Standard.”
Click “Next” at the Adobe Welcome window and “Next” again at the Setup window.
Click “Next” at the Select Language window with “US English” highlighted.
Click “Accept” at the End User License Agreement window.
At the Customer Information window, type the user’s name in the User Name field, ACE in the Organization field,
and the license number (found on the CD) in the Serial Number field. Click “Next.”
7) At the Setup Type window, click the “Custom” bullet and then click “Next.”
8) From the Components list, select “View Adobe PDF” and then click “This feature, and all subfeatures, will be installed
on local hard drive.” Repeat this step, selecting “Create Adobe PDF” and then click “Next.”
9) Click “Install” to begin the installation. Once the installation is complete, click “Finish.”
10) Click “Quit” in order to close the Adobe Acrobat AutoPlay window.
11) From the desktop, double-click to open “Adobe Acrobat 6.0 Standard.”
12) Click the upper right-hand [X] to close the pop-up Registration window.
13) From the right-hand menu, uncheck “Show How To Window at Start up” and then click “Hide” to hide the How to menu.
14) After verifying the program runs, click the upper right-hand [X] to close Adobe Acrobat.
15) Remove the Adobe Acrobat 6.0 CD from the CD-ROM drive.

2. Installing and Testing Adobe Acrobat Reader 7.0
1)
2)
3)
4)
5)
6)
7)

From Explorer, browse to (the mapped server1\files drive)\Disks\Adobe\7.0.7 and double-click “AcrobatReader.exe.”
Click “Next” and “Next” again at the Adobe Reader Welcome window.
Click “Next” at the Destination Folder window and then “Install” to begin installation.
Once the installation is complete, click “Finish.”
From the desktop, double-click to open “Adobe Reader 7.0.” Click “Accept” at the pop-up and verify the program runs.
Click the upper right-hand [X] to close Acrobat Reader.
From the desktop, select “Adobe Reader 7.0” and press [SHIFT] + [DELETE] and answer “Yes” at the pop-up
to remove the shortcut from the desktop.

3. Installing WinZip
1) From Explorer, browse to (the mapped server1\files drive)\Disks\WinZip and double-click to open “winzip112.exe”
2) Click “Setup” at the Winzip Setup window.
3) Click “OK” at the pop-up window. Uncheck the two Google-related checkboxes and click “Continue.”
4) Click “Next”, then “Yes” to accept the License Agreement.
5) Click “Next”, then select the “Start with WinZip Classic” bullet and click “Next.”
6) Click “Next” with “Express Setup (recommended)” bulleted. Click “Next” again.
7) Click “Finish” to complete the installation process.
8) Click the upper right-hand [X] to close WinZip.
9) From the desktop, select “WinZip” and press [SHIFT] + [DELETE] to remove the shortcut from the desktop.
10) From the right-hand corner of the Windows toolbar, right-click on the “WinZip (Quick Pick)” icon and select “Close …”
From the pop-up window, select the “Close and remove” bullet and click “OK” in order to remove WinZip Quick Pick.

4. Installing EFax Messenger
1)
2)
3)
4)

From Explorer, browse to (the mapped server1\files drive)\Disks\eFax and double-click to open “efxsetup.exe.”
Click “OK” in response to the pop-up message and click “OK” again at the User Settings window.
From the pop-up eFax Messenger window, click on the message text displayed. Close eFax Messenger.
Click the upper right-hand [X] to close Explorer.
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Installing and Customizing the Audatex Website Utilities
(NOTE: The following procedure only needs to be performed for systems for customer service reps handling Selective work.)

1. Customizing Internet Explorer for Use with the Audatex Website
1) From the desktop, double-click to open “Internet Explorer.”
2) From the upper menu of Internet Explorer, click “Tools” and then select “Internet Options …”
3) From the Security tab, click “Trusted sites” and then click the “Sites …” button.
4) From the Add this Website field of the Trusted Sites window, type https://www.audatex.com and then click “Add.”
5) Repeat step 4 two more times, typing https://www.audatexsolutions.com and then https://*.audatex.us. Click “OK.”
NOTE: The following steps vary slightly, depending upon whether the operating system intalled is Windows 2000 or XP.
6) From the Privacy tab, click “Settings …”
7) From the Address of Website to allow field of the Pop-up Blocker window, type www.audatex.com and click “Add.”
8) Repeat step 7 two more times, typing www.audatexsolutions.com and then *.audatex.us. Click “Close.”
9) Click “OK” to close the Internet Options window.

2. Installing the Audatex Website CM Utilities
1) From Explorer, browse to (the mapped server1\files drive)\Disks\Audatex CMutilities and double-click to open
“EMS Internet Routines.exe.”
2) Click “Yes” at the CM Utilities Setup window in order to begin the installation. Once the installation is complete,
click “Next.”
3) Click the “Yes, I want to restart my computer now” bullet and then click “Finish” to reboot the workstation.

3. Customizing and Testing the Audatex Website
1) Once the system has rebooted, login as the user.
2) From the desktop, double-click to open “Internet Explorer.”
3) From the Address field of Internet Explorer, type http://www.audatexsolutions.com and press [ENTER] to go to
the Audatex website. Click “Yes” and “OK” at any pop-up messages.
4) Once at the Audatex site, from the upper menu of Internet Explorer, click “Favorites” and select “Add to Favorites …”
Click “OK” at the pop-up Add Favorite window. Click the upper right-hand [X] to close Internet Explorer.
5) From the desktop, double-click to re-open “Internet Explorer.”
6) From the upper menu of Internet Explorer, select “Favorites.” From the drop down list, click the “Audatex” link to go to
the Audatex website. Click “Yes” and “OK” at any pop-up messages.
7) From the left-hand menu, type rgizzio in the User ID field and eclipse in the Password field, and then click “Login.”
(NOTE: The password may be something different, as it is changed occasionally.) Select “No” and check the checkbox
at the pop-up message and click “OK.”
8) From the upper menu of the Audatex login page, click “To Do.”
9) From the Actions column of the resulting To Do List webpage, click any listed claim’s “Add Attachment” link.
10) From the left-hand menu of the resulting Attachments webpage, click “Setup.”
11) From the Finished Estimate Locations section of the Local Setup pop-up window, click the […] button located to the
right of the Mitchell field. From the pop-up window, browse to F:\CIECA\Mitchell\Export and then click “OK.”
Click “Close” to close the Local Setup pop-up window and save the settings change.
12) Next, click “Add Attachment.” Click “OK” at the pop-up window with “EMS Estimate” bulleted.
13) Verify that the pop-up Local EMS Estimates window loads ACE file data.
14) Once data appears, click “Cancel” to close the Local EMS Estimates window.
15) Click the upper right-hand [X] to close Internet Explorer.

21

Installing, Updating, and Customizing Symantec ACT 2000
1. Installing Symantec ACT 2000
1)
2)
3)
4)

Insert the Symantec ACT 2000 CD in the CD-ROM drive.
From the automatic pop-up window, select “Install ACT 2000.”
Click “Next” at the Welcome window and “Yes” at the Software License Agreement window.
At the User Information window, type the manager’s FirstName LastName in the Name field and ACE
in the Company field then click “Next.”
5) Click “Next” at the Choose Destination Location, Choose Country Version, Select NT User Availability, and
Select Program Folder windows.
6) Uncheck “Start SideACT when Windows starts” and click “Next.”
7) Click “Next” at the Start Copying Files window to begin the installation.
8) Click “Next” and then “Skip” at the Register Now window.
9) Uncheck “View the README file” and click “Finish.”
10) Click “Exit” to exit the ACT CD installation program and remove the ACT 2000 CD from the CD-ROM.

2. Setting up and Updating Symantec ACT 2000
1) From the desktop, double-click to open ACT 2000.
2) Click “Next” at the Introduction window.
3) Click “Next” at the LiveUpdate window and again at the What’s new in ACT window.
4) Click “Next” at the Word Processor window with ACT Word Processor selected.
5) Click “Cancel” at the Email Setup window and click “Yes” to the “Are you sure?” pop-up message.
6) Click the upper right-hand [X] to close Symantec ACT 2000.
7) From Explorer, go to (the mapped server1\files drive)\Disks\Act2000\Updates and double-click “ACT2K503.exe.”
8) Click “Next” at the Welcome window.
9) Click “Yes” to accept the Software License Agreement.
10) Click “Finish” with “Yes, I want to restart my computer now” bulleted.

3. Customizing Symantec ACT 2000
1)
2)
3)
4)
5)

After user login, from the desktop, double-click to open “ACT 2000.”
Click on the yellow folder to open a file and browse to F:\Data\Act\Database. Select “acecalls.dbf and click “Open.”
At the login screen, enter the user name and password to access the database and click “OK.”
Click “Register Later” at the pop-up Registration window.
Answer “No” in response to the “Do you want the ACT database to be available to Winfax?” question.
(NOTE: This question will only appear if Symantec Winfax has been installed on the workstation.)
6) From the upper menu of ACT 2000, select Edit and click “Preferences …”
7) From the General tab, click “Browse …” Change the database default location to F:\Data\Act\Database and click “OK.”
8) From the Startup tab, click the […] button. Change the Default contact layout location to
F:\Data\Act\Layout\Acecalls.cly and click “Open.”
9) Under the Startup database heading, select the “Named database” bullet, then click the […] button. Change the named
database default location to F:\Data\Act\Database\Acecalls.dbf and click “Open.” Next, click “Apply” and then “OK.”
10) Click the upper right-hand [X] to close ACT 2000. Next, from the desktop, double-click to re-open “ACT 2000.”
11) Click “OK” at the pop-up login window. Double-click the blue bar of the ACE Contacts window to maximize it.
12) Verify that the bottom toolbar contains information/queries about ACE (this ensures that the database populated).
13) Drag the left-hand toolbar to make it smaller and then answer “Yes” to the pop-up question to move it to the bottom.
14) From the just-relocated toolbar, click the “Task List” button.
15) Click “Select Users …” Click the “Selected users” bullet, click the appropriate user found on the list and click “OK.”
16) Click the upper right-hand [X] to close ACT 2000.
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Installing and Customizing Symantec PCAnywhere
1. Installing Symantec PCAnywhere (10.5)
1) Insert the Symantec PCAnywhere CD into the CD-ROM. The CD should start automatically.
2) From the pop-up window, click “Install pcAnywhere 10.5” and then click “pcAnywhere for the Professional.”
3) From the Welcome to Symantec pcAnywhere Setup wizard window, click “Next.”
4) Click “I accept the terms in the license agreement” bullet and then click “Next.”
5) Type the user’s FirstName LastName in the User Name field, ACE in the Organization field, and then click “Next.”
6) At the Setup Type window, select the “Typical” bullet and click “Next.”
7) Click “Install” to begin the pcAnywhere installation.
8) Once the installation is done, click “Next” at the Support Solutions, Windows Solutions, and How to Reach Us windows.
9) Click “Cancel” at the LiveUpdate window.
10) Click “Skip” at the Please Register window and then click “Yes” at the pop-up.
11) Uncheck “Add pcAnywhere icon to your desktop” and click “Finish.”
12) Click “Yes” at the pcAnywhere Installer Information window in order to reboot.

2. Changing Symantec PCAnywhere (10.5) Settings
1) After user login, from the Start menu, select “Programs” and then click “Symantec pcAnywhere.”
Click “Skip” at the Please Register window and then click “Yes” at the pop-up.
2) From the Hosts window, right-click on “NETWORK, CABLE, DSL” and select “Properties …”
3) From the Connect Info tab, verify that “TCP/IP” is checked.
4) From the Caller list menu of the Callers tab, select the “New Item” icon.
5) Enter BP in the Login Name field and the IT password in the Password field.
Retype the password in the Confirm Password field.
6) From the Privileges tab, check the “Superuser…” bullet. Click “Apply” and then “OK.”
Verify the user appears in the Caller list.
7) From the Encryption Level drop down of the Security Options tab, increase the encryption level to “pcAnywhere.”
8) From the Settings tab, check the “Launch with Windows” checkbox. Click “Apply” and “OK.”
9) Click the upper right-hand [X] to close PCAnywhere and remove the Symantec PCAnywhere CD from the CD-ROM.
10) From the Start Menu, click “Shut Down …” and click “OK” with “Restart” selected. Wait for the system to reboot.
11) After user login, verify that a pcAnywhere monitor icon appears on the right-hand portion of the Windows toolbar.

3. Testing Symantec PCAnywhere (10.5) Connectivity
1)
2)
3)
4)
5)
6)
7)

From the Start Menu, select “Programs –> Accessories” and then click to open “Command Prompt.”
From the Command Prompt, type ipconfig /all and press [ENTER]. A list of Ethernet settings will be displayed.
Write down on a sheet of paper the 11-digit IP Address.
Type exit and [ENTER] to close the Command Prompt.
From an IT workstation, go to the Start Menu, then select “Programs -> Symantec -> and click “Symantec pcAnywhere.”
From the Remotes tab of PCAnywhere, double-click “Add Remote.”
From the Connection Info tab of the pop-up New Remote window, click “Details …” Change the Data port and Status
port numbers to the corresponding port numbers for the new system and click “OK.” (This step may be unnecessary.)
8) From the Settings tab, type the IP address written down earlier into the Network host PC to control or IP address field.
9) From the Login information section, check the “Automatically login to host upon connection” checkbox.
Type BP and password in the Login name and Password fields, and type ACE in the Domain field.
10) From the Security Options tab, change the Encryption Level drop down to “pcAnywhere” and then click “OK” in order
to close the New Remote window.
11) From the main window of the Remotes tab of PCAnywhere, type a name for the new remote and press [ENTER].
12) Next, double-click to open the new remote. Verify that a connection is established with the new system.
13) Click the red “X” icon on the upper menu to end the remote control session and answer “Yes” at the pop-up.
14) Click the upper right-hand [X] to close Symantec PCAnywhere.
15) Return to the new workstation.
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Installing and Customizing Symantec PCAnywhere for Host Access
1. Installing Symantec PCAnywhere (10.5)
1) Insert the Symantec PCAnywhere CD into the CD-ROM. The CD should start automatically.
2) From the pop-up window, click “Install pcAnywhere 10.5” and then click “pcAnywhere for the Professional.”
3) From the Welcome to Symantec pcAnywhere Setup wizard window, click “Next.”
4) Click “I accept the terms in the license agreement” bullet and then click “Next.”
5) Type the user’s FirstName LastName in the User Name field, ACE in the Organization field, and then click “Next.”
6) At the Setup Type window, select the “Typical” bullet and click “Next.”
7) Click “Install” to begin the pcAnywhere installation.
8) Once the installation is done, click “Next” at the Support Solutions, Windows Solutions, and How to Reach Us windows.
9) Click “Cancel” at the LiveUpdate window.
10) Click “Skip” at the Please Register window and then click “Yes” at the pop-up.
11) Uncheck “Add pcAnywhere icon to your desktop” and click “Finish.”
12) Click “Yes” at the pcAnywhere Installer Information window in order to reboot.

2. Changing Symantec PCAnywhere (10.5) Settings
1) After user login, from the Start menu, select “Programs” and then click “Symantec pcAnywhere.”
Click “Skip” at the Please Register window and then click “Yes” at the pop-up.
2) From the Hosts window, right-click on “NETWORK, CABLE, DSL” and select “Properties …”
3) From the Connect Info tab, verify that “TCP/IP” is checked.
4) From the Caller list menu of the Callers tab, select the “New Item” icon.
5) Enter BP in the Login Name field and the IT password in the Password field.
Retype the password in the Confirm Password field.
6) From the Privileges tab, check the “Superuser…” bullet. Click “Apply” and then “OK.”
Verify the user appears in the Caller list.
7) From the Encryption Level drop down of the Security Options tab, increase the encryption level to “pcAnywhere.”
Click “Apply” and “OK.”
8) Click the upper right-hand [X] to close PCAnywhere and remove the Symantec PCAnywhere CD from the CD-ROM.

3. Testing Symantec PCAnywhere (10.5) Host Remote Connectivity
1) From the Start Menu, select “Programs” and then click to open “Symantec pcAnywhere.”
2) From the Remotes tab, for each remote connection to be created:
- Double-click the “Add Remote” icon.
- From the Connection Info tab, click “Details …” and change the Data port and Status port numbers to the
corresponding port numbers for the system to which a connection will be established. Click “Apply”
and then “OK.” (This step may be unnecessary.)
- From the Settings tab, type the IP address for the system into the Network host PC to control or IP address field.
- From the Login information section, check the “Automatically login to host upon connection” checkbox.
Type BP and password in the Login name and Password fields, and type ACE in the Domain field.
- From the Security Options tab, change the Encryption Level drop down to “pcAnywhere” and then click “OK”
in order to close the New Remote window.
- From the main window of the Remotes tab of PCAnywhere, type a name for the new remote and press [ENTER].
- Next, double-click to open the new remote. Verify that a connection to the desired system is established.
- Click the red “X” icon on the upper menu to end the remote control session and answer “Yes” at the pop-up.
3) Once all desired remotes have been created, click the upper right-hand [X] to close Symantec PCAnywhere.
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Installing and Customizing Symantec Winfax
NOTE: The software setup for Winfax servers is different than this procedure. See Setting up an ACE Fax Server for setup.

1. Installing Symantec Winfax (10.0)
1)
2)
3)
4)

Insert the Symantec Winfax CD into the CD-ROM. The CD should start automatically.
From the pop-up Symantec Winfax PRO window, click “Install.”
Click “Next” at the Welcome window and click “Yes” to accept the Software License Agreement.
At the User Information window, type the manager’s FirstName LastName in the “Name” field, ACE in the
“Company” field, and click “Next.”
5) Click “Next” at the Destination Folders window.
6) Click “Next” at the Setup Type window with “Typical” bulleted.
7) Click “Next” at the Select Program Folder and Start Copying Files windowes.
8) Click “Finish” at the File Copy Complete window once the installation is complete.
9) At the Setup-CSID window, type ACE in the CSID field, 6104295205 in the
Fax number field, and 6104295200 in the Phone number field and click “Next.”
10) Select “WinFax PRO Fax Sharing” as the device and click “Next.” Click “No” in response to the pop-up question.
11) Click “Next” at the Enable Controller window with “No” bulleted.
12) Click “Next”, then click “Cancel” at the Registration window and answer “Yes” at the pop-up message.
13) Click “EXIT” at the Symantec Winfax PRO window in order to close the installation program.
14) Click “Finish” and then answer “No” in response to the README pop-up question.
15) Click “Cancel” at the LiveUpdate window. Click “No” in response to the pop-up message.
16) From Explorer, go to C:\WINNT\system32 and double-click to open Dcomcnfg.exe.
17) Answer “No” in response to all configuration pop-up warnings.
18) From the Default Properties tab, change the Default Authentication Level drop down to “(None).”
19) From the Default Protocols tab, select and click “Remove” to remove all items except for “Connection-oriented TCP/IP.”
20) From the Start Menu, click “Shut Down …” and click “OK” with “Shutdown” selected. Wait for the system to shut off.
21) Once the system is off, press the power button in order to reboot. Once the system has started up, login as the manager.
22) Remove the Symantec Winfax CD from the CD-ROM drive.

2. Changing Symantec Winfax (10.0) Settings
1)
2)
3)
4)
5)

After manager login, from the desktop, double-click to open “Winfax PRO Message Manager.”
From the AutoLink pop-up, uncheck “Show any unlinked applications the next time Winfax PRO starts” and click “OK.”
From the upper toolbar, select “Tools” and then click “Program Setup …”
Select “Fax Sharing Client” and then click “Properties …”
From the Device Properties window, select “Winfax PRO Fax Sharing” and click “Properties.”
Click “Yes” in response to the pop-up message to configure.
6) Enter the Winfax Host IP address (192.168.200.212) in the IP address field, uncheck “Check for new events on startup”,
and then click “Finish.” Click “Finish” again at the pop-up.
7) From the Select Locations pop-up window, uncheck all items EXCEPT “Default” and click “OK.”
Click “OK” in response to the area code pop-up message request.
8) From the Dialing Properties pop-up window, type 555 in the area code field. Click “Apply” and then “OK.”
9) Click “OK” at the Device Properties window and then click “Close” to close the Program Setup window.
10) Click the upper right-hand [X] in order to close Winfax PRO Message Manager.
11) From the Start Menu, click “Shut Down …” and click “OK” with “Shutdown” selected. Wait for the system to shut off.
12) Once the system is off, press the power button in order to reboot. Once the system has started up, login as the manager.
13) From the desktop, double-click to open “Winfax PRO Message Manager.”
14) From the upper toolbar, select “Tools” and then click “Program Setup …”
15) Select “Receive” and click “Properties …”
16) Uncheck “Automatically answer incoming calls.” Click “Apply” and then “OK.”
17) Select “Send” and click “Properties …”
18) From the General tab, uncheck “If resubmitting a fax, send failed pages only” and check
“Prompt for keywords and billing code.”
19) From the Header tab, type From: @S @A To: @R - @C in the Left field. Leave the other 2 fields unchanged.
20) From the After Send tab, check “Print a send confirmation page.”
21) Click “Setup …” From the Send Confirmation Setup window, click “Add >>” for each Available item listed.
Click “OK”, then “Apply” and “OK.”
22) Select “User” and click “Properties …”
23) Verify that the manager’s FirstName LastName is in the Name field, ACE is in the Company field,
6104295205 is in the Fax number field, and 6104295200 is in the Voice number field. Click “OK.”
24) Click “Close” to close the Program Setup window and the upper right-hand [X] to close Winfax PRO Message Manager.
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3. Testing Symantec Winfax (10.0)
1)
2)
3)
4)
5)

From the desktop, double-click to open “Microsoft Word.”
Type some generic text into the blank Microsoft Word document.
Next, from the upper menu of Microsoft Word, click “File” and then select “Print ...”
From the Printer Name drop down menu, select “WinFax” as the printer and click “OK” to print.
From the Winfax PRO Send pop-up window:
- Type 6104293131 in the Number field and Generic information in the other fields.
- Select “No Cover Page” from the drop down menu and click “Send.”
- From the pop-up menu, type the manager’s FirstName LastName in the Billing code field and click “OK.”
6) Go to the upstairs fax machine and verify that the information sent properly.
7) If necessary, click “Cancel” at the pop-up Save As window and then click upper right-hand [X] to close Microsoft Word.
Answer “No” in response to the pop-up.
8) From the desktop, delete the “Winfax Drag & Drop Depot” icon.
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Installing and Testing Pop-Up Blockers
1. Installing and Testing SpyHunter
1) From Windows Explorer, browse to (the mapped server1\files drive)\Disks\popupblockers and double-click to open
the “Spyhunter” folder. From within the Spyhunter folder, double-click to open “spyhunterFULL.exe.”
2) Check the “Yes, I agree …” checkbox and then click “Next.” SpyHunter will now be installed on the workstation.
3) Click “Finish” in response to the “Installation Complete” message.
4) Minimize Windows Explorer and then browse to the desktop.
5) Right-click on the newly created “SpyHunter” shortcut and select “Cut.”
6) Open a second copy of Windows Explorer and then browse to the location of the “Popupblockers” folder, which will
either be in C:\Documents and Settings\All Users\Desktop or C:\Documents and Settings\All Users\Start Menu\Programs.
7) Right-click within the Popupblockers folder and select “Paste.”
8) Next, double-click to open “SpyHunter.”
9) From the Program Update window, click the “Program Update” button.
10) If necessary, once updates have downloaded, repeat steps 2 and 3, and then double-click to once again open “SpyHunter.”
11) From the Definitions Update window, click the “Definitions Update” button. SpyHunter will now download updates.
12) Click “Cancel” at the pop-up Internet Explorer homepage settings window.
13) Click “OK” in response to the Invalid authentication pop-up message.
14) From the main SpyHunter window, enter robgiz@netzero.com in the Email field and robertgizzio in the Password field.
15) Uncheck “Start SpyHunter Security Suite on Boot” and then click “Activate Now!”
16) Click “OK” in response to the “User has successfully authenticated” message.
17) To run an initial test scan, from the left-hand menu of SpyHunter, click “SpyHunter Scanner.”
18) From the menu which appears to the right, click “Start Scan” – ensuring that “Smart Scan” and “Fixed drive” (C:)
options are checked.
19) Once the scan has completed, check the “Check all parasites” checkbox located in the Infection Details window
and then click “Start Remove.” SpyHunter will now remove all infections.
20) Click the upper right-hand [X] to close SpyHunter.
21) Click the Start Menu button, then locate “SpyHunter” among the menu items listed. Right-click on it and select “Delete.”
Answer “Yes” at the pop-up. Next, browse to the desktop. If another “SpyHunter” icon has been created there, rightclick on it and select “Delete.” Answer “Yes” at the pop-up. Right-click on the Recycle Bin and select
“Empty Recycle Bin.” Click “Yes” in response to the pop-up message.

2. Installing and Testing Malwarebytes’ Anti-Malware
1) From the first copy of Windows Explorer, browse to (the mapped server1\files drive)\Disks\popupblockers and
double-click to open “AntiMalwareSetup.exe.”
2) At the pop-up Select Language window, click “OK” with “English” selected.
3) Click “Next” at the Welcome window.
4) Select the “I accept the agreement” bullet at the License Agreement window and then click “Next.”
5) Click “Next” at the following 4 windows and then click “Install” in order to install the Anti-Malware software.
6) Once the installation has completed, uncheck both checkboxes and then click “Finish.”
7) Click the upper right-hand [X] in order to close the first copy of Windows Explorer and then browse to the desktop.
8) Right-click on the newly created “Malwarebytes’ Anti-Malware” shortcut and select “Cut.”
9) From the remaining copy of Windows Explorer, browse to the location of the “Popupblockers” folder, which will
either be in C:\Documents and Settings\All Users\Desktop or C:\Documents and Settings\All Users\Start Menu\Programs.
10) Right-click within the Popupblockers folder and select “Paste.”
11) Next, double-click to open “Malwarebytes’ Anti-Malware.” Click “OK” in response to the pop-up message.
12) From the main Anti-Malware window, select the Update tab and then click “Check for Updates.”
NOTE: The message “Update failed …” will probably be displayed. Click “OK” in response to the message.
13) Next, click the “Exit” button in order to close the program and then, from the Popupblockers folder,
double-click to re-open “Malwarebytes’ Anti-Malware.”
14) Again, from the main Anti-Malware window, select the Update tab and then click “Check for Updates.”
Updates should now download successfully - If not, continue to “Exit” and re-open Anti-Malware and click
“Check for Updates” until the updates download (at which point a confirmation pop-up message will appear. Click
“OK” in response to the message and then the program will update and then close).
15) Repeat steps 14 and 15 until the “You have the latest database” message is displayed.
16) Next, select the Scanner tab and then, with the “Perform quick scan” setting bulleted, click “Scan.”
17) Once the scan has completed, click “OK” in response to the pop-up message.
18) Click the “Show Results” button and then, with all infections checked, click “Remove Selected.”
19) From the NotePad window, click the upper right-hand [X] in order to close the log file and then click “OK” in response
to the pop-up message or “Yes” to reboot, if necessary. If a reboot isn’t needed, click “Exit” to close Anti-Malware.
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3. Installing and Testing CCleaner
1) From the first copy of Windows Explorer, browse to (the mapped server1\files drive)\Disks\popupblockers and
double-click to open “ccsetup226.exe.” Click “Run” at the pop-up window.
2) Click “OK” with “English” as the selected language.
3) Click “Next” at the Welcome window.
4) Click “I Agree” at the License Agreement.
5) Click “Next” at the following window.
6) At the Install Options window, uncheck “Add Start Menu Shortcuts”, “Add ‘RunCCleaner’ option …”, “Add
‘OpenCCleaner’ option …”, and “Add CCleanerYahoo! Toolbar …” options and then click “Install.”
7) Once the installation has completed, uncheck “Run CCleaner” and click “Finish.”
8) Click the upper right-hand [X] to close Windows Explorer, then, from the desktop, click and drag the “CCleaner” icon to
the “SpywareRemovalTools” folder located on the desktop (or in the Program Files menu).
9) Next, double-click to open “CCleaner.”
10) From the lower right-hand portion of CCleaner, click “Check for Updates.” An internet browser window will open to
CCleaner’s website. Follow the prompts in order to download and install CCleaner updates, if necessary.
11) From the left-hand menu of CCleaner, select “Cleaner” and click “Analyze” to check the system for unnecessary files.
12) Once the analysis has completed, click “Run Cleaner” and click “OK” at the pop-up in order to remove the files.
13) Once the cleaning process is complete, from the left-hand menu, select “Registry.”
14) Click “Scan for Issues.”
15) Once the scan has completed, click “Fix selected issues …” and answer “Yes” at the pop-up. From the
Save As window, browse to C:\, click to create a new folder, name the folder Backup, and then this folder.
Next, click “Save” in order to save the current Registry state to this location.
16) Next, click “Fix All Selected Issues” from the pop-up window. Once issues have been fixed, click “Close.”
17) Repeat steps 14 – 16 until no items result from the scan (indicating that all Registry issues have been fixed).
18) From the left-hand menu, click “Options” and then “Settings.” Check the
“Run CCleaner when the computer starts” checkbox.
19) Next, click the “Advanced” button found within the Options area. Uncheck the “Only delete files in Windows Temp
folders older than 24 hours” checkbox and check the “Close program after cleaning” checkbox, then click the upper righthand [X] to close CCleaner.
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Installing and Testing Print Shop 12
1. Installing Print Shop 12
(This procedure is ONLY necessary to be set up on the one ACE Account Manager workstation.)
1) Insert The Print Shop Install CD into the CD-ROM drive. The CD should start automatically
2) From the pop-up Print Shop window, click “Install” to begin the pre-installation.
3) Click “Next” at the Welcome window and “Yes” to accept the License Agreement terms.
4) Click “Next” at the Choose Destination Location window.
5) Click “Next” at the Setup Type window with “Typical” selected.
6) Click “Next” at the Available Disk Space window to begin installation.
7) When the Setup Needs the Next Disk pop-up appears, remove the Install CD from the CD-ROM drive, replace it with
The Print Shop Program CD and click “OK.”
8) When the Setup Needs the Next Disk pop-up appears, remove the Program CD from the CD-ROM drive, replace it with
The Print Shop Install CD and click “OK.”
9) Click the upper right-hand [X] to close the Registration window and then click “OK” at the following window.
10) Click the upper right-hand [X] to close the Install AOL window.
11) Click “Finish” with “Yes, I want to restart my computer now” bulleted. Click “OK” in response to the pop-up window.

1. Testing Print Shop 12
1) After manager login, from the desktop, double-click to open “The Print Shop 12.”
Answer “No” at the pop-up window and then click “OK” at the second pop-up.
2) Click “Cancel” at the Personal Information window.
3) Verify the program is working properly and then click the upper right-hand [X] to close The Print Shop.
4) From the desktop, delete the “Install America Online – Free Trial!” and “ExpressIt.com” icons.
5) Remove The Print Shop Install CD from the CD-ROM drive.
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Installing and Customizing Peachtree
(To setup an Accounts Payable Workstation, follow the Manager Workstation Procedure, then follow these Steps.)

1. Installing Peachtree (2002)
1)
2)
3)
4)
5)
6)

Insert the Peachtree 2002 installation CD into the CD-ROM drive.
At the Main Menu, click “Peachtree Accounting.”
Click “Next” at the Welcome window.
Click “Yes” in response to the License Agreement.
At the Select Install Type window, click the “Network” button.
At the following window, under Program Path, click “Browse …” and select F:\PeachW. Click “OK” to set the path.
Leave the Data Path set to C:\PeachW and click “Next.”
7) From the Select Components window, uncheck “Sample company data” and click “Next.”
8) Click “Next” again to begin the installation of Peachtree.
9) Click “OK” in response to the pop-up warning message (disregard the message… It’s a false alarm).
10) Click “Finish” with “Yes” bulleted to restart your computer.

2. Customizing Peachtree (2002)
1)
2)
3)
4)
5)

After manager login, from the desktop, delete the “Peachtree Fixed Assets” and “Stamps.com” shortcuts.
From the desktop, double-click to open “Peachtree Accounting.”
Verify that Peachtree opens properly.
From the upper menu, click the [X] in order close Peachtree Accounting.
Remove the Peachtree 2002 installation CD from the CD-ROM drive.
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Deploying an ACE Workstation
1. Copying User Files from the OLD Workstation to a Temporary Network Folder
Creating a Temporary Folder
1) Go to the user’s CURRENT workstation.
2) From Explorer, browse to the F:\ drive. Right-click somewhere in the right-hand window, select “New” and then click
“Folder” to create a new folder. From the “New Folder”, type _(user) and then press [ENTER] to rename the folder.

Copying Mitchell UltraMate-Related Files to the Network
(NOTE: This step is only necessary for auditor workstations.)
1) From the desktop, double-click to open “UltraMate.”
2) Login using the ACE for the User ID and Password (or the auditor’s User ID and Password, when necessary).
3) Click on the yellow folder to open an existing estimate.
4) From the Estimates tab, write down on paper the number of estimates ( _ of _ Estimates Displayed) and click “Close.”
5) Close UltraMate. Maximize Explorer and go to F:_user (the temporary folder created in the step above).
6) Open another copy of Explorer. Browse to C:\ and select the “Archive” folder as well as any “OldArchive (date)” folders.
Right-click and select “Copy.”
7) Return to the first copy of Explorer and then right-click and select “Paste.”
8) From the second Explorer, browse to C:\Mitchell. Select the folders “useraux” and “userdata”, right-click and “Copy.”
9) Return to the first copy of Explorer and then right-click and select “Paste.”
10) From the second Explorer, browse to C:\Mitchell\Aces. Right-click on the folder “Longexp” and the file “exp_lines.txt”
and then select “Copy.”
11) Return to the first copy of Explorer and then right-click and select “Paste.”

Copying Audatex PenPro Files to the Network
(NOTE: This step is only necessary for PenPro auditor workstations.)
1) From the desktop, double-click to open “PenPro” and then click “OK” to log in.
2) From the claims list window of PenPro, note the number of estimates present. Write the number down on paper.
3) Click the upper right-hand [X] to close the PenPro claims window. Answer “Yes” at the pop-up and then click
“Exit PenPro” to close Audatex PenPro.
4) From the second copy of Explorer, browse to C:\PenPro. Right-click on the “bin” folder and select “Copy.”
5) From the F:\_user copy of Explorer, right-click somewhere and select “Paste.”

Copying Internet Favorites to the Network
(NOTE: This step is only necessary for internet users.)
1) From the desktop, double-click to open “Internet Explorer.” From the upper menu of Internet Explorer, click “Favorites.”
2) Verify if the system contains any non-standard favorites. Click away from the favorites menu to close it, then click the
upper right-hand [X] to close the Internet Explorer window.
3) If the system DOES NOT contain any non-standard favorites, skip to the next step.
4) If the system DOES contain personal favorites, from the second copy of Explorer, browse to C:\Documents and Settings\
User\Favorites. Right-click on “Favorites” and select “Copy.”
5) From the F:\_user copy of Explorer, right-click somewhere and select “Paste.”

Copying Necessary Desktop Icons to the Network
1) From the desktop, select all items that are not present on the NEW workstation. Right-click and “Copy” these items.
2) From the F:\_user copy of Explorer, right-click somewhere in the right-hand window, select “New” and then click
“Folder” to create a new folder. From the “New Folder”, type Desktop and then press [ENTER] to rename the folder.
3) Double-click to open “Desktop”, then right-click somewhere and select “Paste.”

Noting What Printers are Set up on the User’s Current Workstation
1) From the Start Menu, Select “Settings” and then click “Printers and Faxes.”
2) Write down on paper the list of printers shown in the Printers and Faxes window.
3) Click the upper right-hand [X] to close the Printers and Faxes window.
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Noting the My Documents Path on the User’s Current Workstation
(NOTE: This step is only necessary for users with Microsoft Office.)
1) From the desktop, double-click to open “Microsoft Word.”
2) From the upper menu of Microsoft, click “File” and then click “Open …”
3) From the Open pop-up window, click the Look in drop down menu. Write down on paper the default location to which
Microsoft Word documents get stored (for example, F:\Data\Winword\Clerical\(user)).
4) Click “Cancel” and then click the upper right-hand [X] to close Microsoft Word.
5) If the default location is on the F:\ (or other) network drive, the user’s documents folder DOESN’T need to be transferred.
In this case, skip to the next step.
6) However, if the default location is on the C:\ drive, then the user’s documents will need to be transferred. Next, from the
second copy of Explorer, browse to the location just written. Right-click on the folder and select “Copy.” (NOTE: The
folder will usually be named “My Documents”, but not always, as the folder is sometimes renamed, moved, etc.)
7) From the F:\user copy of Explorer, right-click somewhere and select “Paste.”

Copying the User’s Email Program Files to the Network
(NOTE: The following step is only necessary for users with email accounts.)
> If the User’s Current Email Program is OUTLOOK EXPRESS
1) From the desktop, double-click to open “Outlook Express.”
2) From the upper menu of Outlook Express, click the “Send and Receive All” envelope icon to retrieve all new mail.
3) Click [+] to expand all email folders, then press [ALT] + [Print Screen] to “print” the Outlook Express window contents.
4) From the Start Menu, select “Programs -> Accessories” and then click to open “Wordpad.”
5) From Wordpad, right-click somewhere and select “Paste.” From the upper menu, select “File” and then click “Print …”
6) Click “Print”, click the upper right-hand [X] to close Wordpad and answer “No” at the pop-up, then retrieve the printout.
7) From the upper menu of Outlook Express, click the “Address book” icon to open the Address book.
8) Click the upper right-hand [X] to close the Address book.
9) If the user’s Address book contains contacts:
- From the upper menu of Outlook Express, click “File -> Export” and then click “Address Book …”
- Select “Text File (Comma Separated Values)” and then click “Export.”
- Type Addressbk in the Save exported file as field, and then click “Browse …”
- Browse to F:\_user, then click “Save” and then “Next.”
- At the Select fields you wish to export menu, check ALL checkboxes, then click “Finish” and “OK” at the pop-up.
10) Click “Close” to close the Address Book window and then click the upper right-hand [X] to close Outlook Express.
11) From the second copy of Explorer, browse to the folder where the user’s Outlook Express folder is located.
NOTE: The location will usually be in C:\Data or in C:\Documents and Settings\user\Local Settings\Application Data\
Identities\(a long number string)\Microsoft. Write this location down on a sheet of paper.
12) Right-click on “Outlook Express” and “Copy.” From the F:\_user copy of Explorer, right-click somewhere and “Paste.”
> If the User’s Current Email Program is OUTLOOK
(NOTE: The following may vary slightly, depending upon the user’s version of Microsoft Outlook.)
1) From the desktop, double-click to open “Microsoft Outlook.”
2) From the upper menu of Outlook, click the “Send/Receive” to retrieve all new mail.
3) Click [+] to expand all email folders, then press [ALT] + [Print Screen] to “print” the Outlook window contents.
4) From the Start Menu, select “Programs -> Accessories” and then click to open “Wordpad.”
5) From Wordpad, right-click somewhere and select “Paste.” From the upper menu, select “File” and then click “Print …”
6) Click “Print”, click the upper right-hand [X] to close Wordpad and answer “No” at the pop-up, then retrieve the printout.
7) From the upper menu of Outlook, click the “Address book” icon to open the Address book.
8) Click the upper right-hand [X] to close the Address book.
9) If the user’s Address book contains contacts:
- From the upper menu of Outlook, click “File” and then click “Import and Export …”
- Select “Export to a File” and then click “Next.”
- From the Create a file of type list, select “Comma Separated Values (Windows)” and click “Next.”
- From the Select folder to export from list, select “Contacts” and click “Next.”
- Type Addressbk in the Save exported file as field, and then click “Browse …”
- Browse to F:\_user, then click “OK” and then click “Next” and “Finish.”
10) Click the upper right-hand [X] to close Microsoft Outlook.
11) From the second copy of Explorer, browse to the folder where the user’s Outlook folder is located.
NOTE: The location will usually be in the user’s private directory on the network, in the F:\Data\Outlook\user folder,
or in C:\Documents and Settings\user\Local Settings\Application Data\Microsoft.
12) Right-click on “Outlook” and “Copy.” From the F:\_user copy of Explorer, right-click somewhere and “Paste.”

2

2. Final Steps to Perform at the CURRENT User System
1)
2)
3)
4)

Close all Explorer windows.
From the Start Menu, click “Shut Down …” From the pop-up window, click “OK” with “Shut down” selected.
Once the system is off, disconnect the keyboard, mouse, monitor, network cable, and power cord.
Relocate the “old” system to the IT room, in the OLD (reformatable) computers pile, and paste a “stickie” on it
(containing the system type, system number, and processor information).
NOTE: Leave the system’s hard drive intact for AT LEAST two business days before reformatting it.
5) Return to the user’s NEW workstation.
NOTE: Perform the following steps quickly, so that the user is not without a computer for long.

3. Transferring User Files to the NEW Workstation
Transferring Mitchell UltraMate-Related Data to the New System
(NOTE: This step is only necessary for auditor workstations.)
1) From Explorer, go to F:\_user and select “Useraux”, “Userdata”, “Longexp”, “exp_lines.txt” and all “Archive folders.
Right-click and select “Cut.”
2) Open another copy of Explorer. Browse to C:\, right-click somewhere and select “Paste.” Click “Yes to all” at the
pop-up. Select “Useraux”, “Userdata”, “Longexp”, and “exp_lines.txt” again, and then right-click and select “Cut.”
3) Next, browse to C:\Mitchell. Right-click on the existing “Useraux” folder and select “Rename.” Rename it
UserauxNEW. Do the same to the existing “Userdata” folder. Next, right-click somewhere and select “Paste” to make
readable the user’s previous UltraMate data and click “Yes to all” at the pop-up.
4) Select “Longexp” and “exp_lines.txt” and select “Cut.” Browse to C:\Mitchell\Aces. Right-click on the existing
“Longexp” folder and select “Rename.” Rename it LongexpNEW. Next, rename the existing file “exp_lines.txt”
to exp_lines.txtNEW. Right-click somewhere and select “Paste” to paste the new Longexp folder and exp_lines.txt file.
5) From the desktop, double-click to open “UltraMate.” Login using the ACE for the User ID and Password
(or the auditor’s User ID and Password, when necessary).
6) Click on the yellow folder to open an existing estimate.
7) From the Estimates tab, verify that the numbers written down on the scrap paper coincide with the numbers on screen.
8) Next, click “Close” and then click the upper right-hand [X] to close UltraMate.

Transferring Audatex PenPro Data to the New System
(NOTE: This step is only necessary for PenPro auditor workstations.)
1) From the F:\_user copy of Explorer, right-click on the “bin” folder and select “Cut.”
2) From the second copy of Explorer, browse to C:\PenPro. Right-click on the “bin” folder and select “Rename.”
Rename the folder binOLD.
3) Next, right-click somewhere in the folder and select “Paste.”
4) From the desktop, double-click to open “PenPro” and then click “OK” to log in.
5) From the claims list window of PenPro, verify (checking the number written on paper) that all estimates are present.
6) Click the upper right-hand [X] to close the PenPro claims window. Answer “Yes” at the pop-up and then click
“Exit PenPro” to close Audatex PenPro.

Transferring Internet Favorites to the New System
(NOTE: This step is only necessary for internet users.)
1) From the F:\_user copy of Explorer, double-click to open “Favorites.” Select all items in this folder and select “Cut.”
2) From the second copy of Explorer, browse to C:\Documents and Settings\User\Favorites. Right-click somewhere within
the Favorites folder window and select “Paste.” Answer “Yes to All” at the pop-up window.

Transferring Necessary Icons to the New System Desktop
1) From the F:\_user copy of Explorer, browse up one level. Next, double-click to open “Desktop.” Select all items in
this folder and select “Cut.”
2) From the second copy of Explorer, browse to C:\Documents and Settings\All Users\Desktop. Right-click somewhere
within this folder window and select “Paste.”

Verifying that all Necessary Printers are Set up
1) From the Start Menu, Select “Settings” and then click “Printers and Faxes.”
2) Compare the printer list written down early to the list of printers shown in the Printers and Faxes window.
3) Install ALL printers that are not listed in the Printers and Faxes window but are written on the paper. (See the printer
setup procedure.)
4) Click the upper right-hand [X] to close the Printers and Faxes window.
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Customizing and Testing the NuGen Compliance Tool
(NOTE: This step is only necessary for CSAA auditor workstations.)
1) From the desktop, double-click to open “UltraMate.” From the pop-up login window, login with ACE as both
the User ID and Password (unless the auditor has a separate user account).
2) From the upper menu of UltraMate, click the yellow folder icon.
3) From the File Selection window, under the Estimates tab, select ANY file statused as “COMMITTED” and double-click
on the file in order to open it.
4) From the Repair tab of the specific UltraMate file, select a repair line and retype the Labor Unit data in order to allow
the file to be saved. From the upper menu of the UltraMate file, select “File” and then click “Save.”
5) Click the upper right-hand [X] in order to close UltraMate.
6) From the right-hand corner of the Windows toolbar, double-click on the hammer icon to open the Compliance Tool.
7) If necessary, reset the Compliance Tool Configuration Path:
- From the upper menu of the Compliance Tool, click the Configuration tab.
- Next, click the “Add” button. Browse to C:\Cieca\Mitchell\Export and click “OK.”
- The path will now appear in the EMS Estimate locations field. Click “Save Configuration.”
8) From the Estimates tab of the Compliance Tool, click the checkbox of the file saved and click “Check Compliance …”
9) From the pop-up Sign on window, type AAA.AAACE100 in the User ID field and password in the Password field and
then click “Sign-On.”
10) Verify that the Compliance Tool downloads rulesets and then runs a compliance check. Click the upper
right-hand [X] to close both the Compliance Result window and the Compliance Tool and answer “No” at the pop-up.

Transferring and Pathing the My Documents Folder on the New System
(NOTE: This step is only necessary for users with Microsoft Office.)
1) If the user has a non-networked documents folder to be transferred:
- From the F:\_user copy of Explorer, browse up one level. Next, double-click to open the user’s default
Office folder (usually named “My Documents”). Select all items in the folder and then select “Cut.”
- From the second copy of Explorer, browse to C:\Documents and Settings\user\My Documents.
Right-click somewhere and select “Paste.”
2) If the user has a folder named something other than My Documents:
- From the second copy of Explorer, browse to C:\Documents and Settings\user.
- Right-click on “My Documents”, right-click and select “Rename.” Rename the folder to the appropriate
user name (determine the folder name by checking the default path location written down earlier).
3) If necessary, in order to re-path the Office programs to a location other than the default location:
- From the second copy of Explorer, browse to C:\Documents and Settings\user.
- Right-click on the folder and select “Cut.” Browse to the default path location written down earlier.
NOTE: If the location is on the network, you will see an existing folder with the same name as the folder just cut.
- Right-click somewhere and select “Paste” to set the folder path to this location. Click “Yes to All” at the pop-up.
4) From the desktop, double-click to open “Microsoft Word.”
5) From the upper menu of Microsoft, click “File” and then click “Open …”
6) From the Open pop-up window, verify the default location displays the user’s documents.
7) Click “Cancel” and then click the upper right-hand [X] to close Microsoft Word.

Importing all Necessary Email Components to the New Workstation Email Program
(NOTE: This step is only necessary for users with email accounts. Also, Explorer hidden files will need to be made visible.)
> If the User’s Current Email Program is OUTLOOK EXPRESS and the NEW Email Program is OUTLOOK
(NOTE: The following may vary slightly, depending upon the user’s version of Microsoft Outlook.)
1) From the desktop, double-click to open “Microsoft Outlook.”
2) To import the user’s email messages, folders, and address book contacts (if applicable), from the upper menu of Outlook,
select “File” and then click “Import and Export …”
3) Next, click “Import Internet Mail and Addresses” and click “Next.”
4) From the Select the Internet Mail application to import from menu, select “Outlook Express 4.x, ...” and click “Next”
with all three checkboxes checked.
5) From the following window, click the “Replace duplicates with items imported” bullet and click “Finish.”
6) From the Browse for Folder pop-up window, browse to F:\_user\Outlook Express and click “OK.”
7) From the Import Summary window, click “Save in Inbox” to import all items.
8) Verify that the Outlook program now contains all email messages and email folders that were on the user’s
current system (see the printed screen image of Outlook Express).
9) If the user has address book contacts:
- From the upper menu of Outlook, click the “Address book” icon to open the Address book.
- Verify that the contacts appear, and then click the upper right-hand [X] to close the Address book.
10) Click the upper right-hand [X] to close Microsoft Outlook.
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> If the User’s Current and New Email Programs are Both OUTLOOK EXPRESS
1) From the second copy of Explorer, browse to C:\Documents and Settings\user\Local Settings\Application Data\
Identities\(a long number string)\Microsoft. (NOTE: Hidden files/folders will need to be temporarily made visible.)
2) Right-click on “Outlook Express” and select “Rename.” Rename the folder Outlook ExpressNEW.
3) From the F:\_user copy of Explorer, right-click on “Outlook Express” and select “Cut.”
4) From the second copy of Explorer, right-click and select “Paste” to paste in the user’s existing Outlook Express folder.
5) From the desktop, double-click to open “Outlook Express.”
6) Verify that the Outlook Express program now contains all email messages and email folders that were on the user’s
current system (see the printed screen image of Outlook Express).
7) If the user has address book contacts:
- From the upper menu of Outlook Express, click “File -> Import” and then click “Other Address Book …”
- From the pop-up menu, select “Text File (Comma Separated Values)” and click “Import.”
- From the CSV pop-up window, browse to F:\user, then select “Addressbk.csv” and click “Open.”
- Click “Next” and then “Finish” to import the user’s address book contacts.
- Click “OK” at the pop-up message and then click “Close” to close the Address Book Import window.
- From the upper menu of Outlook Express, click the “Address book” icon to open the Address book.
- Verify that the contacts appear, and then click the upper right-hand [X] to close the Address book.
8) Click the upper right-hand [X] to close Outlook Express.
> If the User’s Current and New Email Programs are Both OUTLOOK
(NOTE: The following may vary slightly, depending upon the user’s version of Microsoft Outlook.)
1) From the second copy of Explorer, browse to C:\Documents and Settings\user\Local Settings\Application Data\Microsoft.
2) Right-click on “Outlook” and select “Rename.” Rename the folder OutlookNEW.
3) From the F:\_user copy of Explorer, right-click on “Outlook” and select “Cut.”
4) From the second copy of Explorer, right-click and select “Paste” to paste in the user’s existing Outlook folder.
5) From the desktop, double-click to open “Microsoft Outlook.”
6) Verify that the Outlook program now contains all email messages and email folders that were on the user’s
current system (see the printed screen image of Outlook).
NOTE: It will likely be necessary to hide each imported folder’s reading pane and to not show in groups (Outlook 2003).
7) If the user has address book contacts:
- From the upper menu of Outlook, select “File” and then click “Import and Export …”
- Click “Import from another program or file” and click “Next.”
- From the Select file type to import from list, select “Comma Separated Values (Windows)” and click “Next.”
- Next, from the Import a File window, click “Browse …”
- Browse to F:\_user, select “Addressbk.csv”, and click “OK” and then “Next.”
- From the Select destination list, select “Contacts” and click “Next.”
- Type Addressbk in the Save exported file as field, and then “Finish.”
- From the upper menu of Outlook, click the “Address book” icon to open the Address book.
- Verify that the contacts appear, and then click the upper right-hand [X] to close the Address book.
8) Click the upper right-hand [X] to close Microsoft Outlook.

4. Final Steps to Perform at the NEW User System
1) Close all Explorer windows, and if any new icons were copied to the desktop, re-set the user’s profile as the default.
(See the Ending Customization procedure step on profile set ups.)
2) From the Start Menu, click “Shut Down …” From the pop-up window, click “OK” with “Shut down” selected.
3) Once the system is off, disconnect the keyboard, mouse, monitor, network cable, and power cord.
4) Move the NEW system to the user’s location. Reconnect to the user’s keyboard, mouse, monitor, cable, and power cord.
5) Press the power button of the user’s NEW workstation.
6) Once the system has booted up, login as the user.
7) From Explorer, browse to the F:\ drive. Select and delete the “_user” folder. Answer “Yes” at the pop-up.
8) Close Explorer and inform the user that he or she is now free to work on their new workstation.
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New ACE Employee ~ Setup Procedures
1. Updating Phone System Records – Adding a New User (ACE Phone System Changes)
(Complete the first portion of this Procedure when a NEW extension for the user needs to be added to the Phone System.)
1) Go to the ACE Phone system (located in the phone closet). Determine an open extension to assign to the employee.
2) From the telephone wire panel in the closet, wire the employee’s phone jack to the phone extension.
3) Plug the phone line tester into the employee’s phone jack and verify the green light is lit (indicating proper connectivity).
4) Test the phone by dialing the extension from another location. Also make test internal and external calls using the phone.
5) Now, see Working with the ACE Voice Mail System, Step 4 to setup a greeting and name announcement for the employee.

2. Creating a Network User Login
1)
2)
3)
4)
5)
6)

Receive the new employee’s name and password information.
Physically enter the server closet and go to the ACE Server.
From the desktop of the ACE Server, double-click to open “Administrative Tools.”
From the Administrative Tools window, double-click to open “Active Directory Users and Computers.”
From the upper menu of Active Directory, click the new user icon.
From the New Object-User window, type in the employee’s First name, Initial, Last name, and User login name,
then click “Next.”
7) Type in the employee’s User password and then confirm by retyping it. Check the “User cannot change password”
and “Password never expires” checkboxes and click “Next.”
8) Click “Finish” to complete the creation of the user account.
9) From Active Directory, locate the newly created account. Right-click on it and select “Properties.”
10) Click on the Profile tab and then type in the logon script that the user requires (examples: Clerical user = login.bat,
Non-Win2K Auditor = loginauto.bat).
11) Click the Member Of tab and then “Add …”
12) Select the appropriate group(s) to which the user should be added and click “Add” in each case. Click “OK.”
13) Click “OK” again to exit the user’s Properties window.
14) Click the “X” box to close Active Directory and then the Administrative Tools window.
15) Log off the ACE Server, lock the server closet and return to the IT workstation.

3. Creating a Specialty/Property Reports User Login
(This step is unnecessary for non-Subrogation Auditors and some Clerical and Management employees.)
1) From Explorer, browse to F:\Data\Access\Specialty and double-click to open “Specialty_be.mdb.”
2) From the Tables tab, double-click to open “tblAuditors.”
3) From within the table, in the first vacant row of fields, type the new employee’s information.
4) Close Specialty Reports (changes made will save automatically).
5) From Explorer, browse to F:\Data\Access\Propery\Reports and double-click to open “Property_be.mdb” (Property only).
6) From the Tables tab, double-click to open “tblAuditors.”
7) From within the table, in the first vacant row of fields, type the new employee’s information.
8) Close Property Reports/Property Reports (changes made will save automatically).

4. Adding the Employee to the ACE Computer Database
(This step is unnecessary for Clerical employees.)
1) From the AccessShortcuts folder found on the desktop, double-click to open “ACE Computer Database.”
2) From within the default field (Lookup ACE ID#), type the ID number of the computer the employee will be using.
3) Once the computer information appears, add the employee’s information to the First Name, Last Name, and ID fields.
4) Close ACE Computer Database.
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5. Adding the Employee to the ACE Floorplan, System Assignment Information, & Phone Extensions List
(Not all steps are necessary for Clerical employees.)
1) From the Start menu, go to Programs -> Design -> and select “Flash 5.” From Flash, open the file “UserSysInfo.fla.”
2) Locate the new employee’s location on the floorplan and change all appropriate information.
3) Save the changes, publish the file, and then close Flash 5.
4) From the desktop, double-click to open “Excel.” Browse to the Excel Docs folder within the private IT directory
and then open the file “System Distribution and Specs.xls.”
5) From the relevant spreadsheet tab (such as Auditor Systems or Cust Svc Systems, for example), locate the system’s
data row and place the employee’s name in the appropriate field. Save changes to the spreadsheet and then close it.
6) Next, open the Excel file “System Data.xls.”
7) From the Data Jack Info tab, find the jack number to be used by the employee and enter his name.
8) From the Phone Exts tab, add the employee’s name and extension.
9) From the TCP/IP Addresses tab, if necessary, replace Open Auditor (#PC) with the employee’s name.
10) From the Email Addresses tab, add a row and enter the user’s info. Save changes to the spreadsheet and then close it.
11) Next, open the Excel file “Running Updates.xls.” Go to the Updating-UltraMate Archive tab.
12) Next, add a row and enter the user’s info. From the Updating Windows, AntiVirus, and Pop-ups tabs,
replace Open Auditor (#PC) with the user’s information.
13) Save changes to the spreadsheet and then click the upper right-hand [X] to close Excel.

6. Adding the Employee to the ACE Logins Database
(This step is unnecessary for non-management employees.)
1) From the AccessShortcuts folder found on the desktop, double-click to open the Access file “ACE Logins.”
2) At the Password Required pop-up window, enter the database password and click “OK.”
3) From the Tables tab, double-click to open “tblUsers.”
4) Once in the table, scroll down to the row beneath the last row with information in its fields.
5) In the fields of this blank row, enter in the appropriate user information.
6) Close Microsoft Access.

7. Assigning Clerical Access to the Employee
1) From Explorer, go to F:\Data\First Entry\Databases. Right-click on “Ace_Data_Local.mdb” and then click “Copy.”
2) Go to the desktop, right-click somewhere and select “Paste.” Double-click to open “Ace_Data_Local.mdb.”
3) At the Password Required pop-up window, enter the database password and click “OK.”
4) From the Tables tab, double-click to open “tblEmployees.”
5) Once in the table, scroll down to the row beneath the last row with information in its fields.
6) In the fields of this blank row, enter in the appropriate user information.
7) Close Microsoft Access.
8) To test that the employee does now have Clerical access, from the desktop, double-click to open “Shortcut to clerical.”
9) At the pop up window, type in the User Name created for the employee and click “OK.”
10) If Clerical opens, the employee access has been properly assigned. Close Clerical.

8. Setting up an Email Account for the Employee
(This step is unnecessary for some Clerical employees.)
1) See steps in the Setting up, Customizing, and Testing an E-mail Account ACE Custom Software procedure.

9. Setting up Auditor Identification for Office Reports
(This step is unnecessary for non-Auditor employees.)
1) From the desktop of an IT workstation, double-click to open the “Access Shortcuts” folder and then double-click to
open “office.mdb.”
2) From the Access window, select the Tables tab, and then double-click to open “Appraisers.”
3) From the Appraisers table window, scroll down to the first row containing blank fields.
In the blank field beneath the Code column, type the new auditor’s initials (in ALL CAPS).
In the blank field beneath the Value column, again, type the new auditor’s initials (in ALL CAPS).
4) Click the upper right-hand [X] in order to close the Microsoft Access window.
Click the [X] again to close the Access Shortcuts folder.
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Former ACE Employee ~ Removal Procedures
1. ACE Phone System Changes
1) From within the ACE Voice Mail System …
- Access the employee’s voice mail and remove all messages (Take notes regarding any messages that may be new).
Forward any important or recent messages to the employee’s supervisor (press 5, then the extension to do so).
- Next, record a new voice mail greeting, replacing the existing one. Ex: Thank you for calling ACE. You have
reached an extension that is no longer in use. Please dial 500 to be transferred to the customer service dept.
For details on using the Voice Mail System, refer to Working with the ACE Voice Mail System, Section VI, p. 1.
2) Update the phone system so that the employee’s extension will no longer store voice messages. For details on changing
voice mail settings, see Working with the Phone System Admin Software, Section VI, p. 4, procedure 4.

2. Workstation Profile Clean Up and Removal
NOTE: The following will vary slightly, depending on whether the workstation is running Windows 2000 or Windows XP.
Also, this step is unnecessary for ALL computers (most non-management PCs) that will retain the same user account.
1) Physically go to the former employee’s workstation and log in to the system using the former employee’s login.
2) If necessary, return the system’s icon positions and display properties to the ACE standards.
3) To set the former employee’s profile as the default:
- For Windows 2000 systems, from the desktop, right-click on “My Computer” and select “Properties.”
From the User Profiles tab, click to select the profile “ACE\the user” and then click “Copy To …”
From the Copy To window, click “Browse …” Go to C:\Documents and Settings and click “OK.”
In the Copy to field, after “C:\Documents and Settings”, type \Default User.
Click “OK” to set the user profile the default for new users, click “Yes” at the pop-up, and then click “OK” again.
- For Windows XP systems, from the Start Menu, select “Log off (user).” Answer “Yes” to any pop-ups.
Log in to the system as (the local) Administrator, and select the local computer (instead of ACE) and click “OK.”
Next, after the system has logged in, from the desktop, right-click on “My Computer” and select “Properties.”
From the User Profile section of the Advanced tab, click on the “Settings” button.
From the Profiles list of the User Profiles window, select the profile “ACE\the user” and then click “Copy To …”
From the Copy To window, click “Browse …” Go to C:\Documents and Settings and click “OK.”
In the Copy to field, after “C:\Documents and Settings”, type \Default User.
Click “OK” to set the user profile the default for new users, click “Yes” at the pop-up, and then click “OK” again.
For Windows XP systems, from the Start Menu, select “Log off (user).” Answer “Yes” to any pop-ups.
Log in to the system as the user, and select the ACE network and click “OK.”
4) To delete the former employee’s profile:
- From the Start Menu, select “Log off (user).” Answer “Yes” to any pop-ups. Log in to the system as
the LOCAL administrator, and select the ACE (PC#) local network and click “OK.”
- After log in, from the desktop, right-click on “My Computer” and select “Properties.”
From the User Profiles tab, click to select the former employee’s profile and then click “Delete.”
Click “OK” and then “OK” again to close the System Properties window.
5) To delete the former employee’s admin level rights account:
- From the Start Menu, select “Settings” and then click “Control Panel.”
- From the Control Panel, double-click to open “Users and Passwords” (2000) or “User Accounts” (XP).
- From the pop-up User Accounts window, click to select the former employee’s profile and then click “Remove.”
- Answer “Yes” at the pop-up and then click “OK” to close the User Accounts window.
- Click the upper right-hand [X] to close the Control Panel.
6) To allow any user who logs into the system to receive administrator-level rights by default:
- From the desktop, right-click on “My Computer” and then click “Manage.”
- Click the [+] beside “Local Users and Groups” to expand. Next, click “Groups” to open its contents on the right.
- From the right-hand window list, right-click on “Administrators” and select “Properties.” Next, click “Add …”
- From the Select Users window, in the Enter the object names field, type Domain Users and click “OK.”
- Next, click “Apply” and then “Close” and click the upper-right-hand [X] to close Computer Management.
7) From the Start Menu, select “Log off (user).” Answer “Yes” to any pop-ups. Log in to the system as the new user.
The user will inherit the previously established profile defaults. Shut down the system.

3. Network Login Removal
1)
2)
3)
4)
5)

(This step is unnecessary for non-management employees.)
Physically enter the server closet and, from the desktop of the ACE Server, double-click to open “Administrative Tools.”
From the Administrative Tools window, double-click to open “Active Directory Users and Computers.”
From Active Directory, locate the user, right-click on his name, and then select “Delete.” Answer “Yes” at the pop-up.
Click the “X” box to close Active Directory and then the Administrative Tools window.
Log off the ACE Server, lock the server closet and return to the IT workstation.
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4. Specialty/Property Reports Program Removal
(This step is unnecessary for non-Subrogation Auditors and some Clerical and Management employees.)
1) From Explorer, browse to F:\Data\Access\Specialty and double-click to open “Specialty_be.mdb.”
2) From the main window of Specialty Reports, locate the Tables tab and double-click to open “tblAuditors.”
3) From within the table, locate the employee and check the “Deleted” checkbox beside his name. Close Access Reports.
4) From Explorer, browse to F:\Data\Access\Propery\Reports and double-click to open “Property_be.mdb” (Property only).
5) From the main window of Property Reports, locate the Tables tab and double-click to open “tblAuditors.”
6) From within the table, locate the employee and check the “Deleted” checkbox beside his name. Close Access Reports.

5. ACE Computer Database Removal
(This step is unnecessary for Clerical employees.)
1) From the AccessShortcuts folder found on the desktop, double-click to open “ACE Computer Database.”
2) From within the default field (Lookup ACE ID#), type the employee’s computer ID number.
3) Once the employee’s computer information appears, go to and delete the current information from within the
First Name, Last Name, and ID fields. In the First Name field, type Open Auditor.
4) Updated the date to the date of the current change and then close ACE Computer Database.

6. ACE Floorplan and System Assignment Information Changes
(Only #s 1-3, 8, and 10 are necessary for most Clerical employees.)
1) From the Start menu, go to Programs -> Design -> and select “Flash 5.” From Flash, locate and open “UserSysInfo.fla.”
2) Locate the employee’s location on the floorplan and replace the employee’s data with AUTO WORKSTN and Unused.
3) Save changes, publish the file, and close Flash 5.
4) From the desktop, double-click to open “Excel.” Browse to the Excel Docs folder within the private IT directory
and then open the file “System Distribution and Specs.xls.”
5) From the relevant spreadsheet tab (such as Auditor Systems or Cust Svc Systems, for example), locate the employee’s
data and replace his name with Open (Employee Category, such as Auditor, Manager, etc.) Workstation.
6) Save changes to the spreadsheet and close it. Next, open the Excel file “System Data.xls.”
7) From the Data Jack Info tab, find the jack number to be used by the employee and replace his name with Open Auditor.
8) From the Phone Exts tab, remove the employee’s data field.
9) From the TCP/IP Addresses tab, replace the employee’s information (if it is present) with Open Auditor (#PC).
10) From the Email Addresses tab, remove the row containing the user. Save changes to the spreadsheet and close Excel.
11) Next, open the Excel file “Running Updates.xls.” Go to the Updating-UltraMate Archive tab.
12) Change the field containing the auditor’s initials to Open. From the Updating Windows, AntiVirus, and Pop-ups tabs,
replace the user’s information with Open Auditor (#PC). Save changes to the spreadsheet and close Excel.

7. Removing the Employee from the ACE Logins and Clerical Database
1) From the Access Shortcuts folder on the desktop, double-click to open the Access file “ACE Logins.”
(NOTE: This first step is unnecessary for non-management employees. Skip to step #5.)
2) At the Password Required pop-up window, enter the database password and click “OK.”
3) From the Tables tab, double-click to open “tblUsers.” In the table, scroll to find the row containing the employee’s data.
4) Once located, go to the Deleted field and check the checkbox (the user’s info will now be deleted). Close ACE Logins.
5) From Explorer, go to F:\Data\First Entry\Databases. Right-click on “Ace_Data_Local.mdb” and then click “Copy.”
6) Go to the desktop, right-click somewhere and select “Paste.” Double-click to open “Ace_Data_Local.mdb.”
7) At the Password Required pop-up window, enter the database password and click “OK.”
8) From the Tables tab, double-click to open “tblEmployees.” In the table, scroll to find the row containing the employee.
9) Once located, go to the EmployeeActive field and uncheck the checkbox to remove the data. Close Microsoft Access.

8. Removing the Employee’s Email Account
(This step is unnecessary for some Clerical employees.)
1) See steps in the Setting up, Customizing, and Testing an E-mail Account ACE Custom Software procedure.
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Working with the ACE Voice Mail System
1. Dialing ACE from ACE
1) Dial 400 to connect to ACE (This mimics an external call). Once in the phone system, you will be prompted to enter …
- 0 or hold for a customer service representative.
- 1 to access the employee directory (if you do not know the employee’s extension).
- The employee’s direct extension, if known, may be dialed at any time.
(If you get the employee’s voice mail, dial 0 at any time to be forwarded to a CSR who will field the call.)
2) From the directory, enter the first few letters of the employee’s first or last name.
The phone system will recognize and return an employee name and his/her extension.
- Press # to connect with to the extension of the employee whose name was given.
- Press 1 to hear the next name.
- Press * to cancel the selection and reenter the employee name at the directory menu.
(If you press * at the directory menu, you will exit to the main menu.)
- Additional letters may be entered to narrow the search.

2. Dialing ACE from another location (610-429-5700)
1) Dial 610-429-5200 or 610-429-5700 to connect to ACE. 610-429-5700 will give you access to the phone system,
whereas 610-429-5200 will put you straight through to a customer service representative.

3. Dialing an external number from ACE
1) Press 9 + 1, and then the phone number (including area code) to which you wish to make a connection.

4. Accessing the Voice Mail System and Changing Greetings & Name Announcements
(Note: Once in the Voice Mail System, press 9 at any time to back up one menu level)

To Record a Voice Mail Greeting
1) First, dial 400.
2) From the specific user’s telephone, the user’s voice mail can be accessed by typing his extension and pressing #.
NOTE: If accessing a user’s voice mail from another user’s phone, dial 400, then enter the user’s security code and #.
The system will reject the code and ask for the user’s mailbox number. Enter the user’s mailbox number and #,
then re-enter the user’s security code and # when prompted. You will now be connected to the user’s voice mail.
3) Press 3 to manage the mailbox. Next, press 1 to change the current greeting.
4) Press 1 to select and create a personal greeting, or press # to select the system greeting.
5) If 1 was the selection …
- Press 2 to now record over the existing greeting. Record your greeting and then press #.
- Press 1 to review the greeting.
- If the recorded greeting is satisfactory, press 9 to save it. Otherwise, press 2 to re-record the greeting.
6) Exit the Voice Mail System by hanging up the phone.

To Record a Name Announcement
1)
2)
3)
4)
5)

Repeat the previous procedure, steps 1 - 3.
Press 2 to change the user options. Next, press 6 to record a name.
Record your name announcement and then press #. Press 1 to review the recorded announcement.
If the recorded announcement is satisfactory, press 9 to save it. Otherwise, press 2 to re-record the greeting (Step 7b).
Exit the Voice Mail System by hanging up the phone.

5. Picking up an Extension from another Phone
1) When a user’s phone rings, the call can be picked up from another phone by pressing #5#6, then the user’s extension.

6. Calling an Extension in Intercom mode
1) To speak to another employee through the phone intercom, dial the employee’s extension and then simply press 2.
2) Begin speaking. Your voice will be heard over the recipient’s phone intercom.

7. Removing the Blinking Message Light
1) If an extension has no voice mail messages, but the message light is still blinking …
- Pick up the phone and press #409. Wait a few seconds and hang up. Verify the message light no longer blinks.

8. Turning the Night Bell ON or OFF
1) From Nancy’s phone, to turn the night bell ON, press the “NIGHTBELL” button, then press “3”, and then press “#.”
2) From Nancy’s phone, to turn the night bell OFF, press the “NIGHTBELL” button, then press “1.”
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Setting up a New Phone and Phone Extension
1. Creating a Phone Extension
(Complete this Procedure at night, when no one is utilizing the Phone System.)
1) Retrieve a new phone and take it to the desk of the employee to be set up for phone system access.
2) Look at the phone jack under the desk and note the P – (phone line) number.
3) Go to the ACE Phone system (located in the phone closet).
4) Look at the phone panel and determine which of the available extension numbers to use to assign the phone.
5) Take the spool of phone wire and connect it (in 2 slots) at the panel number corresponding to the P- number noted earlier.
6) Cut the wire (be sure it is long enough, with some slack) from the spool and then connect the other end (in 2 slots)
at the panel number corresponding to the previously assigned PDN equipment number (associated with the extension
number - see the phone system’s eManager software).
7) Take the phone wiring tester and plug it into the panel, beside the extension. Verify that it lights up as green, not red.
If the tester indicates red, the phone was wired improperly. Remove the wire and try reversing the placement (of 2 ends).
8) Remove the tester. Go to the employee’s desk and plug in the phone.
Press the Intercom button and verify that the phone now has a dial tone.

2. Replacing a Phone
1) Physically retrieve a new phone (from the IT closet) for the employee whose current phone is going bad.
2) Remove the employee’s phone and replace with the new phone.
3) Verify the employee’s new phone is working properly by making both an inside and outside call to the extension and
verify the employee’s voice mail is working by leaving a voice mail.

3. Updating the Phone System Records and Setting up Call Forwarding
(Not necessary unless user wishes to set up call forwarding!)
NOTE: This procedure can be followed in order to temporarily reroute a fax machine that isn’t functioning properly.
1) Physically go to the phone that should have its calls forwarded elsewhere.
2) From the phone, press [SPKR], then #6051 and then hang up in order to clear any previous call forwarding.
3) Next, press [SPKR], then #6011 followed by the ext to which the user wishes to have (ALL) calls forwarded,
then the # button, then hang up.
(If the extension belongs to a fax machine, in order to determine the extension, use the fax to dial a display phone and,
From the display phone, verify the (fax’s) incoming extension number.)
4) Make a test call to the phone to ensure it forwards calls properly.
5) NOTE: Other call forwarding codes are as follows:
#6021 = forward calls only when the line is BUSY.
#6031 = forward when the call is not answered.
#6041 = forward when busy or no answer.
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Working with the Phone System Administration Software
1. Installing the Phone System eManager Software
1) From the Start Menu, select “Settings” and then click on “Control Panel.”
2) From the Control Panel, double-click “Add or Remove Programs.”
3) From the left-hand menu of the Add or Remove Programs window, click “Add/Remove Windows Components.”
From the pop-up Windows Components window, check the “Internet Information Services (IIS)” and “Management and
Monitoring Tools” checkboxes and click “Next.” If prompted, insert the proper Windows installation CD and click “OK.”
4) Once the components have been successfully added, click the upper right-hand [X] to close the Add or Remove Programs
window and the Control Panel.
5) From Explorer, go to (the mapped server1\files drive)\Disks\PhoneAdmin and double-click “eManagerV420A06.exe.”
6) From the pop-up window, click “Run.” Click “Next” at the Remove Installation Files window.
7) From the pop-up Toshiba – Before You Start window, click “Install eManager” and then “Continue.”
8) Click “Install eManager Now” to begin the pre-installation.
9) Click “Next” at the first pop-up window. At the following window, enter a generic password (this password does NOT
need to be memorized) in the Password and Confirm Password fields and click “Next.” Click “Next” again.
10) Click “Yes” at the License Agreement window and then click “Next” in order to begin the installation.
11) Remove the Windows installation CD from the CD-ROM drive.
12) Click Finish with “Yes, I want to restart my computer now” bulleted.

2. Installing the Phone System Voice Mail Software
1) After user login, from Explorer, go to (the mapped server1\files drive)\Disks\PhoneAdmin and double-click to open
“StratagyESAdministration4017.exe.”
2) From the pop-up window, click “Run.” Click “Next” at the Remove Installation Files window.
3) Click “Next” at the following two windows in order to begin the installation.
4) Once the installation is complete, click “No” in response to the pop-up Help message and then click “Finish.”
5) From Explorer, browse to C:\Documents and Settings\All Users\Start Menu\Programs\Stratagy Enterprise Server
Administration. Right-click on “Stratagy ES Administration” and select “Copy.” Browse to C:\Documents and Settings\
All Users\Desktop. Right-click and select “Paste.”
6) Click the upper right-hand [X] to close Explorer.

3. Working with the Phone System eManager Software
Initial Software Setup
1) From the desktop, double-click to open “Strata eManager 4.12.”
2) From the pop-up eManager Internet Explorer window, type Administrator in the User Name field, password in the
Password field, and click “Login.”
3) From the left-hand menu of eManager, click “eManager Profile.” From the expanded menu, click “Equipment Editor.”
4) From the Equipment menu box, type ACE in the Name field, 192.168.200.15 in the IP Address field, and
communityName in the Community and Confirm Community fields. Leave the Phone Number and SES IP Address
fields blanks and then click “Add.”
5) Next, from the left-hand menu, click “Classes Setup.” From the User Name drop-down in the main window, select
“Administrator.” From the Not Assigned menu, select “ACE” and click the “<<” button to add to the Assigned menu.
From the left-hand menu of eManager, click “Logout” and then click the upper right-hand [X] to close eManager.
NOTE: Steps 3-5 will only need to be performed ONCE, the first time the program is opened.

Connecting to the Phone System via eManager (after initial setup is complete)
1) From the desktop, double-click to open “Strata eManager 4.12.”
2) From eManager, type Administrator in the User Name field, password in the Password field, and click “Login.”
3) From the left-hand menu of eManager, click “Select Equipment.” From the left-hand menu within the main window,
select “ACE.” Next, click “Connect.” A connection to the phone system will now be established.

Changing Phone Extension Settings – Changing an Extension’s Ring Tones
1) From the left-hand menu of eManager, click “Advanced Configuration.” From the expanded menu, click “Station” and
then the from the subsequent menu, click “Assignments.” This will pull up a phone extension detail window (with a list
of all phone extensions on the right). From the extensions list, click to see the detail of a specific extension.
2) From the upper menu of the detail window (for the specific extension), click the Key tab. A 20-button phone diagram
will be displayed. NOTE: Double-clicking any of the 20 buttons will bring up a window containing that button’s settings.
3) From the diagram, double-click the “PDN” intercom button. Next, change the External and Internal drop-down menu
numbers in order to alter the sound of the internal/external rings. Click “Submit” to accept the setting changes.
4) Repeat step 3, this time double-clicking the “DN” button (the other intercom button).
5) From a phone, dial the extension internally and externally (dial 91-610-429-5700, the ext.) to test out the new ring tone.
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Changing Phone Extension Settings – Switching/Swapping Phone Extensions between Port Locations
1) From the left-hand menu of eManager, click “Advanced Configuration.” From the expanded menu, click “Station” and
then the from the subsequent menu, click “Assignments.”
2) From the upper menu of the detail window, click the Basic tab. From the detailed phone extension window, go to the
extension list found in the bottom menu. Scroll to locate the first extension to be moved. Click the phone extension link.
3) From the phone extension detail window, jot down the number listed in the first field (01 PDN Equipment No.).
Next, click and drag to highlight the contents of this field. NOTE: The PDN equipment number determines the phone’s
position: The 1st 2 digits = the extension’s cabinet, the 2nd 2 = the card in the cabinet, the 3rd 2 = the position in the card.
4) Type the test/swap number, 071001 in the PDN Equipment No. field to temporarily re-assign the extension and then click
“Submit” to save the setting changes.
5) Next, from the extension list found in the bottom menu, locate and click the link of the second extension to be moved.
6) From this phone extension’s detail window, jot down the number listed in the first field (01 PDN Equipment No.).
7) Type the first extension’s Equipment number in the PDN Equipment No. field. Click “Submit” to save the change.
8) From the extension list found in the bottom menu, once again locate and click the link of the first extension.
9) Type the second extension’s Equipment number in the PDN Equipment No. field. Click “Submit” to save the change.
10) From a phone, dial both extensions to verify that their port positions have been switched/relocated.

Changing Phone Extension Settings – Setting Speed Dial Numbers
1) From the left-hand menu of eManager, click “Advanced Configuration.” From the expanded menu, click “Station” and
then from the subsequent menu, click “Station Spdial.”
2) From the right-hand extension list menu, click the link for the specific extension to be set up with speed dial numbers.
3) From the speed dial diagram in the main window, click the first row of data containing NO info in the Number field.
4) From the upper window (now containing the specific speed dial number’s settings (example, 00 or 01)), type the desired
speed dial telephone number in the Number field (beginning with 91).
5) Next, type the name of the phone number’s owner in the Speed Dial Name field. Click “Submit” to save the changes.
6) Repeat steps 3 - 5 for all subsequent empty data rows, until all necessary speed dial numbers have been entered.
7) Click to print a list of all the entered speed dial numbers, and if necessary, write them down on a phone card for storage.
8) From a phone, test the first speed dial number set up by pressing [*] (or the Speed Dial button) followed by [1][0][0].
Verify that the phone rings the proper phone number.

Changing the Phone System Global Ring Time
1) From the left-hand menu of eManager, click “Advanced Configuration.” From the expanded menu, click “System” and
then from the subsequent menu, click “System Timer.”
2) From the right-hand window, change the “08 CF No Answer Time” drop-down to the appropriate number of seconds you
wish for users’ phones to ring before ringing through to voice mail and click “Submit.”
3) From a phone, test the ring time for a phone by test calling an extension. Verify the phone rings for the appropriate length
of time before going into voicemail.
4) From the left-hand menu of eManager, click “Logout” and then click the upper right-hand [X] to close eManager.

Setting Additional Extensions to Ring on a specific Phone Extension
1) From the left-hand menu of eManager, click “Advanced Configuration.” From the expanded menu, click “Station” and
then the from the subsequent menu, click “Assignments.” This will pull up a phone extension detail window (with a list
of all phone extensions on the right). From the list, click the extension link (of the extension to which other numbers will
be added) to access the detailed information on the extension.
2) From the upper menu of the detail window (for the specific extension), click the Key tab. A 20-button phone diagram
will be displayed. NOTE: Double-clicking any of the 20 buttons will bring up a window containing that button’s settings.
(NOTE: If the telephone tied to the extension has only 10 buttons, then only the left-hand side of the diagram applies.)
3) From the diagram, click to highlight the “One Touch” button to be set up for a second extension to ring to.
4) Next, click the “Directory No” button. Beneath all the buttons, several lines of text will appear, including one line reading
“Secondary/Phantom DN.” Click this line.
5) A pop-up window will appear. In the DN Number field at the top of this window, enter the extension number to ring
on the original extension/phone.
6) Next, in the Ringing Assignment section of the pop-up window, change the Day 1, Day 2, and Night radio buttons to
“Immediate Ring” and then click “OK.”
7) Repeat steps 3 - 6 to add additional extensions to the specific extension.
8) From the Assignments window, click “Submit” in order to accept the setting changes.

4. Working with the Phone System Voice Mail Software
Logging in to the Phone System Voice Mail
1) From the desktop, double-click to open “Stratagy ES Administration.”
2) From the Stratagy Login window, type 192.168.200.16 in the Computer field, stratagy in the Name field, Stratagy in the
Password field, and click “OK.”
NOTE: The Voice Ports Status window lists all extensions that are tied to the voice mail system at a given moment in time.
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Changing User Voice Mail Settings
1) From the upper menu of the Stratagy Voice Mail, select “User Agents -> Edit User Agents” and then click “Mailbox.”
2) Next, from the extension list found in the bottom menu, locate and click the link of the extension whose voice mail
settings are to be modified.
3) The following fields are those which will be commonly modified by ACE IT users:
- **Security code, Name 1 (first name), Name 2 (last name), *Tutorial at next login, Store messages.
*NOTE: Checking this checkbox will cause a voice-guided tutorial to play the next to the extension’s voice mail is accessed.
(This is done when a new employee is given an extension, in order to help them easily set up name and voice mail greetings.)
**NOTE: To change the security code, type in the new code in the Security Code field and then click in another field.
Next, from the pop-up window, re-type the new code in the Confirm Security Code field and click “OK.”
4) After altering data in any of the previous fields/checkboxes, click “Apply” in order to save the settings changes.

If Calls are Going Directly into User’s Voice Mail and Not Ringing…
This means that the user has accidently turned on their “Do Not Disturb” phone feature. To turn Do Not Disturb off:
1) Click on the Auto Attendant Options tab of the Stratagy ES Administration program.
2) From the left-hand Call Processing menu, uncheck the “Do not disturb” checkbox and then click “Apply” to save changes,
OR… from a phone, dial 400, login to the user’s voicemail and then press 3 to manage the mailbox. Next, press 2 to
change user options. Press 1 to toggle the Do not disturb setting. Press 9 to save changes and hang up the phone.

Setting up a Date to Play a Holiday Greeting
1) From the upper menu of the Stratagy Voice Mail, select “Configuration” and then click “Holidays.”
2) From the Configuration Properties window, click the Holidays tab.
3) From the Add or Remove Holidays drop-down of the resulting window, select the specific date to be set as a holiday from
the pop-up calendar. NOTE: Only non-repeating holidays (like Thanksgiving, which occurs on a different day each year)
will need to be set up annually.
4) Next, click “No” (to ensure that the date is NOT set as a holiday date for concurrent years).
NOTE: Once the time arrives (and for its duration), the system will automatically play the holiday greeting.
NOTE: The window only displays a holidays list for 1 year. Select a date in a different year to view that year’s holidays.
5) Click “Apply” and “OK” to accept settings changes.

Setting up the Phone System’s Automatic Reboot Time
1) From the upper menu of the Stratagy Voice Mail, select “Configuration” and then click “Scheduler.”
2) From the Scheduler tab of the Configuration Properties window, select the Scheduled Action “OSShutdown.”
NOTE: If “OSShutdown” is NOT present, click the “Add” button, and then type OSShutdown in the (added) blank field.
3) From the right-hand Timetable window, enter the appropriate time and cycle period (daily, weekly, etc.) information.
NOTE: The Timetable time entered must be according to military time, AND the time entered will appear as one hour off
from the time displayed in the Next run: field located above. The time in the Next run: field is the true indicator of when
when the shutdown will occur.
5) Click “Apply” and “OK” and then “OK” again at the pop-up in order to accept settings changes.
6) Click the upper right-hand [X] to close Stratagy Voice Mail.

5. Forwarding Calls from one Extension to another using the Phone System
NOTE: When a fax machine isn’t functioning properly, complete the following to temporarily reroute its extension.
1) Note the number (specifically the last 4 digits) of the bad fax machine AND the machine to which jobs will be forwarded.
2) Once logged in, from the left-hand menu of eManager, click “Advanced Configuration.” From the expanded menu, click
“Trunk” and then from the subsequent menu, click “DID.”
3) From the bottom of the DID window, click the DID/DNIS Table View button and answer “Yes” at the pop-up.
Referencing their 4 digit numbers, from the Table View window, note the Day Destination (3 digit) extensions for both
the bad fax and the forwarding fax. Click the upper right-hand [X] to close the Table View window.
4) From the DID window, select “1” from the ILG Group Number drop-down menu.
5) Next, type the last 4 digits of the fax number (which needs to be forwarded elsewhere) in the 01 DID Number field.
Click in any other field in order for the phone system to populate the specific fax number’s other information.
6) Type over the number contained in the Audio Day1 Dst Digits field with the 3 digit extension of the fax machine that
will temporarily receive the bad fax machine’s incoming jobs.
7) Next, type over the number contained in Audio Day2 Dst Digits and Audio Night Dst Digits with the same number.
8) From the bottom of the DID window, click the “Submit” button in order to save changes made to the phone system.
9) Test send a job to the bad fax machine and verify the job is instead sent to the forwarding fax machine.
10) Once the bad fax machine has been fixed, reset it’s 3 Audio Dst Digits to that machine’s extension and then test send
a job and verify it once again receives (instead of the forwarding fax machine).
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6. Accessing, Rebooting, Backing up, and Updating the Phone System
Accessing the Phone System
1) From the desktop of an IT workstation, double-click to open “NetMeeting.” NOTE: The first time that the NetMeeting
program is run, from the upper menu, select “Tools” and then click “Options …” From the Security tab of the Options
window, check “I prefer to receive secure incoming calls…” and “I prefer to make secure outgoing calls” and click “OK.”
2) Type the phone system’s IP address, 192.168.200.16 in the top drop-down field of NetMeeting and click the “Place Call”
(telephone) icon.
3) From the pop-up Remote Desktop Sharing Password window, type Administrator in both the User and Password fields
and then click “OK.”
4) At the Phone System desktop, in the Enter Network Password window, type password and click “OK” in order
to access the Phone System.
5) NOTE: To log off of the Phone System, return to NetMeeting and click the “End Call” (receiver hang up) icon.
Click the upper right-hand [X] in order to close NetMeeting.

(Soft) Rebooting the Phone System
NOTE: The system only reboots itself automatically once a week, on Tuesday night. Therefore it is often necessary to reboot
the phone system in order to activate holiday greeting changes made in the Stratagy Voice Mail software.
1) First, access the Phone System (see the previous series of steps on Accessing the Phone System).
2) Next, from the desktop of the Phone System, double-click “Restart Stratagy.”
NOTE: A Stratagy Service Restart window will instantly appear, indicating that the system is Restarting Stratagy Service.
The service will take less than 2 minutes to reboot. Dial 400 to test if the service is up after that amount of time passes.
If you dial too soon, you will either get a fast busy sound or a number of dial attempts that go unanswered.
3) Once it has been confirmed that the Phone System is up, log off the Phone System (see Accessing the Phone System).

Backing up the Phone System Data
1) From the desktop, double-click to open “Strata eManager 4.12.”
2) From the pop-up eManager Internet Explorer window, type Administrator in the User Name field, password in the
Password field, and click “Login.”
3) From the left-hand menu of eManager, click “Select Equipment.” From the left-hand menu within the main window,
select “ACE.” Next, click “Connect.” A connection to the phone system will now be established.
4) From the left-hand menu of eManager, click “Utilities.” From the expanded menu, click “Operations” and
then from the subsequent menu, click “CIX/CTX Restart.”
5) From the CIX/CTX Restart window, verify that the correct software update version (sent to ACE from Quantum,
or downloaded and unzipped by ACE) is displayed in the “Standby Software” field.
6) Next, from the expanded Utilities menu, click “Operations” and then from the subsequent menu, click “SM/SD Card.”
7) From the SM/SD Card window, click “Forced Format” and then click “OK” at the pop-up. NOTE: This format is done to
prep the card for backup.
8) Next, from the expanded Utilities menu, click “Operations” and then from the subsequent menu, click “Data Backup.”
9) From the Data Backup window, click “Back Up.” NOTE: This step will take a bit of time to complete.
10) Once the backup completes, verify that the Completion field displays the message “Completed Successfully.”

Updating and Fully Rebooting the Phone System
NOTE: Call Quantum Telecom and verify that someone from the technical team (such as Dennis) will be present should we
run into problems trying to bring the phone system back up to a normal state.
1) Verify that EVERYONE in the office is off their telephone.
2) Once everyone is out of the system, from the expanded Utilities menu, click “Operations” and then from the
subsequent menu, click “CIX/CTX Update.”
3) From the CIX/CTX Update window, click the red button labeled “Start Remote Program Update” or “Clear Reboot”
(NOTE: If the button is NOT present, go to Utilities -> Operations and then click “CIX/CTX Restart” and then click the
red button to reboot the system.). Click “OK” at the Clear/Update reboot pop-up.
4) After the phone system reboots and returns online (which takes anywhere from 1 to 15 minutes), reconnect to the phone
system and then re-click the left-hand menu’s Utilities -> Operations -> “CIX/CTX Update.”
5) Verify that the status now shows a status of Standby for the system. Click the “Set to Normal” button in order to
set the system as active (NOTE: It may not be necessary to complete this step, as the updated version may already have
been set to the active state.).
6) Make a test call out from the phone system and simulate an incoming call into the system to ensure it is functioning.
NOTE: If any strange occurrences are happening, such as NO audio occurring on the system, go down to the
phone system closet, remove the panel from the TOP phone system cabinet, and press the tiny power button on the phone
system card in order to reboot the system (Once the orange shutdown light disappears, the system should be up.).
7) Retest the system if another reboot was necessary. From any workstation, open a Command Prompt window and then
type ping 192.168.200.16 –n 100 (100 will equal the number of ping attempts) in order to attempt to communicate with
the phone system. At the point in which a response is received (instead of a timed out reply), the system should be up.
8) If problems persist with the phone system properly rebooting/functioning, contact Quantum. Corruption may be present.
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Working with the Phone System Call Accounting Software
1. Installing the Phone System Ultimate! Call Accounting Software
(NOTE: This procedure is written up generically, not in step-by-step detail.)

Setting up a Static IP on the Workstation
1) Type in 192.168.200.17 as the Static IP for the workstation (this is the specific IP address that the eManager phone
software looks for in establishing the Call Accounting PC.
NOTE also the gateway, subnet mask, etc. that are set up on the system.

Installing Ultimate! Call Accounting Software
1) Insert the Ultimate! phone system software CD into the CD-ROM drive.
2) Click the default prompts.
3) Once the program installs, it will be stuck in the Startup folder automatically. Copy the shortcut to the desktop as well.

2. Setting up the Phone System Ultimate! Call Accounting Software
(NOTE: This procedure is written up generically, not in step-by-step detail.)
1) Reboot the system. After login, verify that the Call Accounting program runs automatically upon restart.
2) Once the program has been started, from the initial Setup window of Ultimate, select “Toshiba Strata CTX/CIX” from the
phone system drop-down menu.
3) Type ACE in the Name field. Under TCP/IP port, type 4001?!
4) Under Other Initial Setup options, enter the password to gain access to various levels (level3=the level 3 password,
the highest level password).
5) Once these settings changes have been made, pick up a phone and call (91) 262-784-2312 #3 in order to activate Ultimate!
Give the customer service person the order # 8488 and then read them the code displayed on-screen. Type the new code
supplied by the service person and click “Apply.” You should receive a message stating “Response code acknowledged.”

3. Running a Report using the Ultimate! Call Accounting Software
(NOTE: Users can be added to Department groups and then reports can be run for the department as well as individual users.)
1) From the upper menu of Ultimate! Call Accounting, click “Security” and then select “Enter Password.”
2) Type level3 and then click “OK” to gain the highest level access to the Ultimate! Call Accounting software.
3) To run a report, from the upper menu of Ultimate! Call Accounting, select “Reports” and then click “Template Reports.”
4) From the Template Reports window, to run a specific report (in this case, the report showing detail on an extension’s
incoming and outgoing phone calls), select the specific report from the report list. In this case, select “1. Cost Allocation/
Billing – By Department Extension (Detail)” and then click “Print Report.”
5) From the pop-up window, type the specific user’s extension in the Extension drop-down field.
6) Type the appropriate start date in the From drop-down field and then type the start time in the field directly to the right.
7) Type the appropriate end date in the To drop-down field and then type the end time in the field directly to the right.
8) Click “Print” and then retrieve the resulting report pages from the Management Printer.
9) Click “Close” at the Template Reports window.
10) From the upper menu of Ultimate! Call Accounting, click “Security” and then select “Enter Password.”
11) Press [ENTER] twice to logout and lock down the Ultimate! Call Accounting software.
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Access-Related Issues
1. Removing an Unnecessary Specialty Report Page from an ACE Claim
ISSUE: Customer service employee explains that one of the pages appearing in ACEViewer is NOT truly part of the claim.
This is the result of a Subrogation Auditor printing two separate reports from the Specialty Program. By default, both
become part of the claim in ACEViewer, etc.
1) With customer service’s help, determine which page(s) need to be deleted.
2) From the desktop of an IT workstation, double-click to open “ACEViewer” and enter the 6-digit ACE file number
to view the claim in question.
3) Take note of what Specialty sheet needs to be deleted and then click the upper right-hand [X] to close ACEViewer.
4) From Explorer, browse to F:\Data\First Entry\AuditReports\Auto. Double-click to open the folder corresponding to the
specialty report number.
5) Select and delete the necessary .rdf file (usually named with the 6-digit number followed by -SPSubReport.rdf).
6) From the desktop, double-click to reopen “ACEViewer.” Re-enter the 6-digit ACE file number and view the claim.
Verify that the claim now contains one less Specialty page than previously.

1. Setting up an Office to Receive Claims in .Tiff or .Pdf Format
1) From the desktop, open the “AccessShortcuts” folder and then double-click to open “Shortcut to IT.”
2) From the Tables tab, double-click to open “tblInsuranceCompanies.”
3) From the InsuranceCompanyIDPK field, locate the specific insurance company and then scroll over to the
AuditFormatType field. Type 1 if the company is to receive claims as Tiffs or type 0 if they will receive Pdfs.
4) Click the upper right-hand [X] to close Access.
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Billing-Related Issues
1. Removing a Specific File from a Billing Batch File
1)
2)
3)
4)
5)
6)
7)
8)

Receive information from Accounts Receivable detailing the batch number and the file to be eliminated from the batch.
From the Access Shortcuts folder, double-click to open “Office.”
From the Queries tab, double-click to run “qryBatchNumberChange.”
From the Enter Parameter Value pop-up window, enter the listed batch number in the Enter Batch Number field.
The query will run and pull over several files.
From the query file list, locate the file to be removed.
Once located, go to the BATCHNO field for that specific file/record. Replace the current batch number with 0.
Click the upper right-hand [X] to close Microsoft Access.
Close Access and inform Accounts Receivable that the batch file has now been updated to reflect her requested change(s).

2. Deleting a Record from ACE Office
1)
2)
3)
4)
5)

Learn from an employee that an existing record must be deleted from the Office program.
From the AccessShortcuts folder, double-click to open the Access file “Office.”
From the Tables tab, locate the table “Office” and double-click to open it.
From the upper menu, locate the data field labeled “ACE” and click to highlight it.
Press [CTRL] + F. From the Find What field of the Find window, type the complete office code and click “Find First.”
Find will locate and highlight the specific record that was searched.
6) Click “Close” to close the Find window.
7) Verify that the highlighted record is indeed the record that was requested to be deleted.
8) Right-click within the gray margin on the lefthand portion of the screen (and to the left of the record entry fields).
Select “Delete Record.” Answer “Yes” in response to the pop up question “Are you sure you want to delete?”
9) Repeat steps 4 – 8 for all records to be deleted.
10) Click the upper right-hand [X] to close Microsoft Access.
11) Inform the employee that the requested records/files have been deleted from the Office program.
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Switching a Company Office Name in Clerical and ACE Office
1. Switching a Company Office Name (or Other Office Information) - Going Forward
(NOTE: A woman from the Accounts Receivable department normally performs this task. Only perform in her absence.)

Switching the Office’s Information in Clerical
1)
2)
3)
4)

Learn from a Marketing or Accounting employee of an office name that must be changed.
From the desktop, open the “AccessShortcuts” folder and double-click to open “Ins Comp Admin MDB.”
From the Insurance Company window, click to open the form “Clerical Insurance Company Administration.”
In the Company Number field, type the ID # for the insurance company to be changed and press [ENTER].
Information about the company will soon populate into the various form fields.
5) Press [TAB] to switch from the Company Number field to the field labeled Office.
6) Replace the existing office name with the new name for the office.
7) Click the “Close” button in the lower-right portion of the screen to return to the main Insurance Company window.

Switching the Office’s Information in ACE Office
1) From the Insurance Company window, click to open the form “ACE Office Insurance Company Administration.”
2) In the Company Number field, type the ID # for the insurance company to be changed and press [ENTER].
Information about the company will soon populate into the various form fields.
3) Press [TAB] twice to switch from the Company Number field to the field labeled Office.
4) Replace the existing office name with the new name for the office.
5) Click the “Close” button in the lower-right portion of the screen to return to the main Insurance Company window.
6) From the Insurance Company window, click “Exit” to close the Insurance Company Access database.

2. Switching a Company Office Name (or Other Office Information) for It’s Entire History
Running an Access Query on the Company
1)
2)
3)
4)
5)

From the “AccessShortcuts folder”, double-click to open the Access file “Office.”
From the Queries tab, locate the query “Office Change” and click the “Design” button.
From the Criteria field beneath INSCODE, type *, where * is equal to the office ID # (example: D01A).
From the upper menu bar, click the “View” button (located at the far left) to view all files associated with the office.
From the Office Change Query list, click INSOFF to highlight the INSOFF row.

Changing the Company Name (or Other Office Information) to Reflect its New Designation
1) From the upper menu of Access, select Edit -> Replace …
2) From within the Find What field, type the previous office name. Type the new office name in the Replace With field.
3) Ensure that the “Search Only Current Field” checkbox is checked and then click “Find Next” followed with “Replace.”
Click “Find Next” followed by “Replace” a few more times, verifying that the old office is being replaced with the new.
After verifying that the replace is working properly, click “Replace All.” Click “Yes” in response to the pop-up message.
4) Close the Replace window, and from the Office Change Query list, verify that the new office name is relected for all files.
5) Click the upper right-hand [X] to close Microsoft Access and the AccessShortcuts folder.
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Processing a Cancelled File Using a Generic UltraMate Claim
1. Processing a Cancelled File
(After receiving a request (from Accounts Receivable) for a cancelled file to be processed for billing, complete the following.)

Verifying that All Clerical Data is Filled in so as Not to Prevent Conversion from Processing the File
1)
2)
3)
4)

From the desktop, double-click to open “Shortcut to clerical.”
From the Login pop-up window, type your username in the User Name field.
Click the yellow folder icon. Type in the ACE file number and click “OK.”
Verify that an Auditor is associated with the file. If not, click the “…” Auditor button. Type your name in the Selection
field until it is highlighted in the selection list. Double-click on your name to be assigned as the Auditor in Clerical.
5) Click on the “Notes/Remarks” button. Verify information is written in both the Notes and Remarks fields, and that the
File Status is listed as “Requested Audit.”
6) From the upper menu of Clerical, click the “Close Claim” icon. Answer “Yes” at the pop-up.
7) Click the upper right-hand [X] in order to close Clerical.

Forcing the File to Cross over to the Conversion Program for Processing
1) From Explorer, browse to F:\. Right-click on “1234_0.est” and select “Copy.”
2) Browse to F:\Data\First Entry\Images. Right-click somewhere and select “Paste.”
3) Next, quickly right-click on the file and select “Rename.” Rename the file to the ACE file number and press [ENTER]
(Example: Rename 1234_0.est to 929111_0.est).
4) Wait a few minutes for the file to be pulled from the directory and into the Conversion program.
5) Click the upper right-hand [X] to close Explorer.
6) From the desktop, double-click to open “Approval.”
7) After login, type the ACE file number in the ACE Audit # field and press [ENTER].
8) Verify that the file pulls up in the ACEViewer (specifically browse to verify that an invoice page appears). If it does,
then the file has properly processed through Conversion.
9) Click the upper right-hand [X] to close the ACEViewer file and Approval.
10) Inform Accounts Receivable that the cancelled file has been processed and return any paperwork that was given by them.
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Setting up a New Company in Office and Clerical
(Complete the following procedures after learning from an account manager that there is a new office to be set up)

1. Setting up a New Company in the ACE Office Program
1)
2)
3)
4)
5)

From the desktop, double-click to open “Office Application.”
From the upper menu of Office, select “File -> Table Editor.”
From the ACE Application Table Editor window, select the Companies tab.
Next, click “AddNew” in order to add a new company to the database.
With the Caps Lock key ON, add the following into the fields of the pop-up window:
- Company, Office Location, Street Address (typing the Suite # in the second Street Address field when applicable),
City, State, Zip Code, Phone, Fax, Manager, Prop Manager, and finally, type the company code in BOTH
the Office Code and Mitch Code fields.
6) Click “Update” in order to save changes.
7) Next, from the Insurance companies list, locate the office that was just added and click to highlight it.
8) Scroll to the right until the ACEMANAGER field is visible. Type the ACE fee (for auto files) into the field and then
press [TAB].
9) Repeat steps 4 - 8 for all new offices to be added.
10) Click “Close.” Next, click the upper right-hand [X] to close Office and answer “Yes” at the pop-up.

2. Setting up a New Company in Clerical
1) From the desktop, double-click to open “Shortcut to Clerical.”
2) After logging into the program, from the lefthand menu, click the drop-down window labeled “List Admin.”
From the drop-down menu, select “Ins Comps.”
3) From the Insurance Companies pop-up window, type the company code into the first Insurance Company field and then
press [TAB]. All remaining fields should go blank (if the company being set up is truly a new company).
4) Add information into the following fields: The second Insurance Company field (enter the company name), Office
Location, Street Address 1, Street Address 2 (enter the Suite # here, when applicable), City, State, Zip Code, Phone, Fax,
and finally, type the appropriate ACE fees into the Standard, Heavy, Subro - Audit, Subro - Settle, and Over 5K fields.
Standard ACE fees vary, as do BSN and BSN Over 5K fees. Check with marketing or accounts receivable for pricing.
Other fees are static… Static ACE fees are as follows:
- Heavy = ALWAYS $60.00
Subro – Audit = ALWAYS $60.00
Subro – Settle = ALWAYS $60.00
- Over 5K = Add $15.00 to the company’s Standard fee (example: $37.00 standard fee + $15.00 = $52.00)
5) If the new company’s supplements are to be FREE, Check the “Banner” and “New Deal” checkboxes.
6) From the upper menu of the Insurance Companies window, click “Save.”
7) Repeat steps 3 - 6 for all new offices to be added.
8) Next, click the upper right-hand [X] to close the window.
9) Click the upper right-hand [X] again to close the Clerical program.
10) Email all new company paperwork to the Accounts Receivable Department for filing.
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Scanning and Sending Selective Supplements
1. Preparing and Sending a Supplement to Selective Via ADP Claims Manager
Retrieving the ACE File and Scanning the Necessary Supplement Information
At the start of the business day, turn on the Xerox DocuMate 152 scanner.
1) Retrieve the necessary Selective Supplement paperwork from Customer Service and proceed to the scanning workstation.
2) Remove any staples, paperclips, and Post-Its from the supplement paperwork and place the paperwork FACE-BACK
(with the top edge of the paper(s) placed against the scanner) in the Xerox DocuMate 152 scanner’s feed tray.
3) Press the scanner’s “Simplex” button in order to scan the file’s pages.
4) The scan will open in PaperPort, and will automatically save to the OneTouch directory as “OneTouch –date- (1).”
5) Click the upper right-hand [X] to close PaperPort, and remove the paperwork from the scanner and restaple/rePost-It it.

Appending the Scanned Supplement Information to the ACE File
1) From the desktop of the scanning workstation, double-click to open “Approval” and login.
2) From Approval, type the paperwork’s ACE # in the ACE Audit # field and press [ENTER].
3) Proofread the file for accuracy and then click “Unapproved” if it’s OK, in order to approve the file. Take note of the
claim rep associated with the file (the rep’s name may be needed later) and then click to close the ACE Viewer window.
4) Make a note of the email address contained in the rep email field (This address will be typed out in a later step).
5) Next, check the checkbox in order to fax the file to the body shop (but uncheck so as not to fax the claim rep).
6) Click “Fax” in order to send the fax request.
7) Next, click “Print.” From the pop-up window, check the “Rep” checkbox and click “OK.”
8) From the Select Printer menu of the Print window, select “Adobe PDF” and click “Print.”
9) Double-click to open the OneTouch Docs directory, then name the file (the file number).pdf and click “Save” to save it.
10) Wait a few moments, as the file will automatically open in Adobe Acrobat.
11) From Acrobat, press [CTRL] + [SHIFT] + [I]. From the pop-up window, double-click to open the OneTouch directory.
12) Select “scan-(the file number).pdf” then click “Select.” Click the “After” menu option and the “Last” bullet and then
click “OK” to attach the scan as the last page of the file.
13) Scroll down through the pages of the file to ensure that the scanned supplement pages appear after the ACE file pages.
14) Next, click the upper right-hand [X] to close Adobe Acrobat and click “Yes” to close the file with the changes SAVED.
15) Click the upper right-hand [X] to close Approval.

Submitting the File (with the Supplement Information) to Selective via Email
1)
2)
3)
4)
5)

From the desktop, double-click to open “Microsoft Office Outlook 2003.”
From the upper left-hand corner of Outlook’s menu, click “New” to create a new email message.
From the pop-up new email message, type the claim rep’s email address (noted earlier) in the To… field.
Next, type the file # in the Subject: field. Include the rep’s name - if the file is being sent to CSVace@selective.com.
Click the paper clip icon to add an attachment. From the Insert File window, double-click to open the OneTouch Docs
directory and click on the specific file and select “Insert” in order to attach it to the email.
6) Type a brief message in the body of the email and then click “Send” to send the file.
7) Close or minimize Microsoft Outlook.

Cleaning up the Sent File Information and Returning the ACE File Paperwork
1) From the desktop, double-click to open “Scanned Docs.”
2) From the Scanned Docs folder, select and delete “(the file number).pdf.” Click the upper right-hand [X] to close it.
3) Next, from the Windows toolbar (found at the bottom of the screen), click to maximize the Paperport program.
4) Return the supplement paperwork to the Customer Service Rep.
REMINDER: Be sure to turn off the Xerox DocuMate 152 scanner at the end of the business day.
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Correcting ACE Message Pop-up Errors
1. Correcting ERROR:frmMain.ProcessMessageBin Moved … To Failed Messages Folder
1) From Explorer, go to F:\Data\First Entry\MsgBin\FailedMessages and locate the file in question
(Look under the date modified field to help quickly track the file).
2) Right-click on the file and select “Rename.” Rename the file by deleting the .FS extension (which follows CmdMsg).
3) Right-click on the file and select “Cut.”
4) Move up one directory level to the MsgBin and right-click, then select “Paste.”
5) Check the MsgBin at a later time to verify that the renamed file was extracted.

2. Correcting PMERROR: Outlook has not sent mail for more than 30 minutes.
Outlook or the Internet connection may be experiencing problems.
1)
2)
3)
4)
5)

From the desktop, double-click to open the Remotes folder.
Double-click to select “Email Server.”
From the (PCAnywhere) Email Server, go to Outlook and, from the lefthand menu, click “Outbox.”
Double-click on the file located in the Outbox and click “Send.”
Verify that the file sends properly and then close PCAnywhere. Click “Yes” to end the remote session.

3. Correcting ERROR:The Microsoft Jet database engine could not find the object ‘(estimate).ENV/AD1’.
Make sure the object exists and that you spell its name and path name correctly. EstID= (estimate#)
1)
2)
3)
4)
5)
6)
7)
8)

From the desktop, double-click to open “Shortcut to clerical.”
After login, click on the yellow folder to open a claim, enter the 6-digit file number related to the error, and click “OK.”
From the lower-left portion of Clerical, note the name of the Auditor for the file. Close Clerical.
Physically go to the auditor and verify with him that the file did not cross over from Clerical into UltraMate Assignments.
From the desktop, go to the AccessShortcuts folder and double-click to open “Shortcut to Larry.mdb.”
From the View Claims section, change the Closed between field info to include the date range in which the error occurred.
Click the “Query” button to pull all files included in the predetermined date range.
From the list that populates, find the Ace Num that matches the file number. Click on that number’s row to highlight it.
(If the file does not appear in the populated list, open Shortcut to IT, and from the Tables tab, open tblAssignments.
Find the file. Delete the AuditorID, Assign Date and Assign Time Information. Close IT.mdb and proceed to step 10).
9) Once the number is highlighted, click “Clear Assignment Auditor” and then close Larry.mdb.
10) Reopen the file in Clerical and verify that there is no no information contained in the Auditor field.
11) Relay to the auditor that he can now reassign the audit in Clerical and that it will transfer into UltraMate Assignments.

4. Correcting ERROR:Critical clsPrintClaims.PrintClaims – Pos=5 #94: Invalid use of Null
1) Physically go to the Conversion computer. From the upper menu of the Process Claims program, click “Stop.”
2) Scroll through the upper claims list for: Error Critical clsPrintClaims.PrintClaims - Pos=5 #94: Invalid use of Null.
NOTE: The error message will appear multiple times, for every time an attempt was made to process the failed claim.
3) Once an occurrence of the error message line has been located, jot down the file numbers found on the lines DIRECTLY
ABOVE AND BELOW the error message line.
4) Scroll through the upper claims list again and locate several more instances of the error message and again, look at the
lines DIRECTLY ABOVE AND BELOW the error message line. One of the two numbers written down will appear
with each instance of the error message. Note that THIS IS THE ACE FILE THAT IS CAUSING THE ERROR.
5) Physically go to an IT workstation and browse to F:\Data\First Entry\Databases. Double-click to open “Conversion.mdb.”
6) From the Tables tab of the Access database, double-click to open “tblEstimates.”
7) From the tblEstimates window, click to highlight “EstimateIDPK” in order to highlight the ACE file number data column.
8) Next, press [CTRL] + [F]. From the pop-up Find window, type the ACE file number in the Find What field
and then click “Find First.”
9) Once the problem file’s row of data has been located, click “Close” to close the Find window and then uncheck the
problem file’s PrintClaim checkbox.
10) Click the upper right-hand [X] to close Microsoft Access.
11) Return to the Conversion computer. From the upper menu of the Process Claims program, click “Start.”
12) Verify that files process through successfully without the error message reappearing.

1

Correcting ACE Email and File Related Errors
1. Removing an Unwanted Photo from Clerical When the Program Won’t Allow Removal
ERROR: Photos accidentally added to a file cannot be deleted from Clerical, OR from the back pages of the ACE audit file…
1) From the desktop, double-click “Shortcut to clerical.” Log in to Clerical and then click on the yellow folder icon.
2) From the pop-up, enter the 6-digit ACE file number of the file with unwanted photos and then click “OK.”
3) Next, from the left-hand menu of Clerical, click “Photos.”
4) From the Photos window, for each unwanted photo, click to select the photo and click “Remove Photo.”
At this point, Clerical will return an error. From the upper menu of Clerical, click the “Close Claim” button.
5) From Explorer, browse to F:\Data\First Entry\AuditReports\Auto\~Photos.
6) Double-click to open the 6-digit folder that corresponds to the specific file number. Next, scroll down to locate photos
that match those of the specific file. Select and then press [DELETE] (and answer “Yes” at the pop-up) to remove photos.
7) Close Explorer and return to Clerical. Re-open the file and return to the Photos window. You will now be able to remove
the photos from the photo list.
8) Retype information into any filed of Clerical and then click the “Close Claim” button and answer “Yes” to save changes.
The file will now reprocess through Conversion, thus overwriting the ACE audit version which contained the photos.
9) Click the upper right-hand [X] to close Clerical and return any file paperwork to the CSAA customer service department.

2. Cleaning out an Ace-it.com Email Account when it Won’t Properly Receive Emails
ERROR: An email account will not send/receive messages, but generates a send/receive error unrelated to faulty password/
temporary mail server issues.
1) Close all open programs, then, from the desktop of the CSAA Email computer, double-click to open “Internet Explorer.”
2) From Internet Explorer, go to http://www.rackspace.com/email_hosting.
3) From the upper menu of the resulting webpage, click the “LOGIN” button.
4) From the resulting webpage, type the appropriate ACE-it.com email address in the Email Address field.
In the Password field beneath it, type the corresponding email password. Click “Log In” to access the email account.
5) Once the email account inbox webpage has loaded, to delete ALL previously read email messages (and any NEW
messages that appear to be SPAM), click the checkboxes to the left of the specific email messages and then click “Delete.”
6) Repeat this step until ALL necessary messages have been deleted. (NOTE: There may be multiple pages-worth to delete.)
7) Once all messages have been deleted, from the upper right-hand section of the webpage, click “Log Out” to log out of the
email account webpage, then click the upper right-hand [X] to close Internet Explorer.
8) Reboot the computer containing the email account.
9) After login, from the desktop, double-click to open “Microsoft Office Outlook 2003.”
10) From the upper menu of Outlook, click “Send/Receive.” Verify that messages now send and receive properly.

3. Correcting an Original or Supplement File that Shows Negative Savings in Approval
ERROR: The negative savings is caused to the previous version of a file when an auditor re-commits/print/closes the file
without first typing the ACE supplement file number into Mitchell’s Job Information section File Number field and then
reopens/recloses the file after correcting the omission.
THE AUTOMATED METHOD (Works in most cases):
1) After receiving paperwork from the customer service department indicating that the file shows negative savings,
from Windows Explorer, browse to F:\Data\First Entry\Images\Copies\History and then double-click to open the
directory that corresponds to the file number (ex = file # 1225442 would appear in folder 1225xxx).
2) From within the directory, right-click on the file number and select “Copy.” Browse to F:\Data\First Entry\Images,
Right-click somewhere, and then select “Paste.”
NOTE: If the file number does NOT appear in the directory, it will need to be modified manually. See step 5 below.
3) Wait a few minutes for the file to process through Conversion and then, from the desktop open Approval, enter the file #
the file number field and press [ENTER], and then confirm that the Estimate Amount and Audit Amount contained on
page two have reverted to the appropriate amounts (thus overwriting the improper negative savings information).
4) Approve the file or return it to the customer service department for approval.
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THE MANUAL METHOD (sometime necessary):
5) After receiving paperwork from the customer service department indicating that the file shows negative savings, go to the
auditor who wrote the file to determine what the true Shop Estimate Amount and Agreed Price Amount should read.
6) From the desktop on an IT workstation, double-click to open “Access Shortcuts.”
7) From the Access Shortcuts folder, double-click to open “Shortcut to IT.mdb.”
8) From the Tables tab of the database, double-click to open “tblAssignments.”
9) From the table, click “EstimateIDPK” to highlight the entire row of data.
10) Press [CTRL] + F. From the pop-up window, enter the 6-digit ACE file number and click “Find Next.”
Once the file is found, click “Close” to close the pop-up window.
11) Click on the button to the left of the file’s EstimateIDPK to highlight the file’s row of data.
12) Scroll to the right until the columns “BodyShopEstAmt” and “AgreedPrice” are visible.
Type the TRUE Shop Estimate amount and Agreed Price amount into the two corresponding fields.
13) Click the upper right-hand [X] to close Microsoft Access.
14) From the desktop, double-click “Shortcut to clerical.” Log in to Clerical and then click on the yellow folder icon.
15) From the pop-up, enter the 6-digit ACE file number of the file and then click “OK.”
16) Next, from the left-hand menu of Clerical, click “Body Shop.” Verify that the proper Shop Estimate Amt and Agreed
Price information appear in Clerical.
17) From the upper menu of Clerical, click the “Close Claim” button. Click the upper right-hand [X] to close Clerical.
18) Wait a minute or so for the file to re-process through the Conversion program.
19) Wait a few minutes for the file to process through Conversion and then, from the desktop open Approval, enter the file #
the file number field and press [ENTER], and then confirm that the Estimate Amount and Audit Amount contained on
page two have reverted to the appropriate amounts (thus overwriting the improper negative savings information).
20) Approve the file or return it to the customer service department for approval.

3

Correcting MSB IntegriClaim Errors
1. Unlocking MSB IntegriClaim in Response to…
ERROR: Directory is controlled by the other .NET file. Directory C:\ File F:\DDSPRO\DATA\PDOXUSRS.LCK.
1) Make sure all users are out of the MSB IntegriClaim software.
2) From an IT workstation, at the desktop, press [á ] + [F] to open the Windows Find dialog box.
3) In the Named field, type *.NET. Select (F:) from the Look in pull down menu and click “Find Now.”
4) The Find program should locate a file named PDOXUSRS.NET. Right-click on the file and select “Delete.”
5) Now, in the Named field, type *.LCK. Select (F:) from the Look in pull down menu and click “Find Now.”
6) The Find program should locate a file named PDOXUSRS.LCK. Right-click on the file and select “Delete.”
7) The Find program should also locate a file named PARADOX.LCK. Delete this file as well.
8) Return downstairs and, from a property auditor workstation, attempt to open MSB IntegriClaim.
9) Verify that MSB IntegriClaim now runs properly.

2. Unlocking MSB IntegriClaim in Response to…
ERROR: Index is out of date. Index: SORT_ORDER or… USER_CLAIM_NO.
1) Make sure all users are out of the MSB IntegriClaim software.
2) Go to one of the six property auditor workstations.
3) From the Start menu, go to Programs -> IntegriClaim (or DDS Solutions)\Utilities and select Fix Tables.
4) From the Fix Tables Utility, select the Claim data bullet and click “Scan for Errors.”
5) After the scanning process is complete, click “View Errors.”
6) If any table information shows, close the View Errors window and click “Fix Errors.”
7) After the error fixing process is complete, reclick on “Scan for Errors” and “View Errors” to ensure the errors are fixed.
8) Repeat steps 4-7, with the Accounting data bullet selected.
9) Click “Exit” to close the Fix Tables Utility.
10) From the desktop, double-click to open “MSB IntegriClaim.”
11) Attempt to access the data which the user was previously prevented from accessing.
12) If the data is now accessible, the problem has been addressed successfully.
13) If the data is still not accessible, click the upper right-hand [X] to close MSB IntegriClaim and from the Start menu,
go to Programs -> IntegriClaim (or DDS Solutions)\Utilities and select Reindex Tables.
14) Click “Exit” to close the Reindex Tables Utility.
15) From the desktop, double-click to open “MSB IntegriClaim.”
16) Verify that the data which the user was previously prevented from accessing is now accessible.

3. Transferring a Supposedly Closed Property File into the Office Program
NOTE: Receive information from Accounts Receivable that a property file did not properly cross into the Office program.

Setting a Property File to Cross over into Office
1) From the desktop of a property auditor workstation, double-click to open “MSB IntegriClaim.”
2) From the upper menu of IntegriClaim, click the yellow folder in order to open a file. From the pop-up window, enter the
5-digit ACE file number and press [ENTER].
3) Once the file has been found and highlighted, check the file’s status. If it is labeled “Closed,” proceed to step 6,
because the file has already closed and thus crossed into Office. If it is labeled “Open,” it will not cross into Office.
4) Click on the Loss/Assign tab and change the status pull-down menu bar to “Closed.”
5) Save the changes made and then click the upper right-hand [X] to close MSB IntegriClaim. Next, reopen the program.
6) From the upper menu of IntegriClaim, click on the Banner tab.
7) Click the “Save” button and then click the upper right-hand [X] to close MSB IntegriClaim.
8) The property file should now properly import into Office.

Verifying that the Property File Will Cross into Office
1) From the desktop of an IT workstation, open the “Access Shortcuts” folder and then double-click to open “Office.”
2) From the Tables tab of the Office database, double-click to open “Import.”
3) Looking at the ACE column (the column containing the ACE file number), verify that the property file now appears in
the import table.
4) Click the upper right-hand [X] to close the Access database.
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Correcting Microsoft Access Database Corruption
1. Correcting the Error: clsPrintClaims. PrintClaims-91: Object Variable or with Block Variable Not Set
The preceding error will occur at the Conversion Workstation.
Additional Error Message at the client workstation level: Check Approved 3343. Unrecognized database format
“F:\Data\First Entry\Databases\THE DATABASE (For example, “Office.mdb” or “Ace_data.mdb.”)
NOTE: The following procedure will use Ace_data.mdb as an example.

Fixing the Access Database to Correct the Error
1) After receiving notification of the preceding error message(s), inform ALL employees to close the following programs:
- ACE Viewer, Clerical, Approval, and Specialty Reports.
2) Physically go to the Conversion PC and close the Conversion New Process program.
3) Physically go to the Server and verify that all users are out of Ace_data.mdb-related programs. Determine who is still in
Ace_data.mdb by going to Administrative Tools -> Computer Management and looking in Shared Folders/Open Files.
(NOTE: Ace_data.ldb will no longer be present in F:\Data\First Entry\Databases when all users are out of Ace_data.)
4) Once all users are out of Ace_data, from the Email Server (or an IT workstation), open a copy of Windows Explorer.
5) From Explorer, right-click and “Copy” the file “Ace_data.mdb.” Once “Copy of Ace_data” appears, indicating that the
database has been copied, from the Email Server, open “Ace_data.mdb.”
6) Click “OK” in response to the pop-up message to attempt to repair the database.
7) After the repair is finished, click the upper right-hand [X] to close the database.
8) Physically go to any workstation and test Clerical or Approval to ensure that files are pulling in properly.
9) Once verified, inform employees that they can reopen all their applications and begin working.
10) From Explorer, rename Copy of Ace-data.mdb to Ace-data.mdbCORRUPTED* (where * is the date of corruption).
11) Right-click and “Cut” Ace-data.mdbCORRUPTED*. Browse to F:Source\Corrupted-BackupMdbs (NOTE: Only
Administrators can access this) then right-click somewhere and select “Paste” to move the old database to this location.
12) Physically go to the Conversion PC. From the desktop, double-click “New Process.”
13) From the ACE - Process Claims window, click “Start.” Verify that the Process program churns through several files.

Determining Any Files that Need to be Resent/Reprocessed Due to the Error
1) From an IT workstation, open Explorer and browse to F:\Data\First Entry\Logs. Copy CONVERSION.log,
EClaimMailSvr.log, and Clerical.log to the desktop.
2) Click the upper right-hand [X] to close Explorer. From the desktop, double-click to open “Microsoft Word.”
In the blank Word document, type Conversion and then press [ENTER] several times. Repeat, typing EClaimMailSvr
and again typing Clerical.
3) Referring to the log files, determine the time frame of data corruption, and for each log, copy the relevant entries into
the separate sections of the Word document.
4) Click the upper right-hand [X] to close each of the log files. Next, select each and press [DELETE].
5) From the upper menu of Microsoft Word click the printer icon to print out the Word document. Retrieve the print out.
6) Look specifically at the EClaimMailSvr.log entries. Next, physically go to the Email Server.
7) From Outlook, click on the Sent Items folder and determine which items from the printed list did not send properly.
8) Open Explorer and browse to F:\Data\First Entry\MsgBin\FailedMessages. Cut all necessary failed messages and
paste them into F:\Data\First Entry\MsgBin.
9) Verify that the files get pulled from the MsgBin folder and then click the upper right-hand [X] to close Explorer.
10) Return to the Email Server’s Outlook. Verify that the files now appear in the Outbox or Sent Items folder.

2. Correcting the Holding Bin Error: The Microsoft Jet Database Engine stopped the process because you
and another user are attempting to change the data at the same time.
The preceding error will occur occasionally when the Quality Control Manager runs the Holding Bin Manager program.

Fixing the Office Database Table to Correct the Error
1) After receiving notification of the preceding error message, from the desktop of an IT workstation, double-click to open
the “Access Shortcuts” folder and then double-click to open “Office.mdb.”
2) From the Office database, click on the Tables tab and then double-click to open “Holding.”
3) Scroll horizontally across all columns of data, searching for corrupt data - such as “#(ERROR text).”
4) Once the corruption has been located, right-click on the entire row of data (containing the cell with corruption)
and select “Copy.” Click “OK” in response to any pop-up error messages (the data will still copy).
5) Next, right-click and select paste to paste a copy of the row of data.
NOTE: An extra digit will need to be added to the end of the # in the ACE column, since dupe # entries won’t be allowed.
6) Remove the improper information from the corrupt data cell in the PASTED row of data and then click to highlight the
ORIGINAL row of data and press [DELETE]. Answer “Yes” at the pop-up.
7) Return to the Quality Control Manager. Have him re-run the Holding Bin Manager program to verify it works properly.
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Outlook, Webmail, and ACE-IT.com Server Issues
1. Correcting a Microsoft Outlook Mail Delivery Error
(The e-mail message delivery error will appear on the message bar in the lower-right corner of Outlook or Outlook Express.)

First Course of Action ~ Resetting the Email Account’s Password
NOTE: Before beginning to correct the problem, determine if this is the only computer experiencing email problems.
If so, the first or second course of action should relieve the problem. If several computers are experiencing similar
problems, skip directly to the third course of action.
1) Physically go to the computer (example: the Email Client Workstation) where the error is occurring.
2) From the desktop, double-click to open “Microsoft Outlook” (NOTE: The program will likely be open already.).
3) Verify that there are no items contained in the Outbox. If there are, take note of them on paper and then delete them.
4) Next, from the upper menu in Outlook, select “Tools” and then click “Accounts …”
5) From the Mail tab, select ACE-IT Email and click “Properties.”
6) From the Servers tab, remove the password from the Password field and type it again. Click “Apply” and “OK.”
7) Close the Internet Accounts window and then click the upper right-hand [X] to close Outlook.
8) Next, from the desktop, reopen Outlook.
9) From the upper menu of Outlook, click the “Send/Receive” button. Look at the message bar in the lower-right corner.
Double-click on the message to expand it and verify the expanded message box now indicates Outlook is receiving email.

Second Course of Action ~ Removing Potentially Corrupt Email Account Mail from the Mail Server
(If the previous procedure doesn’t solve the problem, complete the following:)
1) Close all open programs, then, from the desktop of the computer where the error is occurring, double-click to open
“Internet Explorer.”
2) From Internet Explorer, go to http://www.rackspace.com/email_hosting.
3) From the upper menu of the mailserver’s homepage, click the “LOGIN” button.
4) From the resulting webpage, type the appropriate ACE-it.com email address in the Email Address field.
In the Password field beneath it, type the corresponding email password. Click “Log In” to access the email account.
NOTE: If the account is not accepted or the website is not functioning properly, skip to the third course of action.
5) Once the email account inbox webpage has loaded, to delete ALL previously read email messages (and any NEW
messages that appear to be SPAM), click the checkboxes to the left of the specific email messages and then click “Delete.”
6) Repeat this step until ALL necessary messages have been deleted. (NOTE: There may be multiple pages-worth to delete.)
7) Once all messages have been deleted, from the upper right-hand section of the webpage, click “Log Out” to log out of the
webmail account, then click the upper right-hand [X] to close Internet Explorer.
8) Reboot the computer experiencing the e-mail problems.
9) After login, from the desktop, double-click to open “Microsoft Outlook.”
10) From the upper menu of Outlook, click “Send/Receive.” Verify that messages now send and receive properly.

Third Course of Action ~ Contacting ACE’s Internet Service Provider (ISP) and/or Webmail Host
(If the previous procedures don’t solve the problem, complete the following:)
1) From the desktop of the computer where the error is occurring, double-click to open “Internet Explorer.”
2) Browse to a few websites. If the websites load properly, then internet service is not a problem. In this case, contact
Webmail.us at (866) 392-3336 (option 2) and tell a support person that our mail server is experiencing problems.
If the websites DO NOT load properly, then our internet service is down. In this case, contact Paetec at (877) 340-2555
and tell a support person that our internet and email services are not functioning.
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Switching ISPs (Perform When Internet Service Goes Down)
1. Switching from Paetec (primary) to Comcast (back up) Internet Service
1) From the desktop of an IT workstation, double-click to open “Internet Explorer.”
2) Type 192.168.200.2 (the ACE Router) into the Address field of Internet Explorer and press [ENTER].
3) From the pop-up window, type admin in the User name field and k*****@****79 in the Password field and click “OK.”
4) From the upper menu of the Linksys router webpage, click the “System Management” link.
5) From the Smart Link Backup Primary WAN drop down, select WAN2 (Comcast) and then click the “Save Settings” link.
6) From the right-hand side of the Linksys router webpage menu, click “Logout.”
7) From the upper menu of Internet Explorer, select “File -> New” and then click “Window.”
8) From the Address field of the second Internet Explorer, type www.domaindiscover.com and press [ENTER].
9) From the upper right-hand side of the BuyDomains website, click the login icon link (an icon containing a key).
10) From the Log In page , type ace-it.com in the User name field and os****** in the Password field and click “Log In.”
11) From the left-hand side of the Domain Services webpage, click the “DNS service:” link.
12) From the Manage DNS webpage, locate “webportal.ace-it.com”, scroll to the right, and click the Edit record icon link.
13) From the Edit a Record webpage, highlight the contents of the IP Address field (which reads 64.221.61.162, the Paetec
IP address). Type 70.91.29.150 (the Comcast IP) over top of the existing information and click “Edit” to save changes.
14) From the upper menu of the BuyDomains Manage DNS webpage, click the “Logout” link.
15) Click the upper right-hand [X] to close the second copy of Internet Explorer.
16) From the Start Menu, select “Programs -> Accessories” and then click “Command Prompt.”
17) From the Command Prompt, type ping webportal.ace-it.com. Communication verification to the web portal will occur.
18) Look at the ping response messages and verify that the Reply from IP reads 70.91.29.150 (The Comcast IP address).
19) Type exit to close the Command Prompt.
20) From the Address field of Internet Explorer, type www.myipaddress.com and press [ENTER].
21) From the MYIPAddress.com window, verify the computer IP address (“seen by the outside world”) reads 70.91.29.150.
22) From the Address field of Internet Explorer, type www.ace-it.com and press [ENTER].
23) Log in to the ACE portal and verify it functions, and if necessary, alert ACE clients that we are back up and running.
24) Click the upper right-hand [X] to close Internet Explorer.
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Restoring the ACE Phone System When Service is Down
1. Restoring the Phone System
Performing the following steps once it has been learned that the phone system is not able to send AND/OR receive calls.
1) Test the phone system hardware, to see if it is the source of the problem. First, physically go to the phone system closet
and remove the cover from the uppermost of the 3 wall-mounted phone system cabinets.
2) In order to re-synch the phone system with “the outside world”:
- Locate the POWER button found on the Stratagy iES32 phone card.
- Using a paper clip, press the POWER button and hold it in for 5 seconds.
- Release the button. The power lights will turn off and the phone card hard drive will stop spinning.
- After about 15 seconds (once the drive stops spinning), pull the iES32 card out from it’s seating in the cabinet.
- After 5 seconds, push the card back into its seating. This will prompt the phone system to restart.
- After 10 minutes, using an ACE phone, TEST TO SEE IF THE PHONE SYSTEM IS NOW FUNCTIONING.
3) If the proceeding step did not correct the phone system, make the following high priority phone calls:
- Call Quantum Telecom (215-781-1170) if the problem is believed to be hardware-related.
- Call Paetec (877-340-2555) if the problem is believed to be software-related.

2. Restoring the Phone System – When the Phone System Voice Mail is Down
When Outgoing calls can be made and when incoming calls can be made to various ACE fax machines, but not to ACE’s
610-429-5200 or 610-429-5700s, then the phone system voice mail is likely down.
1) Verify that the phone system is down in any of the following ways:
A) From any phone, dial 400. If the phone does NOT ring, but instead goes to a fast busy, the voice mail is down.
B) From a Command Prompt window, type ping 192.168.200.16 (the voice mail sys’s IP address) and [ENTER].
If the ping request does not receive any response, but instead times out, the voice mail is down.
C) From an IT workstation, double-click to open “NetMeeting.” From the upper drop down menu of NetMeeting,
Select “192.168.200.16” and then click the “Place Call” icon. It no connect can be made, the voice mail is down.
2) Once it’s been confirmed that voice mail is down, from an IT workstation, double-click to open “Strata eManager 4.12.”
3) From eManager, type Administrator in the User Name field, password in the Password field, and click “Login.”
4) From the left-hand menu of eManager, click “Select Equipment.” From the left-hand menu within the main window,
select “ACE.” Next, click “Connect.” A connection to the phone system will now be established.
5) Once logged in, from the left-hand menu of eManager, click “Advanced Configuration.” From the expanded menu, click
“Trunk” and then from the subsequent menu, click “DID.”
6) From the DID window, select “1” from the ILG Group Number drop-down menu.
7) Next, type 5200 (the last 4 digits of the main ACE number) in the 01 DID Number field.
Click in any other field in order for the phone system to populate the 5200 number’s other information.
8) Type 123 (a customer service person’s extension) over the numbers contained in the Audio Day1, Audio Day2,
and Audio Night Dst Digits fields to temporarily route ALL incoming calls to that extension (effectively bypassing
the currently non-functioning voice mail system).
9) From the bottom of the DID window, click the “Submit” button in order to save changes made to the phone system.
10) Wait a minute for changes to hit the phone system, then test call the 610-429-5200 number and verify it rings to ext. 123.
11) Go to the phone system closet and remove the cover from the uppermost of the 3 wall-mounted phone system cabinets.
12) Locate the reset button found on the top of the PR card labeled “S103.” Press and hold the button for about 5 seconds.
Release the button and verify that the various card lights begin to light up red.
13) After about 5 minutes or so, from any phone, dial 400. If the phone does NOT ring, but instead goes to a fast busy,
the voice mail is down. Continue to wait about 5 more minutes.
14) In the meantime, from a Command Prompt window, type ping 192.168.200.16 –n 50 and [ENTER] in order to ping
the voice mail system 50 times. Watch the responses and look for the system to begin replying (instead of timing out).
15) Once the voice mail system begins to reply, close the Command Prompt, and once again dial 400.
16) Continue to dial 400 for another minute or two, until the phone system voice mail is accessible.
If the voice mail still cannot be accessed after several minutes, call Quantum Telecom (215-781-1170) to troubleshoot.
17) Once the voice mail system is functioning as normal, return to the eManager software. From the DID window,
return DID number 5200’s Audio Day1 number to 579, its Audio Day2 number to 579, and its Night number to 400.
18) From the bottom of the DID window, click the “Submit” button in order to save changes made to the phone system.
19) Wait a minute for changes to hit the phone system, then test call the 610-429-5200 number and verify it rings as normal.
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Salvaging an Auditor's Defective Hard Drive
1. Copying Files from the Defective Drive to the Network
1) After learning from a given auditor that his/her system is dying, go to the auditor’s workstation
with the “Windows 95 Startup Disk with Network Drivers” disk.
2) Boot up the auditor’s system from the disk.
3) From the DOS Prompt, type C:. Next, type dir to ensure that the directories in the C: drive are accessible.
4) Type F:\Data. Next, type md * (where * is the auditor’s initials) to create a directory for the user on the F: drive.
5) Type cd * to enter the new directory. Next, type md useraux and press [ENTER], then type md userdata.
6) Type C:\Mitchell\useraux. Next, type copy *.* F:\data\*\useraux to copy files to the new folder on the F: drive.
7) Type cd .. then cd userdata. Next, type copy *.* F:\data\*\userdata to copy files to the new folder on the F: drive.

2. Copying the Files to the New Hard Drive
1) Bring the *new* system or hard drive to the auditor’s location.
2) Connect the system, start it up, and logon as the auditor.
3) If the user has not been set up on UltraMate…
- From the desktop, double-click to open Mitchell UltraMate.
- In both the User ID and Password fields, type Mitchell and click “OK.”
- From UltraMate’s menu bar, click “System Info” and select “Configuration -> Configure User Information …”
- From the User Manager dialog box, click “New.”
- From the User Detail dialog box, add the user to the system (utilizing the auditor’s proper login and password).
- Close UltraMate.
4) From Explorer, go to F:\Data\* and select the useraux and userdata folders. Now right-click and select “Copy.”
5) Go to C:\Mitchell. Right-click and select “Paste.” Select “Yes to all” in response to the pop-up message to overwrite.
6) From the desktop, double-click to open UltraMate.
7) Login using the Auditor’s User ID and Password.
8) Click on the yellow folder to open an existing estimate.
9) From the Estimates tab, verify that the files have transferred.
10) Click on the Estimate ID menu button, and then scroll to locate a Committed estimate.
11) Locate and click on the persons icon.
12) From the left menu, click the “General” button.
13) Verify that the Estimator ID matches the logon User ID configured for the Auditor.
If different, return to the Configure User Information menu and change the User ID to reflect the Estimator ID.
14) Click “OK” then double-click on a listed car part. Verify that an image pops up on the right portion of the screen.
15) From the top menu bar, select file and click “Close.”
16) Close out of UltraMate and shutdown the *new* system.
17) Relocate the “old” system to the computers to be reformatted pile after removing and labeling the defective hard drive.

3. Replacing the Defective (Western Digital) Hard Drive
1) From the desktop of an IT Workstation, double-click to open Internet Explorer.
2) In the browser’s address window, type http://support.wdc.com/warranty/selection.asp?custtype=END
and press [ENTER]. From the WD Service and Support page that loads, click “Product Warranty Check.”
3) In the Serial Numbers field, type the serial number (S/N:) located on the defective hard drive and then click “Continue.”
4) From the Warranty Check page that loads, view the Status info to determine whether or not the hard drive is in warranty.
If the hard drive is no longer under warranty, do not proceed with this procedure to replace.
5) Retrieve the ACE credit card from Robert before attempting to replace the hard drive.
6) From the upper toolbar of Internet Explorer, click “Back” twice to return to the WD Service and Support page.
Click “RMA (Product Replacement Online).” From the following page, click the “Advance RMA” button.
7) From the Advance Replacement page, type the hard drive serial number in the appropriate field and click “Continue.”
8) From the following page, click “Create RMA” in order to create a request for a replacement hard drive.
9) At the following page, type 6104295200 in the Phone field, Gizzio in the Name field, and click “Continue.”
10) Verify that the hard drive and shipping information are correct on the following page and then click “Create RMA.”
Click “OK” in response to the pop-up message.
11) Verify that the billing address is correct, then type in the appropriate credit card information. Click “Submit Request.”
12) Write the RMA number on a Post-It. Close Internet Explorer and return the ACE credit card to Robert.
13) Set aside the defective hard drive, with the RMA Post-It attached to it.
14) Wait 3-5 days for the replacement drive to arrive from Western Digital.
15) Upon arrival of the replacement drive, package the defective drive in the same box, removing any unnecessary labels.
Place the return address label (which comes with the new drive) on the box and take it to UPS to ship to Western Digital.
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